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Preface

1. General information

1.1. Purpose

This User Guide explains how to manage profiling data in Talend Open Studio for Data Quality in
a normal operational context.

Information presented in this document applies to Talend Open Studio for Data Quality 6.4.1.

1.2. Audience

This guide is for business users, database administrators and data analysts in charge of checking the
quality of data and collecting statistics and information about that data.

The layout of GUI screens provided in this document may vary slightly from your actual GUI.

1.3. Typographical conventions

This guide uses the following typographical conventions:

• text in bold: window and dialog box buttons and fields, keyboard keys, menus, and menu options,

• text in [bold]: window, wizard, and dialog box titles,

• text in courier: system parameters typed in by the user,

• text in italics: file, schema, column, row, and variable names,

•
The  icon indicates an item that provides additional information about an important point. It is
also used to add comments related to a table or a figure,

•
The  icon indicates a message that gives information about the execution requirements or
recommendation type. It is also used to refer to situations or information the end-user needs to be
aware of or pay special attention to.

• Any command is highlighted with a grey background or code typeface.

2. Feedback and Support
Your feedback is valuable. Do not hesitate to give your input, make suggestions or requests regarding
this documentation or product and find support from the Talend team, on Talend Community at:



Feedback and Support

vi Talend Open Studio for Data Quality User Guide

https://community.talend.com/

https://community.talend.com/
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Chapter 1. Data Profiling: Concepts and
Principles
This chapter introduces data profiling as the process of examining the data available in different data sources such
as databases and files.
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1.1. Why profiling data
Data profiling is the process of examining the data available in different data sources and collecting statistics and
information about this data. Data profiling helps to assess the quality level of the data according to defined set
goals.

If data is of a poor quality, or managed in structures that cannot be integrated to meet the needs of the enterprise,
business processes and decision-making suffer.

Compared to manual analysis techniques, data profiling technology improves the enterprise ability to meet the
challenge of managing data quality and to address the data quality challenges faced during data migrations and
data integrations.

1.2.  About Talend Data Quality
The following sections introduce Talend Data Quality and list its key features.

1.2.1.  What is Talend Data Quality
This data profiling tool allows you to identify potential problems before beginning data-intensive projects such
as data integration.

The data profiler centralizes several elements including a:

• data profiler; for more information about the data profiler, see The studio management GUI.

• data explorer; for more information about the data explorer, see Data Explorer management GUI

• pattern manager; for more information about the pattern manager, see Patterns and indicators.

• metadata manager; for more information about the metadata manager, see Metadata repository.

1.2.2. Core features
This section describes basic features of Talend data profiling solution.

1.2.2.1. Metadata repository

Using Talend data quality, you can connect to data sources to analyze their structure (catalogs, schemas and
tables), and stores the description of their metadata in its metadata repository. You can then use this metadata to
set up metrics and indicators.

For more information, see Setting up connections to data sources.

1.2.2.2. Patterns and indicators

Patterns are sets of strings against which you can define the content, structure and quality of high complex data. The
Profiling perspective of the studio lists two types of patterns: regular expressions, which are predefined regular
patterns, and SQL patterns which are the patterns you add using LIKE clauses.
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For more information about patterns, see Patterns.

Indicators are the results achieved through the implementation of different patterns. They can represent the results
of data matching and different other data-related operations. The Profiling perspective of the studio lists two types
of indicators: system indicators, a list of predefined indicators, and user-defined indicators, a list of those defined
by the user.

For more information about indicators, see Indicators.
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Chapter 2. Getting started with Talend Data
Quality
This chapter explains the typical sequence of profiling data using the studio and other important miscellaneous
subjects.

For how to launch and get started with Talend Studio, see the Getting Started Guide.
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2.1. Working principles of data quality
From the Profiling perspective of the studio, you can examine the data available in different data sources and
collect statistics and information about this data.

A typical sequence of profiling data using the studio involves the following steps:

1. Connecting to a data source including databases and delimited files in order to be able to access the tables and
columns on which you want to define and execute analyses. For more information, see Setting up connections
to data sources.

2. Defining any of the available data quality analyses including database content analysis, column analysis, table
analysis, redundancy analysis, correlation analysis, etc. These analyses will carry out data profiling processes
that will define the content, structure and quality of highly complex data structures. The analysis results will
be displayed graphically next to each of the analysis editors, or in more detail in the Analysis Results view.

While you can use all analyses types to profile data in databases, you can only use Column Analysis and Column
Set Analysis to profile data in delimited files.

2.2. Important features and configuration
options
This section details some important information about analysis editors, the error log view and the help context
embedded in your studio.

2.2.1. Defining the maximum memory size threshold

From the studio, you can control memory usage when using the Java engine to run two types of analyses: column
analysis and the analysis of a set of columns.

Why would you like to set a memory limit when running such analyses? If you use column analysis or column
set analysis to profile very big sets of data or data with many problems, you may run out of memory and end up
with a Java heap error. By defining the maximum memory size threshold for these analyses, the Studio will stop
the analysis execution when the memory limit size is reached and provide you with the analysis results that were
measured on the data before the analysis execution was terminated by the memory limit size.

To define the maximum memory size threshold, do the following:

1. On the menu bar, select Window > Preferences to display the [Preferences] window.

2. Either:

• expand Talend > Profiling and select Analysis tuning, or,

• start typing analysis tuning in the dynamic filter field.

The Analysis tuning view is displayed.
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3. In the Memory area, select the Enable analysis thread memory control check box.

4. Move the slider to the right to define the memory limit at which the analysis execution will be stopped.

The execution of any column analysis or column set analysis will be stopped if it exceeds the allocated memory
size. The analysis results given in the Studio will cover the data analyzed before the interruption of the analysis
execution.

2.2.2. Setting preferences of analysis editors and
analysis results

You can decide once for all what sections to fold by default when you open any of the connection or analysis
editors. It also offers the possibility to set up the display of all analysis results and whether to show or hide the
graphical results in the different analysis editors.

To set the display parameters for all editors, do the following:

1. On the menu bar, select Window > Preferences to display the [Preferences] window.

2. Expand Talend > Profiling and select Editor.
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3. In the Folding area, select the check box(es) corresponding to the display mode you want to set for the
different sections in all the editors.

4. In the Analysis results folding area, select the check boxes corresponding to the display mode you want to
set for the statistic results in the Analysis Results view of the analysis editor.

5. In the Graphics area, select the Hide graphics in analysis results page option if you do not want to show
the graphical results of the executed analyses in the analysis editor. This will optimize system performance
when you have so many graphics to generate.

6. In the Analyzed Items Per Page field, set the number for the analyzed items you want to group on each page.

7. In the Business Rules Per Page field, set the number for the business rules you want to group in each page.

You can always click the Restore Defaults tab on the [Preferences] window to bring back the default values.

8. Click Apply and then OK to validate the changes and close the [Preferences] window.

While carrying on different analyses, all corresponding editors will open with the display mode you set in the
[Preferences] window.

2.2.3. Setting the default frequency table parameters

In the Profiling perspective, when viewing the results of an analysis, 10 results are shown in the frequency tables
by default.



Displaying and hiding the help content

Talend Open Studio for Data Quality User Guide 9

From the [Preferences] window of the Studio, you can edit the default value for frequency and low frequency
tables.

You cannot update frequency table parameters for:

• locked analyses,

• open analyses, and

• analyses with frequency indicators that use the current default value.

1. On the menu bar, select Window > Preferences to display the [Preferences] window.

2. Expand Talend > Profiling and select Indicator settings.

3. In the Number of result shown fields, set the default value for Frequency table and Low frequency table.

4. Click Apply to analyses to apply the parameters to existing analyses.

5. In the [Set the Frequency Table Parameters] dialog box, select the analyses for which to apply the new
frequency table parameters, and click OK.

6. Click OK to save your changes.

2.2.4. Displaying and hiding the help content

Your studio provides you with cheat sheets that you can use as a quick reference that guides you through all
common tasks in data profiling.

You can also have access to a help panel that is attached to all wizards used in the studio to create the different
types of analyses or to set thresholds on indicators.

2.2.4.1. Cheat sheets

When you open the studio for the first time, the cheat sheets view opens by default in the Profiling perspective.

If you close the cheat sheets view in the Profiling perspective of the studio, it will be always closed anytime you
switch back to this perspective until you open it manually.

To display the cheat sheets, do one of the following:

1. Either:

• press the Alt+Shift+Q and then H shortcut keys, or,

• select Window > Show View from the menu bar.

The [Show View] dialog box opens.
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2. Expand the Help folder and then select Cheat Sheets.

3. Click OK to close the dialog box.

Or,

1. Select Help > Cheat Sheets from the menu bar. The [Cheat Sheet Selection] dialog box opens.

You can also press the Alt+H shortcut keys to open the Help menu and then select Cheat Sheets.

2. Expand the Talend-Cheat Sheets folder, select the cheat sheet you want to open in the studio and then click
OK .

The selected cheat sheet opens in the studio main window. Use the local toolbar icons to manage the display
of the cheat sheets.
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2.2.4.2. Help panel

A help panel is attached to the wizards used in the studio to create and manage profiling items. This help panel
opens by default in all wizards.
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To hide the help panel in any of the wizards used in the studio, do the following:

1. Select Window > Preferences > Talend > Profiling > Web Browser.

The [Web Browser] view opens.

2. Select the Block browser help check box and then click OK.

From now on, all wizards in the studio display without the help panel.
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2.2.5. Displaying the Module view

Talend Studio provides you with a Module view. This view shows if a module is necessary and required for
creating a connection to a database. Checking the Module view helps you to verify what modules you have or
should have to run smoothly your profiling analyses.

To display the Module view in the studio:

1. Select Window > Show View from the menu bar.

The [Show View] dialog box opens.

2. Start typing Module in the filter field.

3. Select Modules from the list and then click OK.

The Module view opens in the studio.
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4. From the toolbar of the Module view, select:

Icon To...

browse your local system to the module you want to install

open a list of all required external modules that are not integrated in the studio.

For further information, see the Talend Installation and Upgrade Guide.

2.2.6. Displaying the error log view and managing log
files

The studio provides you with very comprehensive log files that maintain diagnostic information and record any
errors that are encountered in the data profiling process. The error log view is the first place to look when a problem
occurs while profiling data, since it will often contain details of what went wrong and how to fix it.

To display the error log view in the Studio, do one of the following:

1. Either:

• press the Alt+Shift+Q and then L shortcut keys, or,

• select Window > Show View from the menu bar.

The [Show View] dialog box opens.

2. Expand the General folder and select Error Log.

3. Click OK to close the dialog box.

The Error Log view opens in the studio.



Displaying the error log view and managing log files

Talend Open Studio for Data Quality User Guide 15

The filter field at the top of the view enables you to do dynamic filtering, for example as you type your text in the
field, the list will show only the logs that match the filter.

You can use icons on the view toolbar to carry out different management options including exporting and
importing the error log files.

Each error log in the list is preceded by an icon that indicates the severity of the log:  for errors,  for
warnings and  for information.

4. Double-click any of the error log files to open the [Event Detail] dialog box.
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5. If required, click the  icon in the [Event Detail] dialog box to copy the event detail to the Clipboard and
then paste it anywhere you like.

2.2.7. Opening new editors

It is possible to open new analysis or SQL editors in the Profiling and Data Explorer perspectives respectively.

To be able to use Data Explorer in the studio, you must install certain SQL explorer libraries that are required for
data quality. If you do not install these libraries, the Data Explorer perspective will be missing from the studio
and many features will not be available.

For further information about identifying and installing external modules, see the Talend Installation and Upgrade
Guide.

To open an empty new analysis editor, do the following:

1. In the DQ Repository tree view, expand the Data Profiling folder.

2. Right-click the Analysis folder and select New Analysis.

To open an empty new SQL editor from the Data Explorer perspective, do the following:

1. In the Connections view of the Data Explorer perspective, right-click any connection in the list.
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A contextual menu is displayed.

2. Select New SQL Editor.

A new SQL empty editor opens in the Data Explorer perspective.

To open an empty SQL editor from the Profiling perspective of  the studio, see the procedure outlined in Creating
and storing SQL queries.

2.3.  Icons appended on analyses names in
the DQ Repository
When you create any analysis type from the studio, a corresponding analysis item is listed under the Analyses
folder in the DQ Repository tree view.

The number of the analyses created in the studio will be indicated next to this Analyses folder in the DQ Repository tree
view.

This analysis list will give you an idea about any problems in one or more of your analyses before even opening
the analysis.

If an analysis fails to run, a small red-cross icon will be appended on it. If an analysis runs correctly but has violated
thresholds, a warning icon is appended on such analysis.
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Chapter 3. Setting up connections to data
sources
The Profiling perspective of Talend Studio enables you to profile data in different data sources including databases
and files.

This chapter explains how to set up different connections to your data sources. It describes as well how to manage
such metadata connections.
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3.1. Creating connections to data sources
The Profiling perspective of the studio enables you to create connections to databases and to delimited files in
order to profile data in these data sources.

3.1.1. Connecting to a database

Before proceeding to analyze data in a specific database, you must first set up the connection to this database.
From the Profiling perspective of the studio, you can create a connection on the DataBase Management System
(DBMS) and show database content.

The databases you can analyze from the Studio include Hive and Amazon Redshift. For further information about
what databases you can profile, see the section about supported databases in the Talend Installation and Upgrade
Guide.

Connections to different databases are reflected by different tree levels and different icons in the DQ Repository
tree view because the logical and physical structure of data differs from one relational database to another. The
highest level structure "Catalog" followed by "Schema" and finally by "Table" is not applicable to all database
types. For further information, see Catalogs and schemas in database systems.

3.1.1.1. How to create a connection

To create a database connection, do the following:

1. In the DQ Repository tree view, expand Metadata, right-click DB Connections and select Create DB
Connection.

The [Database Connection] wizard opens.
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2. In the Name field, enter a name for this new database connection.

Do not use spaces in the connection name.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

3. If required, set other connection metadata (purpose, description and author name) in the corresponding fields
and click Next to proceed to the next step.
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4. In the DB Type field and from the drop-down list, select the type of database to which you want to connect.
For example, MySQL.

For further information about supported databases, see the Talend Installation and Upgrade Guide.

If you select to connect to a database that is not supported in the studio (using the ODBC or JDBC methods), it
is recommended to use the Java engine to execute the column analyses created on the selected database. For more
information on column analyses, see Defining the columns to be analyzed and setting indicators, and for more
information on the Java engine, see Using the Java or the SQL engine.

5. In the DB Version field, select the version of the database to which you are creating the connection.

6. Enter your login, password, server and port information in their corresponding fields.

7. In the Database field, enter the database name you are connecting to. If you need to connect to all of the
catalogs within one connection, if the database allows you to, leave this field empty.

8. Click the Check button to verify if your connection is successful.

If you have not already installed the database driver (.jar file) necessary to use the database, you will have a
wizard prompting you to install the relative third-party module, click Download and Install and then close
the wizard.
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For further information about identifying and installing external modules, see the Talend Installation and
Upgrade Guide or click the How to install a driver link in the wizard.

For further information about the Module view, see Displaying the Module view.

9. Click Finish to close the [Database Connection] wizard.

A folder for the created database connection is displayed under DB Connection in the DQ Repository tree
view . The connection editor opens with the defined metadata in the studio.

Once you create the connection, you can open in the studio a preview of the data in a specific database table.
For further information, see Previewing data in the SQL editor.

From the connection editor, you can:

• Click Connection information to show the connection parameters for the relevant database.

• Click the Check button to check the status of your current connection.

• Click the Edit... button to open the connection wizard and modify any of the connection information.

For information on how to set up a connection to a file, see Connecting to a file.

3.1.1.2. How to create a connection from a catalog or a schema

You can create a connection on a database catalog or schema directly from a database connection.
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Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database

1. In the DQ Repository tree view, expand Metadata > DB Connections and browse to the catalog or schema
on which you want to create the connection.

2. Right-click a catalog or schema and select Create a new connection.

A confirmation message is displayed.

3. Click OK.

A new connection named after the selected connection and catalog is created under DB Connections.

3.1.1.3. How to create a connection to a custom database

The database connection wizard in the studio lists the databases to which you can create a connection and do
profiling processes.

You can still use the studio to connect to a custom "unsupported" database. To do this, you need to choose General
JDBC as the database type in the connection wizard and then fill in the connection parameters.
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After creating the connection to a custom database, you can profile and monitor data in this database by using
different analyses and indicators, as you do with supported databases. But you may need to change, in the Indicator
Settings editor, the SQL query template for some indicators, such as the regex indicator where each database has
a different function to call. For further information, see How to edit a system indicator and How to edit a user-
defined indicator.

If you have a problem profiling a custom database even though you use a JDBC connection, the reason could be that some
JDBC functions are not implemented by the JDBC driver library. Please raise an issue or ask support via Talend Community
at:

https://community.talend.com/

3.1.1.4. What you need to know about some databases

Teradata:

In the Teradata database, the regular expression function is installed by default only starting from version 14. If you
want to use regular expressions with older versions of this database, you must install a User Defined Function in
Teradata and add the indicator definition for Teradata in the studio. To learn more about using regular expressions
with Teradata, see the documentation on Talend Help Center (https://help.talend.com).

Netezza:

The Netezza database does not support regular expressions. If you want to use regular expressions with this
database, you must:

• Install the SQL Extensions Toolkit package on a Netezza system. Use the regex_like function provided
in this toolkit in the SQL template as documented in http://pic.dhe.ibm.com/infocenter/ntz/v7r0m3/topic/
com.ibm.nz.sqltk.doc/r_sqlext_regexp_like.html.

• Add the indicator definition for Netezza in the Pattern Matching folder in the studio under Libraries >
Indicators > System Indicators.

The query template you need to define for Netezza is as the following: SELECT COUNT(CASE WHEN

REGEXP_LIKE(<%=COLUMN_NAMES%>,<%=PATTERN_EXPR%>) THEN 1 END), COUNT FROM <%=TABLE_NAME%>

<%=WHERE_CLAUSE%>. For a detail procedure about how to add an indicator definition for a specific database,
see How to define a query template for a specific database.

Hive:

If you select to connect to the Hive database, you will be able to create and execute different analyses as with
the other database types.

https://community.talend.com/
https://help.talend.com
http://pic.dhe.ibm.com/infocenter/ntz/v7r0m3/topic/com.ibm.nz.sqltk.doc/r_sqlext_regexp_like.html
http://pic.dhe.ibm.com/infocenter/ntz/v7r0m3/topic/com.ibm.nz.sqltk.doc/r_sqlext_regexp_like.html
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In the connection wizard, you must select from the Distribution list the platform that hosts Hive. You must also
set the Hive version and model. For further information, see http://hadoop.apache.org/.

-If you decide to change the user name in an embedded mode of a Hive connection, you must restart the studio
before being able to successfully run the profiling analyses that use the connection. For further information about
the use of user credentials with Hive, see the documentation on Talend Help Center (https://help.talend.com).

-If the Hadoop distribution to be used is Hortonworks Data Platform V1.2 or Hortonworks Data Platform V1.3,
you must set proper memory allocations for the map and reduce computations to be performed by the Hadoop
system. In the second step in the connection wizard:

http://hadoop.apache.org/
https://help.talend.com
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1. Click the button next to Hadoop Properties and in the open dialog box click the [+] button to add two lines
to the table.

2. Enter the parameters names as mapred.job.map.memory.mb and mapred.job.reduce.memory.mb.

3. Set their values to the by-default value 1000.

This value is normally appropriate for running the computations.

-If the Hadoop distribution to be used is Hortonworks Data Platform V2.0 (YARN), you must set the following
parameter in the Hadoop Properties table:

• The parameter is

yarn.application.classpath

• The value is

/etc/hadoop/conf,/usr/lib/hadoop/,/usr/lib/hadoop/lib/,/usr/lib/hadoop-hdfs/,/usr/
lib/hadoop-hdfs/lib/,/usr/lib/hadoop-yarn/,/usr/lib/hadoop-yarn/lib/,/usr/lib/hadoop-
mapreduce/,/usr/lib/hadoop-mapreduce/lib/

Note that one analysis type and few indicators and functions are still not supported for Hive, see the table below
for more detail:

Unsupported indicators Unsupported functions Unsupported analyses

with SQL engine:

-Soundex Low Frequency.

-Pattern(Low) Frequency.

-Upper Quartile and Lower
Quartile.

-Median.

-the View rows contextual menu for column
analyses with unique, duplicate and all textual
indicators.

For further information on the View rows menu, see
Viewing and exporting analyzed data.

-the only analysis that is not supported for
Hive is Time Correlation Analysis as the
Date data type does not exist in Hive. For
further information on this analysis type,
see Time correlation analyses.
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Unsupported indicators Unsupported functions Unsupported analyses

- All Date Frequency indicators. -the View match rows contextual menu for column
analyses with unique, duplicate and all textual
indicators.

For further information on View match rows, see
Comparing identical columns in different tables.

-all contextual menus on the analysis results of
functional dependency analysis.

For further information on this analysis, see
Detecting anomalies in columns (Functional
Dependency Analysis).

3.1.1.5. Catalogs and schemas in database systems

The structure of a database defines how objects are organized in the database. Different data storage structures
are used to store objects in databases. For example, the highest-level structure (such as "Catalog" followed by
"Schema" and finally by "Table") is not applicable to all database types.

The table below describes the structure of some databases in terms of catalog and schemas:

Database name Version Catalog Schema

Oracle no yes

MySQL yes no

SQLServer 2000/2005/2008 yes yes

DB2 no yes

DB2 ZOS no yes

Sybase yes yes

Informix yes yes

PointBase no yes

PostgreSQL yes yes

AS/400 V5R4 yes yes

Ingres no yes

Teradata no yes

Netezza yes yes

SQLite no no

3.1.2. Connecting to a file

Before proceeding to analyze data in a delimited file, you must first set up the connection to this file.

To create a connection to a delimited file, do the following:

1. Expand the Metadata folder.
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2. Right-click FileDelimited connections and then select Create File Delimited Connection to open the [New
Delimited File] wizard.

3. Follow the steps defined in the wizard to create a connection to a delimited file.

You can then create a column analysis and drop the columns to analyze from the delimited file metadata
in the DQ Repository tree view to the open analysis editor. For further information, see Creating a basic
column analysis on a file.

For information on how to set up a connection to a database, see Connecting to a database.

3.2.  Managing connections to data sources
Several management options are available for each of the connections created in the studio.

3.2.1.  Managing database connections

Many management options are available for database connections including editing and duplicating the connection
or adding a task to it.

The sections below explain in detail these management options.

3.2.1.1. How to open or edit a database connection

You can edit the connection to a specific database and change the connection metadata and the connection
information.

Prerequisite(s): A database connection is created in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To edit an existing database connection, do the following:
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1. In the DQ Repository tree view, expand Metadata > DB Connection.

2. Either:

• Double-click the database connection you want to open, or,

• Right-click the database connection and select Open in the contextual menu.

The connection editor for the selected database connection is displayed.
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3. Modify the connection metadata in the Connection Metadata view, as required.

4. Click the Edit... button in the Connection information view to open the [Database Connection] wizard.
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5. Go through the steps in the wizard and modify the database connection settings as required.

6. Click Finish to validate the modifications.

A dialog box opens prompting you to reload the updated database connection.

7. Select the reload option if you want to reload the new database structure for the updated database connection.

If you select the don't reload option, you will still be able to execute the analyses using the connection even after
you update it.

If the database connection is used by profiling analyses in the Studio, another dialog box is displayed to list
all the analyses that use the database connection. It alerts you that if you reload the database new structure,
all the analyses using the connection will become unusable although they will be always listed in the DQ
Repository tree view.
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8. Click OK to accept reloading the database structure or Cancel to cancel the operation and close the dialog
box.

A number of confirmation messages are displayed one after the other.

9. Click OK to close the messages and reload the structure of the new connection.

3.2.1.2. How to filter a database connection

After setting a specific database connection in the studio, you may not want to view all databases in the DQ
Repository tree view of your Studio.

You can filter your database connections to list the databases that match the filter you set. This option is very
helpful when the number of databases in a specific connection is very big.

Prerequisite(s): A database connection is already created in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To filter a database connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connection.
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2. Right-click the database connection you want to filter and select Package Filter to open the corresponding
dialog box.

3. In the Package Filter field, enter the complete name of the database you want to view and then click Finish
to close the dialog box.

Only the database that matches the filter you set is listed under the database connection in the DQ Repository
tree view.
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To cancel the filter, do the following:

1. In the [Package Filter] dialog box, delete the text from the Package Filter field.

2. Click Finish  to close the dialog box.

All databases are listed under the selected database connection in the DQ Repository tree view.

3.2.1.3. How to duplicate a database connection

To avoid creating a DB connection from scratch, you can duplicate an existing one in the DB Connections list
and work around its metadata to have a new connection.

Prerequisite(s): A database connection is created in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To duplicate a connection to a specific database, do the following:

1. In the DQ Repository tree view, expand Metadata DB Connections.

2. Right-click the connection you want to duplicate and select Duplicate from the contextual menu.
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The duplicated database connection shows under the connection list in the DQ Repository tree view as a copy of
the original connection. You can now open the duplicated connection and modify its metadata as needed.

3.2.1.4. How to add a task to a database connection or any of its
elements

You can add a task to a database connection to use it as a reminder to modify the connection or to flag a problem
that needs to be solved later, for example. You can also add a task to a catalog, a table or a column in the connection.

Prerequisite(s): A database connection is created in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To add a task to a database connection, do the following:

1. Expand Metadata and DB connections.

2. Right-click the connection to which you want to add a task, and then select Add task... from the contextual
menu.

The [Properties] dialog box opens showing the metadata of the selected connection.
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3. In the Description field, enter a short description for the task you want to attach to the selected connection.

4. On the Priority list, select the priority level and then click OK to close the dialog box.

The created task is added to the Tasks list.

You can follow the same steps in the above procedure to add a task to a catalog, a table or a column in the connection. For
further information, see Adding a task to a column in a database connection.

For more information on how to access the task list, see Displaying the task list.

3.2.1.5. How to filter tables/views in a database connection

You can filter the tables/views to list under any database connection.

This option is very helpful when the number of tables in the database to which the studio is connecting is very
big. If so, a message is displayed prompting you to set a table filter on the database connection in order to list only
defined tables in the DQ Repository tree view.

Prerequisite(s): A database connection is already created in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To filter table/views in a database connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Expand the database connection in which you want to filter tables/views and right-click the desired catalog/
schema.
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3. Select Table/View Filter from the list to display the corresponding dialog box.

4. Set a table and a view filter in the corresponding fields and click Finish to close the dialog box.

Only tables/views that match the filter you set are listed in the DQ Repository tree view.

3.2.1.6. How to delete or restore a database connection

You can move a database connection to the studio recycle bin whether it is used by analyses or not. You can also
restore the deleted database connection.

Prerequisite(s): A database connection is created in the studio. For further information, see Connecting to a
database.

To delete a database connection from the Metadata node, do the following:
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1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Right-click a database connection and select Delete in the contextual menu.

The database connection is moved to the Recycle Bin.

You can still run the analyses that use the connection in the recycle bin. However, an alert message will be
displayed next to the connection name in the analysis editor.

To delete the connection from the Recycle Bin, do the following:

1. Right-click the database connection in the Recycle Bin and choose Delete from the contextual menu.

A confirm deletion dialog box is displayed.

2. Click OK.

If the connection is not used by any analysis, it is deleted from the studio.

If the connection is used by one or more analyses in the studio, a dialog box is displayed to list such analyses.
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3. Either:

• Click OK to close the dialog box without deleting the database connection from the recycle bin.

• Select the Force to delete all the dependencies check box and then click OK to delete the database
connection from the Recycle Bin and to delete all the dependent analyses from the Data Profiling node.

You can also delete permanently the database connection by emptying the recycle bin. To empty the Recycle Bin,
do the following:

1. Right-click the Recycle Bin and select Empty recycle bin.

If the connection is not used by any analysis in the current Studio, a confirmation dialog box is displayed.

2. Click Yes to empty the recycle bin.

If the connection is used by one or more analyses in the studio, a dialog box is displayed to list these analyses.
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3. Click OK to close the dialog box without removing the connection from the recycle bin.

To restore a database connection from the Recycle Bin, do the following:

• In the Recycle Bin, right-click the connection and select Restore.

The database connection is moved back to the Metadata node.

3.2.2.  Managing file connections

Few management options are available for file connections including editing or deleting the connection, adding
a task to it, or importing and exporting the connection.

You can edit the connection to a specific file and change the connection metadata and the connection information.

Prerequisite(s): A file connection is created in the Profiling perspective of the studio. For further information,
see Connecting to a file.

To edit an existing file connection, do the following:

1. In the DQ Repository tree view, expand Metadata > Filedelimited Connection.

2. Double-click the file connection you want to open.

The connection editor for the selected connection is displayed.

3. Modify the connection metadata as required and click Next.

4. Go through the steps in the wizard and modify the file connection settings as required.

5. Click Finish to validate the modifications.

Other management procedures for file connection are the same as those for databases.

For further information on how to add a task to a file connection, see How to add a task to a database connection
or any of its elements.
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For further information on how to delete or restore a file connection, see How to delete or restore a database
connection.

For further information on how to import or export a file connection, see Importing data profiling items.
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Chapter 4. Profiling database content
This chapter provides the information you need to analyze the data available in a database and collect statistics
and information about that data.
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4.1. Analyzing databases
You can analyze the content of a database to have an overview of the number of tables in the database, rows per
table and indexes and primary keys.

You can also analyze one specific catalog or schema in a database, if a catalog or schema is used in the physical
structure of the database.

4.1.1. Creating a database content analysis

From the Profiling perspective of the studio, you can create an analysis to examine the content of a given database.

Prerequisite(s): At least, one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To create a database content analysis, you must first define the relevant analysis and then select the database
connection you want to analyze.

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.

3. In the filter field, start typing connection overview analysis, select Connection Overview Analysis from the
list that is displayed and click Next.
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You can create a database content analysis in a shortcut procedure if you right-click the database under
Metadata > DB connections and select Overview analysis from the contextual menu.

4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. Set the analysis metadata (purpose, description and author name) in the corresponding fields and click Next.

Selecting the database connection you want to analyze

1. Expand DB Connections and select a database connection to analyze, if more than one exists.
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2. Click Next.

3. Set filters on the tables and/or views you want to analyze in their corresponding fields according to your
needs using the SQL language.

By default, the analysis examines all tables and views in the database.

4. Click Finish to close the [Create New Analysis] wizard.

A folder for the newly created analysis is listed under the Analyses folder in the DQ Repository tree view,
and the connection editor opens with the defined metadata.
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The display of the connection editor depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

5. Click Analysis Parameters and:

• In the Number of connections per analysis field, set the number of concurrent connections allowed per
analysis to the selected database connection.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

• Check/modify filters on table and/or views, if any.

• Select the Reload databases check box if you want to reload all databases in your connection on the server
when you run the overview analysis.

When you try to reload a database, a message will prompt you for confirmation as any change in the
database structure may affect existing analyses.

6. In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

The table in this view lists all context environments and their values you define in the Contexts view in the
analysis editor. For further information, see Using context variables in analyses.

7. Press F6 to execute the analysis.

A message opens at the bottom of the editor to confirm that the operation is in progress and analysis results
are opened in the Analysis Results view.

From the Statistical information view, you can:

• Click a catalog or a schema to list all tables included in it along with a summary of their content: number of
rows, keys and user-defined indexes.
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The selected catalog or schema is highlighted in blue. Catalogs or schemas highlighted in red indicate potential
problems in data.

• Right-click a catalog or a schema and select Overview analysis to analyze the content of the selected item.

• Right-click a table or a view and select Table analysis to create a table analysis on the selected item. You can
also view the keys and indexes of a selected table. For further information, see Displaying keys and indexes
of database tables.

• Click any column header in the analytical table to sort alphabetically the data listed in catalogs or schemas.

4.1.2. Creating a catalog or schema analysis

You can use the Profiling perspective of the studio to analyze one specific catalog or schema in a database, if this
entity is used in the physical structure of the database. The result of the analysis gives analytical information about
the content of this schema, for example number of rows, number of tables, number of rows per table and so on.

Prerequisite(s): At least one database connection has been created to connect to a database that uses the "catalog"
or "schema" entity. For further information, see Connecting to a database.

1. Under DB connections in the DQ Repository tree view, right-click the catalog or schema for which you
want to create content analysis and, select Overview analysis from the contextual menu.

This example shows how to create a schema analysis.

2. In the wizard that opens, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

3. If required, set the analysis metadata (purpose, description and author name) in the corresponding fields and
click Next.

4. Set filters on the tables and/or views you want to analyze in their corresponding fields according to your
needs using the SQL language.

By default, the analysis examines all tables and views in the catalog.
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5. Click Finish.

A folder for the newly created analysis is listed under Analysis in the DQ Repository tree view, and the
analysis editor opens with the defined metadata.

6. Press F6 to execute the analysis.

A message opens at the bottom of the editor to confirm that the operation is in progress and analysis results
are opened in the Analysis Results view.

From the Statistical information view, you can:

• Click the schema to list all tables included in it along with a summary of their content: number of rows, keys
and user-defined indexes.

The selected schema is highlighted in blue. Schemas highlighted in red indicate potential problems in data.

• Right-click a schema and select Overview analysis to analyze the content of the selected item.

• Right-click a table or a view and select Table analysis to create a table analysis on the selected item. You can
also view the keys and indexes of a selected table. For further information, see Displaying keys and indexes
of database tables.
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• Click any column header in the analytical table to sort the listed data alphabetically.

4.2. Previewing data in the SQL editor
After you create a connection to a database, you can open a view in the studio to see actual data in the database.

Prerequisite(s): At least one database connection has been created in the Profiling perspective of the studio. For
further information, see Connecting to a database.

To display a preview of actual data of a given database table, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Browse to a table in a given database connection, right-click it and select Preview.

The SQL editor opens in the studio listing the data in the selected table.

3. If required, do any modifications in the query and save it.

The query is listed under the Libraries > Source Files folder in the DQ Repository  tree view.

4.3. Displaying keys and indexes of database
tables
After analyzing the content of a database as outlined in Creating a database content analysis, you can display
the details of the key and user-defined index of a given table. This information could be very interesting for the
database administrator.
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Prerequisite(s): At least one database content analysis has been created and executed in the studio. For further
information, see Creating a database content analysis.

To display the details of the key and user-defined index of a given table in the analyzed database, do the following:

1. In the Analysis Results view of the analysis editor, click a catalog or a schema under Statistical Information.

All the tables included in the selected catalog or schema are listed along with a summary of their content:
number of rows, keys and user-defined indexes.

2. In the table list, right-click the table and select View keys.

You can not display the key details of tables in a Hive connection.
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The Database Structure and the Database Detail views display the structure of the analyzed database and
information about the primary key of the selected table.

If one or both views do not show, select Window > Show View > Database Structure or Window > Show
View > Database Detail.

3. In the table list, right-click the table and select View indexes.

You can not display the index details of tables in a Hive connection.

The Database Structure and the Database Detail  views display the structure of the analyzed database and
information about the user-defined index of the selected table.

4. If required, click any of the tabs in the Database Detail view to display the relevant metadata about the
selected table.
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4.4. Synchronizing metadata connections and
database structures
When the data in a source database is changed or updated, it is necessary that the relevant connection structure in
the studio follows that change or update as well. Otherwise, errors may occur when trying to analyze a column
that has been modified/deleted in a database.

You can synchronize the connection structure displayed in the DQ Repository tree view with the database
structures to eliminate any incoherences. You can perform synchronization at the following three different levels:

• DB connection: to refresh the catalog and schema lists,

• Tables: to refresh the list of tables,

• Column: to refresh the list of columns.

4.4.1. How to synchronize and reload catalog and
schema lists

You can compare and match the catalog and schema lists in the DQ Repository tree view with those in the
database.

Prerequisite(s): A database connection has been created in the Profiling perspective of the studio.

To synchronize the catalog and schema lists, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Right-click the database connection you want to synchronize with the database and select Reload database
list.
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A message will prompt you for confirmation as any change in the database structure may affect the analyses
created on these catalogus or schemas from the Studio.

3. Click OK to close the confirmation message, or Cancel to stop the operation.

The selected database connection is updated with the new catalogs and schemas, if any.

4.4.2. How to synchronize and reload table lists

You can compare and match the table lists in the DQ Repository tree view with those in the database.

Prerequisite(s): A database connection has already been created in the Profiling perspective of the studio.

To synchronize and reload a table list, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections  .

2. Browse through the entities in your database connection to reach the Table folder you want to synchronize
with the database.

3. Right-click the Tables folder and select Reload table list.
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A message will prompt you for confirmation as any change in the database structure may affect the analyses
created on these tables from the Studio.

4. Click OK to close the confirmation message, or Cancel to stop the operation.

The selected table list is updated with the new tables in the database, if any.

4.4.3. How to synchronize and reload column lists

You can compare and match the column lists in the DQ Repository tree view with those in the database.

Prerequisite(s): A database connection has been created in the Profiling perspective of the studio.

To synchronize and reload a column list, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Browse through the entities in your database connection to reach the Columns folder you want to synchronize
with the database.

3. Right-click the Columns folder and select Reload column list.
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A message will prompt you for confirmation as any change in the database structure may affect the analyses
created on these columns from the Studio.

4. Click OK to close the confirmation message, or Cancel to stop the operation.

The selected column list is updated with the new column in the database, if any.
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Chapter 5. Column analyses
This chapter describes the process of using the studio to examine columns in databases and in delimited files. You
can run this analysis on several columns but each column is analyzed separately and independently.
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5.1. Where to start?
Talend Studio enables you to examine and collect statistics and information about the data available in database
columns and in delimited files.

From the Profiling perspective, you can:

• design a column analysis from scratch and define the analysis settings manually,

• create column analyses automatically preconfigured with the indicators appropriate to the type you select,

To create a column analysis:

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analysis folder and select New Analysis.

3. From the Column Analysis folder, select:

Option To...

Basic Column Analysis generate an empty column analysis where you can select the columns to analyze and
manually assign the indicators on each column.

For further information, see Creating a basic analysis on a database column.

Discrete Data Analysis create a column analysis on numerical data preconfigured with the Bin Frequency and
simple statistics indicators. You can then configure further the analysis or modify it in
order to convert continuous data into discrete bins (ranges) according to your needs.

For further information, see Analyzing discrete data.

Nominal Values Analysis create a column analysis on nominal data preconfigured with indicators appropriate for
nominal data, namely Value Frequency, Simple Statistics and Text Statistics indicators.

For example results about these statistics, see Finalizing and executing the column
analysis.

Pattern Frequency Analysis create a column analysis preconfigured with the Pattern Frequency, Pattern Low
Frequency and the row and null count indicators.

This analysis can discover patterns in your data. It shows frequent patterns and rare
patterns so that you can identify quality issues more easily.

For example results about these statistics, see Finalizing and executing the column
analysis.

To learn more about the databases and engines supported with Pattern Frequency Statistics
indicators, see the documentation on Talend Help Center (https://help.talend.com).

Summary Statistics Analysis create a column analysis on numerical data preconfigured with the Summary Statistics
and the row and null count indicators.

This helps you to get a good idea of the shape of your numeric data by computing the
range, the inter quartile range and the mean and median values.

For an example of the use of Summary Statistics, see How to set system or user-defined
indicators and Finalizing and executing the column analysis.

Usually, the sequence of profiling data in one or multiple columns involves the following steps:

1. Connecting to the data source. For further information, see Setting up connections to data sources.

2. Defining one or more columns on which to carry out data profiling processes that will define the content,
structure and quality of the data included in the column(s).

3. Settings predefined system indicators or indicators defined by the user on the column(s) that need to be
analyzed or monitored. These indicators will represent the results achieved through the implementation of
different patterns.

https://help.talend.com
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4. Adding to the column analyses the patterns against which you can define the content, structure and quality
of the data.

For further information, see How to add a regular expression or an SQL pattern to a column analysis.

The Creating a basic analysis on a database column section explains the procedures to analyze the content of one
or multiple columns in a database.

The Creating a basic column analysis on a file section explains the procedures to analyze columns in delimited
files.

5.2. Creating a basic analysis on a database
column
You can build your analysis from scratch, analyze the content of one or multiple columns and execute the created
analyses using the Java or the SQL engine. This type of analysis provides statistics about the values within each
column.

When you use the Java engine to run a column analysis, you can view the analyzed data according to parameters
you set yourself. For more information, see Using the Java or the SQL engine.

When you use the Java engine to run a column analysis on big sets or on data with many problems, it is advisable to define
a maximum memory size threshold to execute the analysis as you may end up with a Java heap error. For more information,
see Defining the maximum memory size threshold.

You can also analyze a set of columns. This type of analysis provides statistics on the values across all the data
set (full records). For more information, see Analyzing tables in databases.

The sequence of creating a basic column analysis involves the following steps:

1. Defining the column(s) to be analyzed.

For more information, see How to define the columns to be analyzed.

2. Settings predefined system indicators or indicators defined by the user for the column(s).

For more information, see How to set indicators on columns. For more information on indicator types and
indicator management, see Indicators.

3. Adding the patterns against which to define the content, structure and quality of the data.

For more information, see Using regular expressions and SQL patterns in a column analysis. For more
information on pattern types and management, see Patterns.

5.2.1. Defining the columns to be analyzed and setting
indicators

5.2.1.1. How to define the columns to be analyzed

The first step in analyzing the content of one or multiple columns is to define the column(s) to be analyzed. The
analysis results provides statistics about the values within each column.
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Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To analyze one or more columns, do the following:

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analysis folder and select New Analysis.

The [Create New Analysis] wizard opens.

3. In the filter field, start typing basic column analysis, select Basic Column Analysis and click Next.
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4. In the Name field, enter a name for the current column analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. Set column analysis metadata (purpose, description and author name) in the corresponding fields and click
Next to proceed to the next step.

Selecting the database columns and setting sample data

1. Expand DB connections and in the desired database, browse to the columns you want to analyze.
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When profiling a DB2 database, if double quotes exist in the column names of a table, the double quotation marks
cannot be retrieved when retrieving the column. Therefore, it is recommended not to use double quotes in column
names in a DB2 database table.

2. Select the columns and then click Finish to close the wizard.

A file for the newly created column analysis is listed under the Analysis node in the DQ Repository tree
view, and the analysis editor opens with the analysis metadata.
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This example analyzes full names, email addresses and sales figures.

3. In the Data preview view, click Refresh Data.

The data in the selected columns is displayed in the table.

4. In the Data preview view, select:

Option To...

New Connection open a wizard and create a connection to the data source from within the editor.

For further information about how to create a connection to data sources, see Connecting
to a database and Connecting to a file.

The Connection field on top of this section lists all the connections created in the Studio.

Select Columns open the Column Selection dialog box where you can select the columns to analyze or
change the selection of the columns listed in the table.

From the open dialog box, you can filter the table or column lists by using the Table filter
or Column filter fields respectively.

Select Indicators open the [Indicator Selection] dialog box where you can select the indicators to use for
profiling columns.
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For further information, see How to set indicators on columns.

n first rows

or

n random rows

list in the table N first data records from the selected columns or list N random records
from the selected columns.

Refresh Data display the data in the selected columns according to the criteria you set.

Run with sample data run the analysis only on the sample data set in the Limit field.

5. In the Limit field, set the number for the data records you want to display in the table and use as sample data.

6. In the Analyzed Columns view, use the arrows in the top right corner to open different pages in the view
if you analyze large number of columns.

You can drag the columns to be analyzed directly from the DQ Repository  tree view to the Analyzed
Columns list in this view.

If one of the columns you want to analyze is a primary or a foreign key, its data mining type becomes
automatically Nominal when you list it in the Analyzed Columns view. For more information on data mining
types, see Data mining types.

7. If required, right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view to locate it in the database connection in the DQ Repository tree view.

When you select to analyze Date columns and run the analysis with the Java engine, the date information is
stored in the studio as regular date/time of format YYYY-MM-DD HH:mm:ss.SSS for date/timestamp and of format
HH:mm:ss.SSS for time. The date and time formats are slightly different when you run the analysis with the SQL
engine.

5.2.1.2. How to set indicators on columns

The second step after defining the columns to be analyzed is to set either system or user-defined indicators for
each of the defined columns.

How to set system or user-defined indicators

Prerequisite(s): A column analysis is open in the analysis editor in the Profiling perspective of the studio. For
more information, see How to define the columns to be analyzed.

To set system indicators for the columns to be analyzed, do the following:

1. From the Data preview view in the analysis editor, click Select indicators to open the [Indicator Selection]
dialog box.
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2. From the [Indicator Selection] dialog box:

• In the Data preview section, place the cursor on a row to display the complete data. This section lists the
sample data you define in the analysis editor.

• Click in the cells next to indicators names to set indicator parameters for the analyzed columns as needed.
You can assign system or user-defined indicators to the columns.

• Select the Hide non applicable indicators check box to hide the system and user-defined indicators that
are not compatible with the engine you select to execute the analysis.

• If required, change the order of columns by dropping them with the cursor.

The order of the columns will be changed accordingly in the analysis editor.
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- It is not very useful to use Pattern Frequency Statistics on a column of a Date type in databases when executing
the analysis with the SQL engine. No data quality issues are returned by this indicator as all dates will be displayed
using one single format. To learn more about profiling Date columns in Oracle, see the documentation on Talend Help
Center (https://help.talend.com).

- If you attach the Date Pattern Frequency to a date column in your analysis, you can generate a date regular
expression from the analysis results. For more information, see How to generate a regular expression from the Date
Pattern Frequency.

3. Click OK.

Indicators are accordingly attached to the analyzed columns in the Analyzed Columns view.

The analysis in this example provides/computes the following:

• simple statistics on all columns. For further information about these indicators, see Simple statistics,

• the characteristics of textual fields and the number of most frequent values for each distinct record in the
fullname column . For further information, see Text statistics and Advanced statistics respectively,

• patterns in the email column to show frequent and rare patterns so that you can identify quality issues more
easily. For further information about these indicators, see Pattern frequency statistics,

• the range, the inter quartile range and the mean and median values of the numeric data in the total_sales
column. For further information about these indicators, see Summary statistics.

• the frequency of the digits 1 through 9 in the sales figures to detect fraud. For further information, see
Fraud Detection.

How to set options for system or user-defined indicators

You can define expected thresholds on the indicator's value. The threshold you define is used for measuring the
quality of data. If the indicator's value is outside the defined threshold, then the data is of bad quality. You can
define only one threshold or no threshold at all. You may set these thresholds either by value or by percentage
with respect to the row count.

Prerequisite(s): A column analysis is open in the analysis editor in the Profiling perspective of the studio. For
more information, see How to define the columns to be analyzed.

For more information about setting indicators, see How to set system or user-defined indicators.

To set options for system or user-defined indicators, do the following:

1.
In the Analyzed Columns view in the analysis editor, click the option icon  next to the indicator.

2. In the open dialog box, set the parameters for the given indicator.

For example, if you want to flag if there are null values in the column you analyze, you can set 0 in the Upper
threshold field for the Null Count indicator.

https://help.talend.com
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Indicators settings dialog boxes differ according to the parameters specific for each indicator. For more
information about different indicator parameters, see Indicator parameters.

3. Click Finish to close the dialog box.

4. Save the analysis.

How to set user-defined indicators from the analysis editor

Prerequisite(s):

• A column analysis is open in the analysis editor in the Profiling perspective of the studio. For more information,
see How to define the columns to be analyzed.

• A user-defined indicator is created in the Profiling perspective of the studio. For more information, see How
to create SQL user-defined indicators.

To set user-defined indicators from the analysis editor for the columns to be analyzed, do the following:

1. Either:

1. In the analysis editor and from the Analyzed Columns view, click the  icon next to the column name
to which you want to define the indicator.

The [UDI selector] dialog box opens.
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2. Select the user-defined indicators and then click OK.

Or:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. From the User Defined Indicator folder, drop the user-defined indicator(s) against which you want to
analyze the column content to the column name in the Analyzed Columns view.

The user-defined indicator is listed under the column name.

3. If required, set a threshold for the user-defined indicator.

For further information, see How to set options for system or user-defined indicators.

2. Save the analysis.

5.2.2. Finalizing and executing the column analysis

After defining the column(s) to be analyzed and setting indicators, you may want to filter the data that you want
to analyze and decide what engine to use to execute the column analysis.

Prerequisite(s):

• The column analysis is open in the analysis editor in the Profiling perspective of the studio . For more
information, see How to define the columns to be analyzed.

• You have set system or predefined indicators for the column analysis. For more information, see How to set
indicators on columns.

• You have installed in the studio the SQL explorer libraries that are required for data quality.

To finalize the column analysis defined in Defining the columns to be analyzed and setting indicators, do the
following:
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1. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

2. In the Analysis Parameters View:

• In the Number of connections per analysis field, set the number of concurrent connections allowed per
analysis to the selected database connection.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

• From the Execution engine list, select the engine, Java or SQL, you want to use to execute the analysis.

If you select the Java engine:

• select the Allow drill down check box to be able to drill down, in the Analysis Results view, the results
of all indicators except Row Count.

• in the Max number of rows kept per indicator field, set the number of the data rows you want to
drill down.

For further information about these engines, see Using the Java or the SQL engine.

3. If you have defined context variables in the Contexts view in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

4. Save the analysis and press F6 to execute it.

The editor switches to the Analysis Results view.

When you use the SQL engine, the analysis runs multiple indicators in parallel and results are refreshed in
the charts while the analysis is still in progress.

Below are the graphics representing the Frequency and Text Statistics for the fullname column.
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For further information about the Frequency and Text Statistics, see Advanced statistics and Text statistics
respectively.

Below are the graphics representing the Pattern Frequency and Pattern Low Frequency statistics for the email
column.

The patterns in the table use a and A to represent the email values. Each pattern can have till 30
characters. If the total number of characters exceeds 30, the pattern is represented as the following:
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aaaaaAAAAAaaaaaAAAAAaaaaaAAAAA...<total number of characters>, and you can place your pointer on
the pattern in the table to get the original value.

For further information about these indicators, see Pattern frequency statistics.

Below are the graphics representing the Summary Statistics for the total_sales column.

For further information about these indicators, see Summary statistics.

And below are the graphics representing the order of magnitude and the Benford's law statistics for the
total_sales column.

For further information about the Benford's law statistics usually used as an indicator of accounting and
expenses fraud in lists or tables, see Fraud Detection.
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If you execute this analysis using the Java engine and then select the Allow drill down check box in the Analysis
parameters view, you can store locally the analyzed data and thus access it in the Analysis Results > Data view.
You can use the Max number of rows kept per indicator field to decide the number of the data rows you want
to make accessible.

When you select the Java engine, the system will look for Java regular expressions first, if none is found, it looks
for SQL regular expressions.

If you select to connect to a database that is not supported in the studio (using the ODBC or JDBC methods), it is
recommended to use the Java engine to execute the column analyses created on the selected database. For more information
on the java engine, see Using the Java or the SQL engine.

If you execute this analysis using the SQL engine, you can view the executed query for each of the attached
indicators if you right-click an indicator and then select the View executed query option from the list. However,
when you use the Java engine, SQL queries will not be accessible and thus clicking this option will open a warning
message.

For more information on the Java and the SQL engines, see Using the Java or the SQL engine.

5.2.3. Using the Java or the SQL engine

After setting the analysis parameters in the analysis editor, you can use either the Java or the SQL engine to execute
your analysis.

The choice of the engine can sometimes slightly change analysis results, for example when you select the summary
statistics indicators to profile a DB2 database. This is because indicators are computed differently depending on
the database type, and also because Talend uses special functions when working with Java.

SQL engine:

If you use the SQL engine to execute a column analysis:

• an SQL query is generated for each indicator used in the column analysis, the analysis runs multiple indicators
in parallel and results are refreshed in the charts while the analysis is still in progress,
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• data monitoring and processing is carried on the DBMS,

• only statistical results are retrieved locally.

By using this engine, you guarantee system better performance. You can also access valid/invalid data in the data
explorer, for more information, see Viewing and exporting analyzed data.

Java engine:

If you use the Java engine to execute a column analysis:

• only one query is generated for all indicators used in the column analysis,

• all monitored data is retrieved locally to be analyzed,

• you can set the parameters to decide whether to access the analyzed data and how many data rows to show per
indicator. This will help to avoid memory limitation issues since it is impossible to store all analyzed data.

When you execute the column analysis with the Java engine, you do not need different query templates specific
for each database. However, system performance is significantly reduced in comparison with the SQL engine.
Executing the analysis with the Java engine uses disk space as all data is retrieved and stored locally. If
you want to free up some space, you may delete the data stored in the main studio directory, at Talend-
Studio>workspace>project_name>Work_MapDB.

To set the parameters to access analyzed data when using the Java engine, do the following:

1. In the Analysis Parameter view of the column analysis editor, select Java from the Execution engine list.

2. Select the Allow drill down check box to store locally the data that will be analyzed by the current analysis.

This check box is usually selected by default.

3. In the Max number of rows kept per indicator field enter the number of the data rows you want to make
accessible.

This field is set to 50 by default.

You can now run your analysis and then have access to the analyzed data according to the set parameters. For
more information, see Viewing and exporting analyzed data.

5.2.4. Accessing the detailed view of the database
column analysis

Prerequisite(s): You have selected the Profiling perspective in the studio. A column analysis is defined and
executed.
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To access a more detailed view of the analysis results of the procedures outlined in Defining the columns to be
analyzed and setting indicators and Finalizing and executing the column analysis, do the following:

1. Click the Analysis Results tab at the bottom of the analysis editor to open the corresponding view.

2. Click the Analysis Result  tab in the view and then the name of the analyzed column for which you want
to open the detailed results.

The display of the Analysis Results view depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.

The detailed analysis results view shows the generated graphics for the analyzed columns accompanied with
tables that detail the statistic results.

Below are the tables that accompany the Frequency and Simple Statistics graphics in the Analysis Results
view for the analyzed email column.

In the Simple Statistics table, if an indicator value is displayed in red, this means that a threshold has been set
on the indicator in the column analysis editor and that this threshold has been violated. For further information
about data thresholds, see How to set options for system or user-defined indicators.

Below are the tables and the graphics representing the order of magnitude and the Benford's law statistics in
the Analysis Results view for the analyzed total_sales column.



Viewing and exporting analyzed data

Talend Open Studio for Data Quality User Guide 75

For further information about the Benford's law statistics usually used as an indicator of accounting and
expenses fraud in lists or tables, see Fraud Detection.

3. Right-click any data row in the result tables and select View rows to access a view of the analyzed data.

For more information, see Viewing and exporting analyzed data.

5.2.5. Viewing and exporting analyzed data

After running your analysis using the SQL or the Java engine and from the Analysis Results view of the analysis
editor, you can right-click any of the rows in the statistic result tables and access a view of the actual data.

After running your analysis using the Java engine, you can use the analysis results to access a view of the actual
data.

After running your analysis using the SQL engine, you can use the analysis results to open the Data Explorer
perspective and access a view of the actual data.
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Prerequisite(s):You have selected the Profiling perspective in the studio. A column analysis has been created
and executed.

To view and export the analyzed data, do the following:

1. At the bottom of the analysis editor, click the Analysis Results tab to open a detailed view of the analysis
results.

2. Right-click a data row in the statistic results of the analyzed columns and select an option as the following:

Option Operation

View rows open a view on a list of all data rows in the analyzed column.

For the Duplicate Count indicator, the View rows option will list all the rows
that are duplicated. So if the duplicate count is 12 for example, this option will
list 24 rows.

View values open a view on a list of the actual data values of the analyzed column.

Options other than the above listed ones are available when using regular expressions and SQL patterns in a column
analysis. For further information, see Using regular expressions and SQL patterns in a column analysis and How
to view the data analyzed against patterns.

When using the SQL engine, the view opens in the Data Explorer perspective listing the rows or the values of
the analyzed data according to the limits set in the data explorer.

If the Data Explorer perspective is missing from the studio, you must install certain SQL explorer libraries that
are required for data quality to work correctly, otherwise you may get an error message.

For further information about identifying and installing external modules, see the Talend Installation and Upgrade
Guide.
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This explorer view will give also some basic information about the analysis itself. Such information is of great
help when working with multiple analysis at the same time.

The data explorer does not support connections which has empty user name, such as Single sign-on of MS SQL Server.
If you analyze data using such connection and you try to view data rows and values in the Data Explorer perspective, a
warning message prompt you to set your connection credentials to the SQL Server.

When using the Java engine, the view opens in the studio listing the number of the analyzed data rows you set in
the Analysis parameters view of the analysis editor. For more information, see Using the Java or the SQL engine.

From this view, you can export the analyzed data into a csv file. To do that:

1.
Click the  icon in the upper left corner of the view.

A dialog box opens.
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2. Click the Choose... button and browse to where you want to store the csv file and give it a name.

3. Click OK to close the dialog box.

A csv file is created in the specified place holding all the analyzed data rows listed in the view.

5.2.6. Using regular expressions and SQL patterns in a
column analysis

You can use regular expressions or SQL patterns in column analyses. These expressions and patterns will help
you define the content, structure and quality of the data included in the analyzed columns.

For more information on regular expressions and SQL patterns, see Patterns and indicators and Table analyses.
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5.2.6.1. How to add a regular expression or an SQL pattern to a
column analysis

You can add to any column analysis one or more regular expressions or SQL patterns against which you can match
the content of the column to be analyzed.

If the database you are using does not support regular expressions or if the query template is not defined in the studio, you
need first to declare the user defined function and define the query template before being able to add any of the specified
patterns to the column analysis. For more information, see Managing User-Defined Functions in databases.

Prerequisite(s): You have selected the Profiling perspective in the studio. A column analysis is open in the
analysis editor.

To add a regular expression or an SQL pattern to a column analysis, do the following:

1. Follow the steps outlined in How to define the columns to be analyzed to create a column analysis.

2.
In the Analyze Columns view in the analysis editor, click the  icon next to the column name to which you
want to add a regular expression or an SQL pattern, the email column in this example.

The [Pattern Selector] dialog box opens.

3. Expand Patterns and browse to the regular expression or/and the SQL patterns you want to add to the column
analysis.

4. Select the check box(es) of the expression(s) or pattern(s) you want to add to the selected column.
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5. Click OK to proceed to the next step.

The added regular expression(s) or SQL pattern(s) are displayed under the analyzed column in the Analyzed
Column list.

You can add a regular expression or an SQL pattern to a column simply by a drag and drop operation from
the DQ Repository tree view onto the analyzed column.

6. Press F6 to execute the column analysis.

The editor switches to the Analysis result view. The results of the column analysis include those for pattern
matching.

5.2.6.2. How to edit a pattern in the column analysis

Prerequisite(s): You have selected the Profiling perspective in the studio. A column analysis is open in the
analysis editor.

To edit a pattern added to an analyzed column:

1. In the Analyze Columns view in the analysis editor, right-click the pattern you want to edit and select Edit
pattern from the contextual menu.
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The pattern editor opens showing the selected pattern metadata.

2. In the Pattern Definition view, edit the pattern definition, or change the selected database, or add other
patterns specific to available databases using the [+] button.
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If the regular pattern is simple enough to be used in all databases, select Default in the list.

When you edit a pattern through the analysis editor, you modify the pattern in the studio repository. Make
sure that your modifications are suitable for all other analyses that may be using the modified pattern.

3. Save your changes.

5.2.6.3. How to view the data analyzed against patterns

When you add one or more patterns to an analyzed column, you check all existing data in the column against the
specified pattern(s). After the execution of the column analysis, using the java or the SQL engine you can access
a list of all the valid/invalid data in the analyzed column.

When you use the Java engine to run the analysis, the view of the actual data will open in the studio. While if you
use the SQL engine to execute the analysis, the view of the actual data will open in the Data Explorer perspective.

Prerequisite(s):

• You have selected the Profiling perspective in the studio.

• You have installed in the studio the SQL explorer libraries that are required for data quality.

If you do not install these libraries, the Data Explorer perspective will be missing from the studio and many
features will not be available. For further information about identifying and installing external modules, see the
Talend Installation and Upgrade Guide.

To view the actual data in the column analyzed against a specific pattern, do the following:

1. Follow the steps outlined in How to define the columns to be analyzed and How to add a regular expression
or an SQL pattern to a column analysis to create a column analysis that uses a pattern.

2. Execute the column analysis.

The editor switches to the Analysis Results view.

3. Browse to Pattern Matching under the name of the analyzed column.

The generated graphic for the pattern matching is displayed accompanied with a table that details the matching
results.
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4. Right-click the pattern line in the Pattern Matching table and select:

Option To...

View valid/invalid values open a view of all valid/invalid values measured against the pattern used on the selected
column

View valid/invalid rows open a view of all valid/invalid rows measured against the pattern used on the selected
column

When using the SQL engine, the view opens in the Data Explorer perspective listing valid/invalid rows or values
of the analyzed data according to the limits set in the data explorer.

This explorer view will also give some basic information about the analysis itself. Such information is of great
help when working with multiple analysis at the same time.

The data explorer does not support connections which has empty user name, such as Single sign-on of MS SQL
Server. If you analyze data using such connection and you try to view data rows and values in the Data Explorer
perspective, a warning message prompt you to set your connection credentials to the SQL Server.

When using the Java engine, the view opens in the Profiling perspective of the studio listing the number of valid/
invalid data according to the row limit you set in the Analysis parameters view of the analysis editor. For more
information, see Using the Java or the SQL engine.



Saving the queries executed on indicators

84 Talend Open Studio for Data Quality User Guide

You can save the executed query and list it under the Libraries > Source Files folders in the DQ Repository tree
view if you click the save icon on the SQL editor toolbar. For more information, see Saving the queries executed
on indicators.

For more information about the data explorer Graphical User Interface, see Data Explorer management GUI.

5.2.7. Saving the queries executed on indicators

From the studio and in the Data Explorer perspective, you can view the queries executed on different indicators
used in an analysis. From the data explorer, you will be able to save the query and list it under the Libraries >
Source Files folders in the DQ Repository tree view.

Prerequisite(s): You have selected the Profiling perspective in the studio. At least one analysis with indicators
has been created.

To save any of the queries executed on an indicator set in a column analysis, do the following:

1. In the column analysis editor, right-click any of the used indicators to open a contextual menu.
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2. Select View executed query to open the data explorer on the query executed on the selected indicator.

If the Data Explorer perspective is missing from the studio, you must install certain SQL explorer libraries
that are required for data quality to work correctly, otherwise you may get an error message.

For further information about identifying and installing external modules, see the Talend Installation and
Upgrade Guide.

The data explorer does not support connections which has empty user name, such as Single sign-on of MS SQL Server.
If you analyze data using such connection and you try to view the executed queries in the Data Explorer perspective,
a warning message prompt you to set your connection credentials to the SQL Server.

3. Click the save icon on the editor toolbar to open the [Select folder] dialog box
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4. Select the Source Files folder or any sub-folder under it and enter in the Name field a name for the open query.

5. Click OK to close the dialog box.

The selected query is saved under the selected folder in the DQ Repository tree view.

5.2.8. Creating analyses from table or column names
In the studio, you can use simplified ways to create one or multiple column analyses. All what you need to do is
to start from the table name or the column name under the relevant DB Connection folder in the DQ Repository
tree view.
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However, the options you have to create column analyses if you start from the table name are different from those
you have if you start from the column name.

To create a column analysis directly from the relevant table name in the DB Connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Browse to the table that holds the column(s) you want to analyze and right-click it.

3. From the contextual menu, select:

Item To...

Match Analysis open the match analysis editor where you can define match rules and select the columns
on which you want to use the match rules.

For more information see Analyzing duplicates.

Table Analysis analyze the selected table using SQL business rules.

For more information on the Simple Statistics indicators, see Simple statistics.

Column Analysis analyze all the columns included in the selected table using the Simple Statistics
indicators.

For more information on the Simple Statistics indicators, see Simple statistics.

Pattern Frequency Analysis analyze all the columns included in the selected table using the Pattern Frequency
Statistics along with the Row Count and the Null Count indicators.

For more information on the Pattern Frequency Statistics, see Pattern frequency statistics.

To learn more about the databases and engines supported with Pattern Frequency Statistics
indicators, see the documentation on Talend Help Center (https://help.talend.com).

The above steps replace the procedures outlined in Defining the columns to be analyzed and setting indicators.
Then you proceed following the steps outlined in Finalizing and executing the column analysis.

To create a column analysis directly from the column name in the DB Connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Browse to the column(s) you want to analyze and right-click it/them.

3. From the contextual menu, select:

Item To...

Analyze create an analysis for the selected column

you must later set the indicators you want to use to analyze the selected column.

For more information on setting indicators, see How to set indicators on columns. For
more information on accomplishing the column analysis, see Finalizing and executing
the column analysis.

Nominal Value Analysis create a column analysis on nominal data preconfigured with indicators appropriate for
nominal data, namely Value Frequency, Simple Statisticsand Text Statistics indicators.

Simple Analysis analyze the selected column using the Simple Statistics indicators.

For more information on the Simple Statistics indicators, see Simple statistics.

Pattern Frequency Analysis analyze the selected column using the Pattern Frequency Statistics along with the Row
Count and the Null Count indicators.

For more information on the Pattern Frequency Statistics, see Pattern frequency statistics.

To learn more about the databases and engines supported with Pattern Frequency Statistics
indicators, see the documentation on Talend Help Center (https://help.talend.com).

Analyze Column Set perform an analysis on the content of a set of columns. This analysis focuses on a column
set (full records) and not on separate columns as it is the case with the column analysis.

https://help.talend.com
https://help.talend.com
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For more information, see Creating a simple table analysis (Column Set Analysis).

Analyze Correlation perform column correlation analyses between nominal and interval columns or nominal
and date columns in database tables.

For more information, see Numerical correlation analyses.

Analyze matches open the match analysis editor where you can define match rules and select the columns
on which you want to use the match rules.

For more information see Analyzing duplicates.

The above steps replace one of or both of the procedures outlined in Defining the columns to be analyzed and
setting indicators. Now, you proceed following the same steps outlined in Finalizing and executing the column
analysis.

5.3. Creating a basic column analysis on a
file
You can create a column analysis on a delimited file and execute the created analyses using the Java engine.

From the studio, you can also analyze a set of columns, for more information, see Analyzing tables in delimited
files.

The sequence of profiling data in a delimited file involves the following steps:

1. defining the columns to be analyzed.

For more information, see How to define the columns to be analyzed.

2. settings predefined system indicators for the defined columns.

For more information, see How to set indicators on columns. For more information on indicator types and
indicator management, see Indicators.

3. setting patterns for the defined columns. For more information, see Patterns.

You can also use Java user-defined indicators when analyzing columns in a delimited file on the condition
that a Java user-defined indicator is already created. For further information, see How to define Java user-
defined indicators.

5.3.1. How to define the columns to be analyzed

The first step in analyzing the content of a delimited file is to define the columns to be analyzed.

Prerequisite(s): At least one connection to a delimited file is set in the Profiling perspective of the studio. For
further information, see Connecting to a file.

Defining the analysis

1. In the DQ Repository tree view, expand the Data Profiling folder.

2. Right-click the Analysis folder and select New Analysis.



How to define the columns to be analyzed

Talend Open Studio for Data Quality User Guide 89

The [Create New Analysis] wizard opens.

3. In the filter field, start typing Basic Column Analysis, select Basic Column Analysis and then click Next.
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4. In the Name field, enter a name for the current column analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. If required, set the analysis metadata (purpose, description and author name) in the corresponding fields and
click Next to proceed to the next step.
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Selecting the file columns and setting sample data

1. Expand FileDelimited connections and then browse to the columns you want to analyze.

In this example, you want to analyze the id, first_name and age columns from the selected connection.

2. Select the columns and then click Finish to close the wizard.

A file for the newly created analysis is displayed under the Analyses node in the DQ Repository tree view,
and the analysis editor opens with the analysis metadata.

3. In the Data preview view, click Refresh Data.

The data in the selected columns is displayed in the table.

You can change your data source and your selected columns by using the New Connection and Select
Columns buttons respectively.

4. In the Limit field, set the number for the data records you want to display in the table and use as sample
data, 50 records for example.

5. Select n first rows to list the first 50records from the selected columns.

6. In the Analyzed Columns view, use the arrows in the top right corner to open different pages in the view
if you analyze large number of columns..
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You can also drop the columns to analyze directly from the DQ Repository tree view to the analysis editor.

7. Use the delete, move up or move down buttons to manage the analyzed columns.

8. If required, right-click any of the listed columns and select Show in DQ Repository view to locate the
selected column under the corresponding delimited file connection in the tree view.

When you select to analyze Date columns and run the analysis with the Java engine, the date information is stored
in the studio as regular date/time of the format YYYY-MM-DD HH:mm:ss for date/timestamp and of the format
HH:mm:ss.SSS for time. The date and time formats are slightly different when you run the analysis with the SQL
engine.

5.3.2. How to set system and user-defined indicators

The second step after defining the columns to be analyzed is to set statistics indicators for each of the defined
columns.

You can also use Java user-defined indicators when analyzing columns in a delimited file on the condition that a Java user-
defined indicator is already created. For further information, see How to define Java user-defined indicators.

Prerequisite(s): An analysis of a delimited file is open in the analysis editor in the Profiling perspective of the
studio. For more information, see How to define the columns to be analyzed.

To set system indicators for the column(s) to be analyzed, do the following:

1. Follow the procedure outlined in How to define the columns to be analyzed.

2. From the Data preview view in the analysis editor, click Select indicators to open the [Indicator Selection]
dialog box.
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3. Set the indicators using the [Indicator Selection] dialog box as outlined in How to set system or user-defined
indicators.

In this example, you want to set the Simple Statistics indicators on all columns, the Text Statistics indicators
on the first_name column and the Soundex Frequency on the first_name column as well.

You can set the text statistics indicators on a column only if its data mining type is set to nominal. Otherwise, these
indicators will be grayed out in the [Indicator Selection] dialog box.

The selected indicators are attached to the analyzed columns in the Analyzed Columns view.
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4. Save the analysis.

5.3.3. How to set options for system indicators

Prerequisite(s): An analysis of a delimited file is open in the analysis editor in the Profiling perspective of the
studio. For more information, see How to define the columns to be analyzed, How to set indicators on columns.

To set options for system indicators used on the columns to be analyzed, do the following:

1. Follow the procedures outlined in How to define the columns to be analyzed and How to set indicators on
columns.

2. In the analysis editor, click Analyzed Columns to open the analyzed columns view.

3. In the Analyzed Columns list, click the option icon  next to the indicator to open the dialog box where
you can set options for the given indicator.

Indicators settings dialog boxes differ according to the parameters specific for each indicator. For more
information about different indicator parameters, see Indicator parameters.

4. Set the parameters for the given indicator.

5. Click Finish to close the dialog box.

5.3.4. How to set regular expressions and finalize the
analysis

You can add one or more regular expressions to one or more of the analyzed columns.

Prerequisite(s): An analysis of a delimited file is open in the analysis editor in the Profiling perspective of the
studio. For more information, see How to define the columns to be analyzed, How to set indicators on columns
and How to set options for system indicators.
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To set regular expressions to the analyzed columns, do the following:

1. Define the regular expression you want to add to the analyzed column. For further information on creating
regular expressions, see How to create a new regular expression or SQL pattern.

In this example, the regular expression checks for all words that start with uppercase.

2. Add the regular expression to the analyzed column in the open analysis editor, the first_name column in
this example. For further information, see How to add a regular expression or an SQL pattern to a column
analysis.
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3. Press F6 to execute the analysis.

If the format of the file you are using has problems, you will have an error message to indicate which row
causes the problem.

The detailed analysis results view shows the generated graphics for the analyzed columns accompanied with
tables that detail the statistic results.

Below are the tables that accompany the statistics graphics in the Analysis Results view for the analyzed
first_name column in the procedure outlined in How to define the columns to be analyzed.
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5.3.5. How to view and export the analyzed data in a
file

After running your file analysis using the Java engine and from the Analysis Results view of the analysis editor,
you can right-click any of the rows in the statistic result tables and access a view of the actual data.

Prerequisite(s): A file analysis has been created and executed.

To view and export the analyzed data, do the following:

1. At the bottom of the analysis editor, click the Analysis Results tab to open a detailed view of the analysis
results.

2. Right-click a data row in the statistic results of any of the analyzed columns and select an option as the
following:

Option Operation

View rows open a view on a list of all data rows in the analyzed column.

For the Duplicate Count indicator, the View rows option will list all the rows
that are duplicated. So if the duplicate count is 12 for example, this option will
list 24 rows.

View values open a view on a list of the actual data values of the analyzed column.

For Pattern Matching results, select an option as the following:

Option Operation

View valid/invalid rows open a view on a list of all valid/invalid rows measured against a pattern.

View valid/invalid values open a view on a list of all valid/invalid values measured against a pattern.

From this view, you can export the analyzed data into a csv file. To do that:

1.
Click the  icon in the top left corner of the view.

A dialog box opens.
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2. Click the Choose... button and browse to where you want to store the csv file and give it a name.

3. Click OK to close the dialog box.

A csv file is created in the specified place holding all the analyzed data rows listed in the view.

5.3.6. How to analyze delimited data in shortcut
procedures

You can profile data in a delimited file using a simplified way. All what you need to do is to start from the column
name under Metadata > FileDelimited folders in the DQ Repository tree view.

For further information, see Creating analyses from table or column names.
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5.4. Analyzing discrete data
This analysis enables you to analyze numerical data. It creates a column analysis in which indicators, appropriate
for numeric data, are assigned to the column by default.

Discrete data can only take particular values of potentially an infinite number of values. Continuous data is the
opposite of discrete data, it is not restricted to defined separate values, but can occupy any value over a continuous
range.

This analysis uses the Bin Frequency indicator that you must configure further in order to convert continuous
data into discrete bins (ranges) according to your needs.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand Metadata and browse to the numerical column you want to analyze.

2. Right-click the numerical column and select Column Analysis > Discrete data Analysis.

In this example, you want to convert customer age into a number of discrete bins, or range of age values.

The [New Analysis] wizard opens.

3. In the Name field, enter a name for the analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

4. Set the analysis metadata and click Finish.

The analysis opens in the analysis editor and the Simple Statistics and the Bin Frequency indicators are
automatically assigned to the numeric column.
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5. Double-click the Bin Frequency indicator to open the [Indicator settings] dialog box.
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6. Set the bins minimum and maximum values and the number of bins in the corresponding fields.

If you set the number of bins is set to 0, no bin is created. The indicator computes the frequency of each
value of the column.

7. Select the Set ranges manually check box.

The four read-only fields in the lower part of the [Create Bins] dialog box show you the data that Tableau
uses to suggest a bin size. You can also consider these values if you want to set a bin size manually.

Continuous numeric data is aggregated into discrete bins. Four ranges are listed in the table with a suggested
bin size. The minimal value is the beginning of the first bin, and the maximal value is the end of the last
bin. The size of each bin is determined by dividing the difference between the smallest and the largest values
by the number of bins.

You can always modify these values if you want to set a bin size manually. The value in the number of bins
field is updated automatically with the new range number.

Running the analysis and accessing the detail analysis results

1. Run the analysis.

The editor switches to the Analysis Results view.
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The analysis creates age ranges with limited and discrete set of possible values out of an unlimited, continuous
range of age values.

2. Right-click any data row in the result tables or in the charts, the first age range in this example, and select
View rows to access a view of the analyzed data.
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The SQL Editor opens listing all customers whose age is between 28 and 39.

5.5. Data mining types
When you create a column analysis in the studio, you can see a Datamining Type box next to each of the columns
you want to analyze. The selected type in the box represents the data mining type of the associated column.
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These data mining types help the studio to choose the appropriate metrics for the associated column since not all
indicators (or metrics) can be computed on all data types.

Available data mining types are: Nominal, Interval, Unstructured Text and Other. The sections below describe
these data mining types.

5.5.1. Nominal

Nominal data is categorical data which values/observations can be assigned a code in the form of a number where
the numbers are simply labels. You can count, but not order or measure nominal data.

In the studio, the mining type of textual data is set to nominal. For example, a column called WEATHER with the
values: sun, cloud and rain is nominal.

And a column called POSTAL_CODE that has the values 52200 and 75014 is nominal as well in spite of
the numerical values. Such data is of nominal type because it identifies a postal code in France. Computing
mathematical quantities such as the average on such data is non sense. In such a case, you should set the data
mining type of the column to Nominal, because there is currently no way in the studio to automatically guess the
correct type of data.

The same is true for primary or foreign-key data. Keys are most of the time represented by numerical data, but
their data mining type is Nominal.

5.5.2. Interval

This data mining type is used for numerical data and time data. Averages can be computed on this kind of data.
In databases, sometimes numerical quantities are stored in textual fields.

In the studio, it is possible to declare the data mining type of a textual column (e.g. a column of type VARCHAR)
as Interval. In that case, the data should be treated as numerical data and summary statistics should be available.

5.5.3. Unstructured text

This is a new data mining type introduced by the studio. This data mining type is dedicated to handle unstructured
textual data.

For example, the data mining type of a column called COMMENT that contains commentary text can not be
Nominal, since the text in it is unstructured. Still, we could be interested in seeing the duplicate values of such a
column and here comes the need for such a new data mining type.

5.5.4. Other

This is another new data mining type introduced in the studio. This type designs the data that the studio does not
know how to handle yet.
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Chapter 6. Table analyses
This chapter provides all the information you need to perform table analyses on databases and delimited files.

It describes all types of table analyses including business rule analysis, match analysis and functional dependency
analysis.
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6.1. Steps to analyze database tables
You can examine the data available in single tables of a database and collect information and statistics about this
data.

The sequence of profiling data in one or multiple tables may involve the following steps:

1. Defining one or more tables on which to carry out data profiling processes that will define the content,
structure and quality of the data included in the table(s).

2. Creating SQL business rules based on WHERE clauses and add them as indicators to table analyses.

3. Creating column functional dependencies analyses to detect anomalies in the column dependencies of the
defined table(s) through defining columns as either "determinant" or "dependent".

Check Analyzing tables in databases for information about the different options to analyze a table.

6.2. Analyzing tables in databases
Table analyses can range from simple table analyses to table analyses that uses SQL business rules or table analyses
that detect anomalies in the table columns.

Using the studio, you can better explore the quality of data in a database table through either:

• Creating a simple table analysis through analyzing all columns in the table using patterns. For more information,
see Creating a simple table analysis (Column Set Analysis).

• Adding data quality rules as indicators to table analysis. For more information, see Creating a table analysis
with SQL business rules.

• Detecting anomalies in column dependencies. For more information, see Detecting anomalies in columns
(Functional Dependency Analysis).

• Comparing a set of columns and creating groups of similar records using blocking and matching keys and/or
survivorship rules. For more information, see Analyzing duplicates.

6.2.1. Creating a simple table analysis (Column Set
Analysis)

You can analyze the content of a set of columns. This set can represent only some of the columns in the defined
table or the table as a whole.

The analysis of a set of columns focuses on a column set (full records) and not on separate columns as it is the case
with the column analysis. The statistics presented in the analysis results (row count, distinct count, unique count
and duplicate count) are measured against the values across all the data set and thus do not analyze the values
separately within each column.

With the Java engine, you may also apply patterns on each column and the result of the analysis will give the
number of records matching all the selected patterns together. For further information, see How to add patterns
to the analyzed columns.
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When you use the Java engine to run a column set analysis on big sets or on data with many problems, it is advisable to define
a maximum memory size threshold to execute the analysis as you may end up with a Java heap error. For more information,
see Defining the maximum memory size threshold.

6.2.1.1. How to create an analysis of a set of columns using
patterns

This type of analysis provides simple statistics on the full records of the analyzed column set and not on the values
within each column separately. For more information about simple statistic indicators, see Simple statistics.

With this analysis, you can use patterns to validate the full records against all patterns and have a single-bar result
chart that shows the number of the rows that match "all" the patterns..

How to define the set of columns to be analyzed

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To define the set of columns to analyzed, do the following:

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. In the filter field, start typing column set analysis, select Column Set Analysis from the list and click Next.

4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.
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5. Set column analysis metadata (purpose, description and author name) in the corresponding fields and then
click Next.

Selecting the set of columns you want to analyze

1. Expand DB connections.

2. In the desired database, browse to the columns you want to analyze, select them and then click Finish to
close this [New analysis] wizard.

A folder for the newly created analysis is listed under Analysis in the DQ Repository tree view, and the
analysis editor opens with the defined data.
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A sample data is displayed in the Data Preview section and the selected columns are displayed in the
Analyzed Column section of the analysis editor.

In this example, you want to analyze a set of six columns in the customer table: account number
(account_num), education (education), email (email), first name (fname), second name (Iname) and gender
(gender). The statistics presented in the analysis results are the row count, distinct count, unique count and
duplicate count which all apply on records (values of a set of columns).

3. In the Data preview section, select:

Option To...

New Connection open a wizard and create or change the connection to the data source from within the
editor.

For further information about how to create a connection to data sources, see Connecting
to a database and Connecting to a file.

The Connection field on top of this section lists all the connections created in the Studio.

Select Columns open the Column Selection dialog box where you can select the columns to analyze or
change the selection of the columns listed in the table.
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From the open dialog box, you can filter the table or column lists by using the Table filter
or Column filter fields respectively.

n first rows

or

n random rows

list in the table N first data records from the selected columns or list N random records
from the selected columns.

Refresh Data display the data in the selected columns according to the criteria you set.

Run with sample data run the analysis only on the sample data set in the Limit field.

4. In the Limit field, set the number for the data records you want to display in the table and use as sample data.

5. If required, right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view. The selected column is automatically located under the corresponding connection in the
tree view.

6. Use the delete, move up or move down buttons to manage the analyzed columns when necessary.

How to add patterns to the analyzed columns

You can add patterns to one or more of the analyzed columns to validate the full record (all columns) against all
the patterns, and not to validate each column against a specific pattern as it is the case with the column analysis.
The results chart is a single bar chart for the totality of the used patterns. This chart shows the number of the rows
that match "all" the patterns.

Before being able to use a specific pattern with a set of columns analysis, you must manually set the pattern definition
for Java in the pattern settings, if it does not already exist. Otherwise, a warning message opens prompting you to set the
definition of the Java regular expression.

Prerequisite(s): An analysis of a set of columns is open in the analysis editor in the Profiling perspective of the
studio. For more information, see How to define the set of columns to be analyzed.

To add patterns to the analysis of a set of columns, do the following:

1.
In the Analyzed Columns section of the editor, click the  icon next to each of the columns you want to
validate against a specific pattern.

The [Pattern Selector] dialog box is displayed.
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You can add only regular expressions to the analyzed columns.

You can drop the regular expression directly from the Patterns folder in the DQ Repository tree view directly
to the column name in the column analysis editor.

If no Java expression exists for the pattern you want to add, a warning message opens prompting you to add the
pattern definition for Java. Click Yes to open the pattern editor and add the Java regular expression, then proceed
to add the pattern to the analyzed columns.

In this example, you want to add a corresponding pattern to each of the analyzed columns to validate data in
these columns against the selected patterns. The result chart will show the percentage of the matching/non-
matching values, the values that respect the totality of the used patterns.

2. In the [Pattern Selector] dialog box, browse to the regular expression you want to add to the selected column.

3. Select the check box(es) of the expression(s) you want to add to the selected column.

4. Click OK.

The regular expression(s) are displayed under the analyzed column(s) in the Analyzed Columns list, and the
All Match indicator is displayed in the Indicators list in the Indicators view.
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How to finalize and execute the analysis of a set of columns

What is left before executing this set of columns analysis is to define the indicator settings, data filter and analysis
parameters.

Prerequisite(s): A column set analysis has already been defined in the Profiling perspective of the studio. For
further information, see How to define the set of columns to be analyzed and How to add patterns to the analyzed
columns.

1.
In the Indicators section in the analysis editor, click the option icon  to open a dialog box where you can
set options for each indicator according to your needs.

For more information about indicators management, see Indicators.
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The indicators representing the simple statistics are by-default attached to this type of analysis. For further
information about the indicators for simple statistics, see section Simple statistics.

2. In the Data Filter section, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

3. In the Analysis Parameters view:

• In the Number of connections per analysis field, set the number of concurrent connections allowed per
analysis to the selected database connection.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

• From the Execution engine list, select the engine, Java or SQL, you want to use to execute the analysis.

• If you select the Java engine, the Store data check box is selected by default and cannot be unselected.
Once the analysis is executed, the profiling results are always available locally to drill down through the
Analysis Results > Data view. For further information, see How to filter data against patterns.

Executing the analysis with the Java engine uses disk space as all data is retrieved and stored locally. If
you want to free up some space, you may delete the data stored in the main studio directory, at Talend-
Studio>workspace>project_name>Work_MapDB.

• If you select the SQL engine, you can use the Store data check box to decide whether to store locally
the analyzed data and access it in the Analysis Results > Data view.

If the data you are analyzing is very big, it is advisable to leave the Store data check box unselected in order
not to store the results at the end of the analysis computation.
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4. If you have defined context variables in the Contexts view in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

5. Save the analysis and press F6 to execute it.

The analysis editor switches to the Analysis Results view where you can read the analysis results in tables
and graphics. The graphical result provides the simple statistics on the full records of the analyzed column
set and not on the values within each column separately.

When you use patterns to match the content of the set of columns, another graphic is displayed to illustrate
the match and non-match results against the totality of the used patterns.

6. In the Simple Statistics table, right-click an indicator result and select View Rows or View Values.

• If you run the analysis with the Java engine, a list of the analyzed data is opened in the Profiling perspective.

• If you run the analysis with the SQL engine, a list of the analyzed data is opened in the Data Explorer
perspective.

7. In the Data view, click Filter Data to filter the valid/invalid data according to the used patterns.

You can filter data only when you run the analysis with the Java engine. For further information, see How
to filter data against patterns.
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How to filter data against patterns

After analyzing a set of columns against a group of patterns and having the results of the rows that match or do
not match "all" the patterns, you can filter the valid/invalid data according to the used patterns.

Prerequisite(s): An analysis of a set of columns is open in the analysis editor in the Profiling perspective of the
studio. You have used the Java engine to execute the analysis.

For more information, see How to define the set of columns to be analyzed and How to add patterns to the analyzed
columns.

To filter data resulted from the analysis of a set of columns, do the following:

1. In the analysis editor, click the Analysis Results tab at the bottom of the editor to open the detailed result view.

2. Click Data to open the corresponding view.

A table lists the actual analyzed data in the analyzed columns.

3. Click Filter Data on top of the table.

A dialog box is displayed listing all the patterns used in the column set analysis.

4. Select the check box(es) of the pattern(s) according to which you want to filter data.

5. Select a display option as the following:
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Select To...

All data show all analyzed data.

matches show only the data that matches the selected pattern.

non-matches show the data that does not match the selected pattern(s).

6. Click Finish to close the dialog box.

In this example, data is filtered against the Email Address pattern, and only the data that does not match is
displayed.

All email addresses that do not match the selected pattern appear in red. Any data row that has a missing
value appear with a red background.

The Previous and Next buttons under the table helps you to navigate back and forth through pages.

Numbered buttons are displayed under the table to access pages directly:

• when you open the Data view for the first time after running the analysis,

• if you did not select a pattern in the Filter Data dialog box, or

• if you selected All data as the display option in the Filter Data dialog box.

6.2.1.2. How to create a column analysis from a simple table
analysis

You can create a column analysis on one or more columns defined in a simple table analysis (column set analysis).

Prerequisite(s): A simple table analysis is defined in the analysis editor in the Profiling perspective of the studio.

To create a column analysis on one or more columns defined in a simple table analysis, do the following:

1. Open the simple table analysis.

2. In the Analyzed Columns section of the analysis editor, right-click the column(s) you want to create a column
analysis on.
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3. Select Column analysis from the contextual menu.

The [New Analysis] wizard opens.

4. In the Name field, enter a name for the new column analysis and then click Next to proceed to the next step.

The analysis editor opens with the defined metadata and a folder for the newly created analysis is listed under
the Analyses folder in the DQ Repository tree view.

5. Follow the steps outlined in Creating a basic analysis on a database column to continue creating the column
analysis.

6.2.2. Creating a table analysis with SQL business
rules

You can set up SQL business rules based on WHERE clauses and add them as indicators to table analyses. You
can as well define expected thresholds on the SQL business rule indicator's value. The range defined is used for
measuring the quality of the data in the selected table.

It is also possible to create an analysis with SQL business rules on views in a database. The procedure is exactly the same
as that for tables. For more information, see How to create a table analysis with an SQL business rule with a join condition.

When you use the Java engine to run a column set analysis on big sets or on data with many problems, it is advisable to define
a maximum memory size threshold to execute the analysis as you may end up with a Java heap error. For more information,
see Defining the maximum memory size threshold.

6.2.2.1. How to create an SQL business rule

SQL business rules can be simple rules with WHERE clauses. They can also have join conditions in them to
combine common values between columns in database tables and give a result data set.

For an example of a table analysis with a simple business rule, see How to create a table analysis with a simple
SQL business rule. For an example of a table analysis with a business rule that has a join condition, see How to
create a table analysis with an SQL business rule with a join condition.
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Creating the business rule

1. In the DQ Repository tree view, expand Libraries > Rules.

2. Right-click SQL.

3. From the contextual menu, select New Business Rule to open the [New Business Rule] wizard.

Consider as an example that you want to create a business rule to match the age of all customers listed in the
age column of a defined table. You want to filter all the age records to identify those that fulfill the specified
criterion.
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4. In the Name field, enter a name for this new SQL business rule.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. Set other metadata (purpose, description and author name) in the corresponding fields and then click Next.

6. In the Where clause field, enter the WHERE clause to be used in the analysis.

In this example, the WHERE clause is used to match the records where customer age is greater than 18.

7. Click Finish to close the [New Business Rule] wizard.

A sub-folder for this new SQL business rule is displayed under the Rules folder in the DQ Repository tree
view. The SQL business rule editor opens with the defined metadata.
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In the SQL business rule editor, you can modify the WHERE clause or add a new one directly in the Data quality
rule view.

8. If required, set a value in the Criticality Level field.

This will act as an indicator to measure the importance of the SQL business rule.

Creating a join condition

This step is not obligatory. You can decide to create a business rule without a join condition and use it with only
the WHERE clause in the table analysis.

For an example of a table analysis with a simple business rule, see How to create a table analysis with a simple
SQL business rule. For an example of a table analysis with a business rule that has a join condition, see How to
create a table analysis with an SQL business rule with a join condition.

1. In the SQL business rule editor, click Join Condition to open the corresponding view.

2. Click the [+] button to add a row in the Join Condition table.
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3. Expand the Metadata folder in the DQ Repository tree view, and then browse to the columns in the tables
on which you want to create the join condition.

This join condition will define the relationship between a table A and a table B using a comparison operator
on a specific column in both tables. In this example, the join condition will compare the "name" value in the
Person and Person_Ref tables that have a common column called name.

You must be careful when defining the join clause. In order to get an easy to understand result, it is advisable to make
sure that the joined tables do not have duplicate values. For further information, see How to create a table analysis
with an SQL business rule with a join condition.

4. Drop the columns from the DQ Repository tree view to the Join Condition table.

A dialog box is displayed prompting you to select where to place the column: in TableA or in TableB.

5. Select a comparison condition operator between the two columns in the tables and save your modifications.

In the analysis editor, you can now drop this newly created SQL business rule onto a table that has an "age"
column. When you run the analysis, the join to the second column is done automatically.

The table to which to add the business rule must contain at least one of the columns used in the SQL business rule.

For more information about using SQL business rules as indicators on a table analysis, see Creating a table analysis
with SQL business rules.

6.2.2.2. How to edit an SQL business rule

To edit an SQL business rule, do the following:

1. In the DQ Repository tree view, expand Libraries > Rules > SQL.

2. Right-click the SQL business rule you want to open and select Open from the contextual menu.

The SQL business rule editor opens displaying the rule metadata.
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3. Modify the business rule metadata or the WHERE clause as required.

4. Click the save icon on top of the editor to save your modifications.

The SQL business rule is modified as defined.

6.2.2.3. How to create a table analysis with a simple SQL
business rule

You can create analyses on either tables or views in a database using SQL business rules. The procedure for
creating such analysis is the same for a table or a view.

Prerequisite(s):

• At least one SQL business rule has been created in the Profiling perspective of the studio. For further
information about creating SQL business rules, see How to create an SQL business rule

• At least one database connection is set in the Profiling perspective of the studio. For further information, see
Connecting to a database.

In this example, you want to add the SQL business rule created in How to create an SQL business rule to a
top_custom table that contains an age column. This SQL business rule will match the customer ages to define
those who are older than 18.
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Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.

3. In the filter field, start typing business rule analysis, select Business Rule Analysis and click Next.
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4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Next.
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Selecting the table you want to analyze

1. Expand DB Connections, browse to the table to be analyzed and select it.

2. Click Finish to close the [Create New Analysis] wizard.

You can directly select the data quality rule you want to add to the current analysis by clicking the Next button in the
[New Analysis] wizard or you can do that at later stage in the Analyzed Tables view as shown in the following steps.

A folder for the newly created table analysis is listed under the Analyses folder in the DQ Repository tree
view, and the analysis editor opens with the defined metadata.
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3. If required:

• Click Select Tables to open the [Table Selection] dialog box and select new table(s) to analyze.

You can filter the table or column lists by typing the desired text in the Table filter or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

• Select another connection from the Connection list to connect to a different database. This list has all
the connections created in the Studio. If the tables listed in the Analyzed Tables view do not exist in the
new database connection you want to set, you receive a warning message that enables you to continue or
cancel the operation.

4. Right-click any of the listed columns in the Analyzed Columns view and select Show in DQ Repository
view, the selected column is automatically located under the corresponding connection in the tree view.



Creating a table analysis with SQL business rules

128 Talend Open Studio for Data Quality User Guide

Selecting the business rule

1.
Click the  icon next to the table name where you want to add the SQL business rule.

The [Business Rule Selector] dialog box is displayed.

2. Expand the Rules folder and select the check box(es) of the predefined SQL business rule(s) you want to
use on the corresponding table(s).

3. Click OK.

The selected business rule is listed below the table name in the Analyzed Tables view.

You can also drag the business rule directly from the DQ Repository tree view to the table in the analysis
editor.

4. If required, right-click the business rule and select View executed query.

The SQL editor opens in the Studio to display the query.

5. Click Data Filter in the analysis editor to open the view where you can set a filter on the data of the analyzed
table(s).
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6. Save the table analysis and press F6 to execute it.

An information pop-up opens to confirm that the operation is in progress and the analysis editor switches
to the Analysis Results view.

All age records in the selected table are evaluated against the defined SQL business rule. The analysis results
has two bar charts: the first is a row count indicator that shows the number of rows in the analyzed table, and
the second is a match and non-match indicator that indicates in red the age records from the "analyzed result
set" that do not match the criteria (age below 18).

7. Right-click the business rule results in the second table, or right-click the result bar in the chart itself and
select:

Option To...

View valid rows access a list in the SQL editor of all valid rows measured against the pattern used on the
selected table

View invalid rows access a list in the SQL editor of all invalid rows measured against the pattern used on
the selected table

Analyze duplicates generates a ready-to-use analysis that analyzes duplicates in the table, if any, and give the
row and duplicate counts. For further information, see How to generate an analysis on
the join results to analyze duplicates.

You can carry out a table analysis in a direct and more simplified way. For further information, see How to
create a table analysis with an SQL business rule in a shortcut procedure.
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6.2.2.4. How to create a table analysis with an SQL business rule
with a join condition

In some cases, you may need to analyze database tables or views using an SQL business rule that has a join clause
that combines records from two tables in a database. This join clause will compare common values between two
columns and give a result data set. Then the data in this set will be analyzed against the business rule.

Depending on the analyzed data and the join clause itself, several different results of the join are possible, for
example #match + #no match > #row count,  #match + #no match < #row count or #match + #no match = #row
count.

The example below explains in detail the case where the data set in the join result is bigger than the row count
(#match + #no match > #row count) which indicates duplicates in the processed data.

Prerequisite(s):

• At least one SQL business rule has been created in the Profiling perspective of the studio. For further
information about creating SQL business rules, see How to create an SQL business rule

• At least one database connection is set in the Profiling perspective of the studio. For further information, see
Connecting to a database.

In this example, you want to add the SQL business rule created in How to create an SQL business rule to a Person
table that contains the age and name columns. This SQL business rule will match the customer ages to define
those who are older than 18. The business rule also has a join condition that compares the "name" value between
the Person table and another table called Person_Ref through analyzing a common column called name.

Below is a capture of both tables:

Below is a capture of the result of the join condition between these two tables:

The result set may give duplicate rows as it is the case here. Thus the results of the analysis may become a bit
harder to understand. The analysis here will not analyze the rows of the table that match the business rule but it
will run on the result set given by the business rule.

1. Define the table analysis and select the table you want to analyze as outlined in How to create a table analysis
with a simple SQL business rule.
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The selected table is listed in the Analyzed Tables view.

2.
Add the business rule with the join condition to the selected table through clicking the  icon next to the
table name.

This business rule has a join condition that compares the "name" value between two different tables through
analyzing a common column. For further information about SQL business rules, see How to create an SQL
business rule.

3. Save the table analysis and press F6 to execute it.

An information pop-up opens to confirm that the operation is in progress and the analysis editor switches
to the Analysis Results view.
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All age records in the selected table are evaluated against the defined SQL business rule. The analysis results
has two bar charts: the first is a row count indicator that shows the number of rows in the analyzed table, and
the second is a match and non-match indicator that indicates the age records from the "analyzed result set"
that do not match the criteria (age below 18).

If a join condition is used in the SQL business rule, the number of the rows of the join (#match + # no match) can
be different from the number of the analyzed rows (row count). For further information, see How to create a table
analysis with an SQL business rule with a join condition.

4. Right-click the Row Count row in the first table and select View rows.

The SQL editor opens in the Studio to display a list of the analyzed rows.

5. Right-click the business rule results in the second table, or right-click the result bar in the chart itself and
select:
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Option To...

View valid rows access a list in the SQL editor of all valid rows measured against the pattern used on the
selected table

View invalid rows access a list in the SQL editor of all invalid rows measured against the pattern used on
the selected table

Analyze duplicates generates a ready-to-use analysis that analyzes duplicates in the table and give the row
and duplicate counts. For further information, see How to generate an analysis on the join
results to analyze duplicates.

Below is the list of the invalid rows in the analyzed table.

6. In the SQL editor, click the save icon on the toolbar to save the executed query on the SQL business rule and
list it under the Libraries > Source Files folder in the DQ Repository tree view.

For further information, see Saving the queries executed on indicators.

To better understand the Business Rule Statistics bar chart in the analysis results, do the following:

1. In the analysis editor, right-click the business rule and select View executed query.

The SQL editor opens in the Studio.
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2. Modify the query in the top part of the editor to read as the following: SELECT * FROM

`my_person_joins`.`person` Person JOIN `my_person_joins`.`Person_ref` Person_ref ON

(Person.`name`=Person_ref.`Name`).

This will list the result data set of the join condition in the editor.

3.
In the top left corner of the editor, click the  icon to execute the query.

The query result, that is the analyzed result set, is listed in the bottom part of the editor.

4. Go back to the analysis editor and click the Analysis Results tab at the bottom of the editor to open a detail
view of the analysis results.
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The analyzed result set may contain more or fewer rows than the analyzed table. In this example, the number
of match and non-match records (5 + 2 = 7) exceeds the number of analyzed records (6) because the join of
the two tables generates more rows than expected.

Here 5 rows (71.43%) match the business rule and 2 rows do not match. Because the join generates duplicate
rows, this result does not mean that 5 rows of the analyzed table match the business rule. It only means that 5
rows among the 7 rows of the result set match the business rule. Actually, some rows of the analyzed tables
may not be even analyzed against the business rule. This happens when the join excludes these rows. For this
reason, it is advised to check for duplicates on the columns used in the join of the business rule in order to
make sure that the join does not remove or add rows in the analyzed result set.  Otherwise the interpretation
of the result is more complex.

In the Analysis Results view, if the number of match and non-match records exceeds the number of analyzed
records, you can generate a ready-to-use analysis that will analyze the duplicates in the selected table.

6.2.2.5. How to generate an analysis on the join results to analyze
duplicates

In some cases, when you analyze database tables using an SQL business rule that has a join clause, the join results
show that there are more rows in the joint than in the analyzed table. This is because the columns in the analyzed
table has some duplicate records, for an example see How to create a table analysis with an SQL business rule
with a join condition.

You can generate a ready-to-use analysis to analyze these duplicate records. The results of this analysis help you
to better understand why there are more records in the join results than in the table.

Prerequisite(s): A table analysis with an SQL business rule, that has a join condition, is defined and executed in
the Profiling perspective of the studio. The join results must show that there are duplicates in the table. For further
information, see How to create a table analysis with an SQL business rule with a join condition.

To generate an analysis that analyzes the duplicate records in a table, do the following:

1. After creating and executing an analysis on a table that has duplicate records as outlined in How to create a
table analysis with an SQL business rule with a join condition, click the Analysis Results tab at the bottom
of the analysis editor.
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2. Right-click the join results in the second table and select Analyze duplicates.

The [Column Selection] dialog box opens with the analyzed tables selected by default.

3. Modify the selection in the dialog box if needed and then click OK.

Two column analyses are generated and listed under the Analyses folder in the DQ Repository tree view
and are open in the analysis editor.
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4. Press F6 to execute the analysis.

The analysis results show two bars, one representing the row count of the data records in the analyzed column
and the other representing the duplicate count.

5. Click Analysis Results at the bottom of the analysis editor to access the detail result view.
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6. Right-click the row count or duplicate count results in the table, or right-click the result bar in the chart itself
and select:

Option To...

View rows open a view on a list of all data rows or duplicate rows in the analyzed column.

View values open a view on a list of the duplicate data values of the analyzed column.

6.2.2.6. How to create a table analysis with an SQL business rule
in a shortcut procedure

You can use a simplified way to create a table analysis with a predefined business rule. All what you need to do
is to start from the table name under the relevant DB Connection folder.

Prerequisite(s):

• At least one SQL business rule is created in the Profiling perspective of the studio.

• At least one database connection is set in the Profiling perspective of the studio.

For more information about creating SQL business rules, see How to create an SQL business rule.

To create a table analysis with an SQL business rule in a shortcut procedure, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections, and then browse to the table you
want to analyze.

2. Right-click the table name and select Table analysis from the list.

The [New Table Analysis] wizard is displayed.
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3. Enter the metadata for the new analysis in the corresponding fields and then click Next to proceed to the
next step.

4. Expand Rules > SQL and then select the check box(es) of the predefined SQL business rule(s) you want to
use on the corresponding table(s).

5. Click OK to proceed to the next step.

The table name along with the selected business rule are listed in the Analyzed Tables view.
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6. If required, click Data Filter in the analysis editor to open the view where you can set a filter on the data
of the analyzed table(s).

7. Press F6 to execute the analysis.

An information pop-up opens to confirm that the operation is in progress and the editor switches to the
Analysis Results view.

6.2.3. Detecting anomalies in columns (Functional
Dependency Analysis)

This type of analysis helps you to detect anomalies in column dependencies through defining columns as either
"determinant" or "dependent" and then analyzing values in dependant columns against those in determinant
columns. This analysis supports only database tables.

This type of analysis detects to what extent a value in a determinant column functionally determines another value
in a dependant column.

This can help you identify problems in your data, such as values that are not valid. For example, if you analyze
the dependency between a column that contains United States Zip Codes and a column that contains states in the
United States, the same Zip Code should always have the same state. Running the functional dependency analysis
on these two columns will show if there are any violations of this dependency.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. In the filter field, start typing functional dependency analysis, select Functional Dependency Analysis from
the list and click Next.

4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.
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5. Set the analysis metadata (purpose, description and author name) in the corresponding fields, and then click
Next.

Selecting the columns as either "determinant" or "dependent"

1. Expand DB connections, browse to the database you want to analyze, select it and then click Finish to close
the [New Analysis] wizard.

A folder for the newly created functional dependency analysis is listed under Analysis in the DQ Repository
tree view, and the analysis editor opens with the defined metadata.
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The Data Preview section shows a sample data of all the table columns.

2. In the Left Column panel, click A Columns Set to open the [Column Selection] dialog box.

Here you can select the first set of columns against which you want to analyze the values in the dependant
columns. You can also drag the columns directly from the DQ Repository tree view to the left column panel.

In this example, you want to evaluate the records present in the city column and those present in the
state_province column against each other to see if state names match to the listed city names and vice versa.
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3. In the [Column Selection] dialog box, expand DB Connections and browse to the column(s) you want to
define as determinant columns.

You can filter the table or column lists by typing the desired text in the Table filter or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

4. Select the check box(es) next to the column(s) you want to analyze and click OK to proceed to the next step.

The selected column(s) are displayed in the Left Columns panel of the Analyzed Columns Set view. In this
example, we select the city column as the determinant column.
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5. Do the same to select the dependant column(s) or drag it/them from the DQ Repository tree view to the
Right Columns panel. In this example, we select the state_province column as the dependent column. This
relation will show if the state names match to the listed city names.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view, the selected column is automatically located under the corresponding connection in the
tree view.

6. Click the Reverse columns tab to automatically reverse the defined columns and thus evaluate the reverse
relation, what city names match to the listed state names.

You can select to connect to a different database by selecting another connection from the Connection list
in the Data Preview section. This list shows all the connections created in the Studio. If the columns listed
in the Analyzed Columns Set view do not exist in the new database connection you want to set, you will
receive a warning message that enables you to continue or cancel the operation.

Finalizing and executing the functional dependency analysis

1. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

2. In the Analysis Parameter view and in the Number of connections per analysis field, set the number of
concurrent connections allowed per analysis to the selected database, if required.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

3. If you have defined context variables in the Contexts view in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

4. Save the analysis and press F6 to execute it.

A progress information pop-up opens to confirm that the operation is in progress. The results of column
functional dependency analysis are displayed in the Analysis Results view.

This functional dependency analysis evaluated the records present in the city column and those present in the
state_province column against each other to see if the city names match to the listed state names and vice
versa. The returned results, in the %Match column, indicate the functional dependency strength for each
determinant column. The records that do not match are indicated in red.
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The #Match column in the result table lists the numbers of the distinct determinant values in each of the
analyzed columns. The #row column in the analysis results lists the actual relations between the determinant
attribute and the dependant attribute. In this example, #Match in the first row of the result table represents the
number of distinct cities, and #row represents the number of distinct pairs (city, state_province). Since these
two numbers are not equal, then the functional dependency relationship here is only partial and the ratio of
the numbers (%Match) measures the actual dependency strength. When these numbers are equal, you have
a "strict" functional dependency relationship, that is to say each city appears only once with each state.

The presence of null values in either of the two analyzed columns will lessen the "dependency strength". The system
does not ignore null values, but rather calculates them as values that violates the functional dependency.

5. In the Analysis Results view, right-click any of the dependency lines and select:

Option To...

View valid/invalid rows access a list in the SQL editor of all valid/invalid rows measured according to the
functional dependencies analysis

View valid/invalid values access a list in the SQL editor of all valid/invalid values measured according to the
functional dependencies analysis

View detailed valid/detailed
invalid values

access a detailed list in the SQL editor of all valid/invalid values measured according to
the functional dependencies analysis

From the SQL editor, you can save the executed query and list it under the Libraries > Source Files folders
in the DQ Repository tree view if you click the save icon on the editor toolbar. For more information, see
Saving the queries executed on indicators.

6.3. Analyzing tables in delimited files
From the Profiling perspective, you can better explore the quality of data in tables in delimited files through either:

• Creating a simple table analysis through analyzing all columns in the table using patterns. For more information,
see  Creating a column set analysis on a delimited file using patterns.

• Comparing a set of columns and creating groups of similar records using blocking and matching keys and/or
survivorship rules. For more information, see Analyzing duplicates.

6.3.1.  Creating a column set analysis on a delimited
file using patterns

This type of analysis provide simple statistics on the number of records falling in certain categories, including the
number of rows, the number of null values, the number of distinct and unique values, the number of duplicates,
or the number of blank fields. For more information about these indicators, see Simple statistics.

It is also possible to add patterns to this type of analysis and have a single-bar result chart that shows the number
of the rows that match "all" the patterns.

6.3.1.1. How to define the set of columns to be analyzed in a
delimited file

You can analyze the content of a set of columns in a delimited file. This set can represent only some of the columns
in the defined table or the table as a whole.
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You can then execute the created analysis using the Java engine.

Prerequisite(s): At least one connection to a delimited file is set in the studio. For further information, see
Connecting to a database.

When carrying out this type of analysis, the set of columns to be analyzed must not include a primary key column.

To define the set of columns to analyzed, do the following:

1. In the DQ Repository tree view, expand the Data Profiling folder.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.

3. In the filter field, start typing Column Set Analysis, select Column Set Analysis and then click Next.
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4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. If required, set column analysis metadata (purpose, description and author name) in the corresponding fields
and click Next to proceed to the next step.
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6. Expand the FileDelimited connection and browse to the set of columns you want to analyze.

7. Select the columns to be analyzed, and then click Finish to close this [New analysis] wizard.

The analysis editor opens with the defined analysis metadata, and a folder for the newly created analysis is
displayed under Analysis in the DQ Repository tree view.
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8. If required, select another connection from the Connection box in the Analyzed Columns view. This box
lists all the connections created in the Studio with the corresponding database names.

By default, the delimited file connection you have selected in the previous step is displayed in the Connection
box.

9. If required, click the Select columns to analyze link to open a dialog box where you can modify your column
selection.
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You can filter the table or column lists by typing the desired text in the Table filter  or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

10. In the column list, select the check boxes of the column(s) you want to analyze and click OK to proceed
to the next step.

In this example, you want to analyze a set of six columns in the delimited file: account number (account_num),
education (education), email (email), first name (fname), last name (lname) and gender (gender). You want
to identify the number of rows, the number of distinct and unique values and the number of duplicates.

11. Use the delete, move up or move down buttons to manage the analyzed columns.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ Repository
view, the selected column will be automatically located under the corresponding connection in the tree view.
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6.3.1.2. How to add patterns to the analyzed columns in the
delimited file

Now, you can add patterns to one or more of the analyzed columns to validate the full record (all columns) against
all the patterns, and not to validate each column against a specific pattern as it is the case with the column analysis.
The results chart is a single bar chart for the totality of the used patterns. This chart shows the number of the rows
that match "all" the patterns.

Before being able to use a specific pattern with a set of columns analysis, you must manually set in the patterns settings
the pattern definition for Java, if it does not already exist. Otherwise, a warning message will display prompting you to set
the definition of the Java regular expression.

Prerequisite(s): An analysis of a set of columns is open in the analysis editor in the studio. For more information,
see How to define the set of columns to be analyzed.

To add patterns to the analysis of a set of columns, do the following:

1.
Click the  icon next to each of the columns you want to validate against a specific pattern.

The [Pattern Selector] dialog box is displayed.

You can add only regular expressions to the analyzed columns.

You can drop the regular expression directly from the Patterns folder in the DQ Repository tree view directly to the
column name in the column analysis editor.

If no Java expression exists for the pattern you want to add, a warning message will display prompting you to add the
pattern definition for Java. Click Yes to open the pattern editor and add the Java regular expression, then proceed
to add the pattern to the analyzed columns.



Creating a column set analysis on a delimited file using patterns

Talend Open Studio for Data Quality User Guide 153

In this example, you want to add a corresponding pattern to each of the analyzed columns to validate data in
these columns against the selected patterns. The result chart will show the percentage of the matching/non-
matching values, the values that respect the totality of the used patterns.

2. In the [Pattern Selector] dialog box, expand Patterns and browse to the regular expression you want to add
to the selected column.

3. Select the check box(es) of the expression(s) you want to add to the selected column.

4. Click OK to proceed to the next step.

The added regular expression(s) display(s) under the analyzed column(s) in the Analyzed Columns view
and the All Match indicator is displayed in the Indicators list in the Indicators view.

6.3.1.3. How to finalize and execute the column set analysis on a
delimited file

What is left before executing this set of columns analysis is to define indicators, data filter and analysis parameters.

Prerequisite(s):A column set analysis is defined in the Profiling perspective of the studio. For further information,
see How to define the set of columns to be analyzed in a delimited file and How to add patterns to the analyzed
columns in the delimited file.
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1. Click Indicators in the analysis editor to open the corresponding view.

The indicators representing the simple statistics are by-default attached to this type of analysis. For further information
about the indicators for simple statistics, see section Simple statistics.

2.
If required, click the option icon  to open a dialog box where you can set options for each indicator. For
more information about indicators management, see Indicators.

3. If required, click Data Filter in the analysis editor to display its view and filter data through SQL "WHERE"
clauses.

4. In the Analysis Parameters view, select the Allow drill down check box to store locally the data that will
be analyzed by the current analysis.

5. In the Max number of rows kept per indicator field enter the number of the data rows you want to make
accessible.

The Allow drill down check box is selected by default, and the maximum analyzed data rows to be shown per indicator
is set to 50.

6. Press F6 to execute the analysis.

The editor switches to the Analysis Results view and displays the graphical result corresponding to the
Simple Statistics indicators used to analyze the defined set of columns.
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When you use patterns to match the content of the columns to be analyzed, another graphic is displayed to
illustrates the match results against the totality of the used patterns.

6.3.1.4. How to filter analysis data against patterns

The procedure to filter the data of the analysis of a delimited file is the same as that for the database analysis. For
further information, see How to filter data against patterns.
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6.3.2.  Creating a column analysis from the analysis of
a set of columns

You can create a column analysis on one or more columns defined in the set of columns analysis.

Prerequisite(s): A simple table analysis is defined in the analysis editor in the Profiling perspective of the studio.

To create a column analysis on one or more columns defined in the set of columns analysis, do the following:

1. Open the set of columns analysis.

2. In the Analyzed Columns view, right-click the column(s) you want to create a column analysis on.

3. Select Column analysis from the contextual menu. The [New Analysis] wizard opens.

4. In the Name field, enter a name for the new column analysis and then click Next to proceed to the next step.

The analysis editor opens with the defined metadata and a folder for the newly created analysis is displayed
under the Analyses folder in the DQ Repository tree view.

5. Follow the steps outlined in Creating a basic column analysis on a file to continue creating the column
analysis on a delimited file.

6.4. Analyzing duplicates
You can use the match analysis in the Profiling perspective of the studio to compare columns in databases or
delimited files and create groups of similar records using the VSR or the T-Swoosh algorithm.

This analysis provides you with a simple way to create match rules, test them on a set of columns and see the
results directly in the editor..

You can also use the Profiling perspective to define match rules in a match rule editor and save them in the studio
repository. For further information, see Creating a match rule.
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6.4.1. Creating a match analysis

The match analysis enables you to compare a set of columns in databases or in delimited files and create groups
of similar records using blocking and matching keys and/or survivorship rules.

This analysis enables you to create match rules and test them on data to assess the number of duplicates . Currently,
you can test match rules only on columns in the same table.

Prerequisite(s): At least one database or file connection is defined under the Metadata node. For further
information, see Connecting to a database.

The sequence of setting up a match analysis involves the following steps:

1. Creating the connection to a data source from inside the editor if no connection has been defined under the
Metadata folder in the Studio tree view.

For further information, see How to configure the match analysis.

2. Defining the table or the group of columns you want to search for similar records using match processes.

For further information, see How to define a match analysis from the Analysis folder or How to define a
match analysis from the Metadata folder.

3. Defining blocking keys to reduce the number of pairs that need to be compared.

For further information, see How to define a match rule.

4. Defining match keys, the match methods according to which similar records are grouped together. For further
information, see How to define a match rule.

5. Exporting the match rules from the match analysis editor and centralize them in the studio repository.

For further information, see How to import or export match rules.

6.4.1.1. How to define a match analysis from the Analysis folder

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analysis folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. Start typing match in the filter field, select Match Analysis and then click Next to open a wizard.

4. Set the analysis name and metadata and then click Next.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.
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5. Expand DB connections or FileDelimited connections depending on if the columns you want to match are
in a database or a delimited file.

6. Browse to the columns you want to match, select them and then click Finish.

The columns you select should be in the same table. Currently, the match analysis does not work on columns
in different tables.

The match analysis editor opens listing the selected columns.

You can also define a match analysis starting from the table or columns you want to match. For further
information, see How to define a match analysis from the Metadata folder.
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7. Modify the parameters in the match analysis editor according to your needs.

For further information, see How to configure the match analysis.

6.4.1.2. How to define a match analysis from the Metadata folder

1. In the DQ Repository tree view, expand Metadata.

2. Either:

• Browse the database or the file connection to the table you want to match, right-click it and select Match
Analysis, or

• Browse the database or the file connection to the columns you want to match, right-click them and select
Analyze matches.

The columns you select should be in the same table. Currently, the match analysis does not work on columns
in different tables.

The match analysis editor opens listing all columns in the table or the group of selected columns.

3. Set the analysis name and metadata and click Next to open the analysis editor.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

4. Modify the parameters in the match analysis editor according to your needs.

For further information, see How to configure the match analysis.

6.4.1.3. How to configure the match analysis

1. In the Limit field in the match analysis editor, set the number for the data records you want to use as a data
sample.

Data is displayed in the Data Preview table.
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2. If required, click any column name in the table to sort the sample data in an ascending or descending order.

3. In the match analysis editor, select:

Option To...

locate the selected table under the Metadata node in the tree view.

New Connection create a connection to a database or to a file from inside the match analysis editor where
you can expand this new connection and select the columns on which to do the match.

For further information about how to create a connection to data sources, see Connecting
to a database and Connecting to a file.

Select Data update the selection of the columns listed in the table.

If you change the data set for an analysis, the charts that display the match results of the
sample data will be cleared automatically. You must click Chart to compute the match
results for the new data set you have defined.

Refresh Data refresh the view of the columns listed in the table.

n first rows

or

n random rows

lists in the table N first data records from the selected columns or list N random records
from the selected columns.

Select Blocking Key define the column(s) from the input flow according to which you want to partition the
processed data in blocks.

For more information, see How to define a match rule.

Select Matching Key define the match rules and the column(s) from the input flow on which you want to apply
the match algorithm.

For more information, see How to define a match rule.

The Data Preview table has some additional columns which show the results of matching data. The indication
of these columns are as the following:
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Column Description

GID represents the group identifier.

GRP_SIZE counts the number of records in the group, computed only on the master record.

MASTER identifies, by true or false, if the record used in the matching comparisons is a master
record. There is only one master record per group.

Each input record will be compared to the master record, if they match, the input record will
be in the group.

SCORE measures the distance between the input record and the master record according to the
matching algorithm used.

GRP_QUALITY only the master record has a quality score which is the minimal value in the group.

ATTRIBUTE_SCORE lists the match score and the names of the columns used as key attributes in the applied rules.

6.4.1.4. How to define a match rule

You can define match rules from the match analysis editor by defining:

• blocking keys, the column(s) from the input flow according to which you want to partition the processed data
in blocks,

• matching keys and survivorship rules, the match algorithms you want to apply on columns from the input flow.

Defining a blocking key

Defining a blocking key is not mandatory but strongly advisable. Using a blocking key to partition data in blocks
reduces the number of records that need to be examined as comparisons are restricted to record pairs within each
block. Using blocking column(s) is very useful when you are processing a big data set.

1. In the Data section, click the Select Blocking Key tab and then click the name of the column(s) you want
to use to partition the processed data in blocks.

Blocking keys that have the exact name of the selected columns are listed in the Blocking Key table.
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You can define more than one column in the table, but only one blocking key will be generated and listed
in the BLOCK_KEY column in the Data table.

For example, if you use an algorithm on the country and lnamecolumns to process records that have the same
first character, data records that have the same first letter in the country and last names are grouped together
in the same block. Comparison is restricted to record within each block.

To remove a column from the Blocking key table, right-click it and select Delete or click on its name in
the Data table.

2. Select an algorithm for the blocking key, and set the other parameters in the Blocking Key table as needed.

In this example, only one blocking key is used. The first character of each word in the country column is
retrieved and listed in the BLOCK_KEY column.

3. Click Chart to compute the generated key, group the sample records in the Data table and display the results
in a chart.

This chart allows you to visualize the statistics regarding the number of blocks and to adapt the blocking
parameters according to the results you want to get.

Defining a matching key with the VSR algorithm

1. In the Record linkage algorithm section, select Simple VSR Matcher if it is not selected by default.

2. In the Data section, click the Select Matching Key tab and then click the name of the column(s) on which
you want to apply the match algorithm.

Matching keys that have the exact names of the selected input columns are listed in the Matching Key table.

To remove a column from this table, right-click it and select Delete or click on its name in the Data table.
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3. Select the match algorithms you want to use from the Matching Function column and the null operator from
the Handle Null column.

In this example two match keys are defined, you want to use the Levenshtein and Jaro-Winkler match
methods on first names and last names respectively and get the duplicate records.

If you want to use an external user-defined matching algorithm, select Custom and use the Custom Matcher
column to load the Jar file of the user-defined algorithm.

Defining a matching key with the T-Swoosh algorithm

• Make sure first to select the column(s) on which to apply the match algorithm either from the Data section
by using the Select Matching Key tab, or directly from the Matching Key table.

To create a match key using the T-Swoosh algorithm:

1. In the Record linkage algorithm section, select T-Swoosh.

2. In the Match and Survivor section, you define the criteria to use when matching data records. Click the [+]
button to add a new rule, and then set the following criteria.

• Match Key Name: Enter the name of your choice for the match key.

• Matching Function: Select the type of matching you want to perform from the drop-down list. Select
Custom if you want to use an external user-defined matching algorithm.

• Custom Matcher: This item is only used with the Custom matching function. Browse and select the Jar
file of the user-defined algorithm.

• Threshold: Specify the match score (between 0 and 1) above which two values should be considered a
match.

• Confidence Weight: Set a numerical weight (between 1 and 10) to the column you want to use as a match
key. This value is used to give greater or lesser importance to certain columns when performing the match.

• Handle Null: Specify how to deal with data records which contain null values.

• nullMatchNull: If both records contain null values, consider this a match.

• nullMatch None: If one record contains a null, do not consider this a match.

• nullMatch All: If one record contains a null, consider this a match.

• Survivorship Function: Select how two similar records will be merged from the drop-down list.

• Concatenate: It adds the content of the first record and the content of the second record together - for
example, Bill and William will be merged into BillWilliam. In the Parameter field, you can specify a
separator to be used to separate values.

• Prefer True (for booleans): It always set booleans to True in the merged record, unless all booleans
in the source records are False.

• Prefer False (for booleans): It always sets booleans to False in the merged record, unless all booleans
in the source records are True.

• Most common: It validates the most frequently-occurring field value in each duplicates group.

• Most recent or Most ancient: The former validates the earliest date value and the latter the latest date
value in each duplicates group. The relevant reference column must be of the Date type.

• Longest or Shortest: The former validates the longest field value and the latter the shortest field value
in each duplicates group.



Creating a match analysis

Talend Open Studio for Data Quality User Guide 165

• Largest or Smallest: The former validates the largest numerical value and the latter the smallest
numerical value in a duplicates group.

Make sure you select Largest or Smallest as the survivorship function when the match key is of numeric type.

• Parameter: For the Most trusted source survivorship function, this item is used to set the name of the data
source you want to use as a base for the master record. For the Concatenate survivorship function, this
item is used to specify a separator you want to use for concatenating data.

3. In the Match threshold field, enter the match probability threshold.

Two data records match when the probability is above this value.

In the Confident match threshold field, set a numerical value between the current Match threshold and 1.

4. In the Default Survivorship Rules section, you define how to survive matches for certain data types:
Boolean, Data, Number and String. If you do not specify the behavior for any or all data types, the default
behavior is applied.

• Click the [+] button to add a new row for each data type.

• In the Data Type column, select the relevant data type from the drop-down list.

• In the Survivorship Function column, select how two similar records will be merged from the drop-down
list. Note that, depending on the data type, only certain choices may be relevant.

Make sure you select Largest or Smallest as the survivorship function when the match key is of numeric type.

• Parameter: For the Most trusted source survivorship function, this item is used to set the name of the data
source you want to use as a base for the master record. For the Concatenate survivorship function, this
item is used to specify a separator you want to use for concatenating data.

5. Save your changes.

Editing rules and displaying sample results

1. To define a second match rule, put your cursor on the top right corner of the Matching Key table, click the
[+] button to create a new rule.

Follow the steps outlined in How to define a match rule to define matching keys.

When you define multiple conditions in the match rule editor, an OR match operation is conducted on the
analyzed data. Records are evaluated against the first rule and the records that match are not evaluated against
the second rule and so on.

2.
Click the  button at the top right corner of the Matching Key or Match and Survivor section and replace
the default name of the rule with a name of your choice.
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If you define more than one rule in the match analysis, you can use the up and down arrows in the dialog box
to change the rule order and thus decide what rule to execute first.

3. Click OK.

The rules are named and ordered accordingly in the section.

4. In the Match threshold field, enter the match probability threshold.

Two data records match when the probability is above this value.

In the Confident match threshold field, set a numerical value between the current Match threshold and 1.

If the GRP-QUALITY calculated by the match analysis is equal to or greater than the Confident match
threshold, you can be confident about the quality of the group.

5. Click Chart to compute the groups according to the blocking key and match rule you defined in the editor
and display the results of the sample data in a chart.

This chart shows a global picture about the duplicates in the analyzed data. The Hide groups less than
parameter is set to 2 by default. This parameter enables you to decide what groups to show in the chart, you
usually want to hide groups of small group size.

The chart in the above image indicates that out of the 1000 sample records you examined and after excluding
items that are unique, by having the Hide groups less than parameter set to 2:

• 49 groups have 2 items each. In each group, the 2 items are duplicates of each other.
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• 7 groups have 3 duplicate items and the last group has 4 duplicate items.

Also, the Data table indicates the match details of items in each group and colors the groups in accordance
with their colors in the match chart.

6.4.1.5. How to show the match results

To collect duplicates from the input flow according to the match types you define, Levenshtein and Jaro-Winkler
in this example, do the following:

• Save the settings in the match analysis editor and press F6.

The analysis is executed. The match rule and blocking key are computed against the whole data set and the
Analysis Results view is open in the editor.

In this view, the charts give a global picture about the duplicates in the analyzed data. In the first tables, you
can read statistics about the count of processed records, distinct records with only one occurrence, duplicate
records (matched records) and suspect records that did not match the rule. Duplicate records represent the
records that matched with a good score - above the confidence threshold. One record of the matched pair is
a duplicate that should be discarded and the other is the survivor record.

In the second table, you can read statistics about the number of groups and the number of records in each
group. You can click any column header in the table to sort the results accordingly.

6.4.1.6. How to import or export match rules

You can import match rules from the studio repository and use them in the match editor to test them on your data.
You can also export match rules from the match editor and save them in the studio repository.
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You can import match rules stored in the studio repository into the match editor and test them on your data. You
can also export match rules from the editor and store them in the studio repository.

Importing match rules from the repository

1. In the match editor, click the  icon on top of the editor.

2. In the [Match Rule Selector] wizard, select the match rule you want to import into the match analysis editor
and use on the analyzed data.

A warning message displays in the wizard if the match rule you want to import is defined on columns that
do not exist in the analyzed data. Ignore the message as you can define input columns later in the match
analysis editor.

3. Select the Overwrite current Match Rule in the analysis check box if you want to replace the rule in the
editor with the rule you import, otherwise, leave the box unselected.

4. Click OK.

The match rule is imported and the matching and blocking keys and /or survivorship rules are listed in the
Matching Key and Blocking Key tables respectively.
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5. Click in the Input column and select from the list the column on which you want to apply the imported
blocking and matching keys.

If you have in the analyzed data a column that match the input column in the imported keys, it will be
automatically defined in the Input column, you do not need to define it yourself.

When you analyze data with multiple conditions, the match results will list data records that meet any of the
defined rules. When you execute the match analysis, an OR match operation is conducted on data and data
records are evaluated against the first rule and the records that match are not evaluated against the other rules.

Exporting match rules to the repository

1. In the match editor, click the  icon on top of the editor.
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2. In the open wizard, enter a name for the rule and set other metadata, if needed.

3. Click Finish.

The rule editor opens on the rule settings and the rule is saved and listed under Libraries > Rules > Match
in the DQ Repository tree view.

6.4.2. Creating a match rule

In data quality, match rules are used to compare a set of columns and create groups of similar records using
blocking and matching keys and/or survivorship functions.

From the studio, you can create match rules with the VSR or the T-Swoosh algorithm and save them in the studio
repository. Once centralized in the repository, you can import them in the match analysis editor and test them
on your data to group duplicate records. For further information about the match analysis, see Creating a match
analysis.

The two algorithms produce different match results because of two reasons:

• first, the master record is simply selected to be the first input record with the VSR algorithm. Therefore, the list
of match groups may depend on the order of the input records,

• second, the output records do not change with the VSR algorithm, whereas the T-Swoosh algorithm creates
new records.

6.4.2.1. How to define the rule

1. In the DQ Repository tree view, expand Libraries > Rules.

2. Right-click Match and select New Match Rule.
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3. In the [New Match Rule] wizard, enter a name and set other metadata, if required.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

Consider as an example that you want to create a rule to match customer full names.

4. Click Finish.

A match rule editor opens in the studio and the new match rule is listed under Libraries > Rule > Match
in the DQ Repository tree view.

In the Record Linkage algorithm view, the Simple VSR Matcher algorithm is selected by default.

5. Start defining the match rule items as described in Rules with the VSR algorithm and Rules with the T-Swoosh
algorithm.

6.4.2.2. How to duplicate a rule

To avoid creating a match rule from scratch, you can duplicate an existing one and work around its metadata and
definition to have a new rule.

To duplicate a rule, do the following:

1. In the DQ Repository tree view, expand Libraries > Rules > Match.
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2. Browse through the match rule list to reach the rule you want to duplicate.

3. Right-click its name and select Duplicate.

The duplicated rule is created under the Match folder in the DQ Repository tree view.

4. Double-click the duplicated rule to open it and modify its metadata and/or definition as needed.

6.4.2.3. Rules with the VSR algorithm

The VSR algorithm takes a set of records as input and groups similar encountered duplicates together according
to defined match rules. It compares pairs of records and assigns them to groups. The first processed record of each
group is the master record of the group. The VSR algorithm compares each record with the master of each group
and uses the computed distances, from master records, to decide to what group the record should go.

In the match analysis, the matching results of the VSR algorithm may vary depending on the order of the input
records. If possible, put the records in which you have more confidence first in the input flow, to have better
algorithm accuracy.

Defining a blocking key

Defining a blocking key is not mandatory but advisable. Using a blocking key partitions data in blocks and thus
reduces the number of records to be examined, as comparisons are restricted to record pairs within each block.
Using blocking key(s) is very useful when you are processing big data set.

1. In the rule editor and in the Generation of Blocking Key section, click the [+] button to add a row to the table.

2. Set the parameters of the blocking key as the following:

• Blocking Key Name: Enter a name for the column you want to use to reduce the number of record pairs
that need to be compared.

• Pre-algorithm: Select from the drop-down list an algorithm and set its value where necessary.

Defining a pre-algorithm is not mandatory. This algorithm is used to clean or standardize data before
processing it with the match algorithm and thus improve the results of data matching.

• Algorithm: Select from the drop-down list the match algorithm you want to use and set its value where
necessary.

• Post-algorithm: Select from the drop-down list an algorithm and set its value where necessary

Defining a post-algorithm is not mandatory. This algorithm is used to clean or standardize data after
processing it with the match algorithm and thus improve the outcome of data matching.

3. If required, follow the same steps to add as many blocking keys as needed.

When you import a rule with many blocking keys into the match analysis editor, only one blocking key will
be generated and listed in the BLOCK_KEY column in the Data table.

Defining a matching key

1. In the rule editor and in the Matching Key table, click the [+] button to add a row to the table.

2. Set the parameters of the matching key as the following:

• Match Key Name: Enter the name of your choice for the match key.

• Matching Function: Select the type of matching you want to perform from the drop-down list. Select
Custom if you want to use an external user-defined matching algorithm.
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In this example two match keys are defined, you want to use the Levenshtein and Jaro-Winkler match
methods on first names and last names respectively and get the duplicate records.

• Custom Matcher: This item is only used with the Custom matching function. Browse and select the Jar
file of the user-defined algorithm.

• Confidence Weight: Set a numerical weight (between 1 and 10) to the column you want to use as a match
key. This value is used to give greater or lesser importance to certain columns when performing the match.

• Handle Null: Specify how to deal with data records which contain null values.

3. In the Match threshold field, enter the match probability threshold. Two data records match when the
probability is above this value.

In the Confident match threshold field, set a numerical value between the current Match threshold and 1.
Above this threshold, you can be confident about the quality of the group.

4. To define a second match rule, place your cursor on the top right corner of the Matching Key table and then
click the [+] button.

Follow the steps to create a match rule.

When you define multiple conditions in the match rule editor, an OR match operation is conducted on the
analyzed data. Records are evaluated against the first rule and the records that match are not evaluated against
the second rule.

5.
If required, put your cursor on the top right corner of the table and click the  button then replace the
default names of the rules with names of your choice.
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You can also use the up and down arrows in the dialog box to change the rule order and thus decide what
rule to execute first.

6. Click OK.

The rules are named and ordered accordingly in the Matching Key table.

7. Save the match rule settings.

The match rule is saved and centralized under Libraries > Rule > Match in the DQ Repository tree view.

You can import and test the rule on your data in the match analysis editor. For further information, see How to
import or export match rules.

6.4.2.4. Rules with the T-Swoosh algorithm

You can use the T-Swoosh algorithm to find duplicates and to define how two similar records are merged to create
a master record, using a survivorship function. These new merged records are used to finds new duplicates. The
difference with the VSR algorithm is that the master record is in general a new record that does not exist in the
list of input records.

1. In the Record linkage algorithm section, select T-Swoosh.

2. In the Match and Survivor section, you define the criteria to use when matching data records. Click the [+]
button to add a new rule, and then set the following criteria.

• Match Key Name: Enter the name of your choice for the match key.

• Matching Function: Select the type of matching you want to perform from the drop-down list. Select
Custom if you want to use an external user-defined matching algorithm.

• Custom Matcher: This item is only used with the Custom matching function. Browse and select the Jar
file of the user-defined algorithm.

• Threshold: Specify the match score (between 0 and 1) above which two values should be considered a
match.

• Confidence Weight: Set a numerical weight (between 1 and 10) to the column you want to use as a match
key. This value is used to give greater or lesser importance to certain columns when performing the match.
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• Handle Null: Specify how to deal with data records which contain null values.

• nullMatchNull: If both records contain null values, consider this a match.

• nullMatch None: If one record contains a null, do not consider this a match.

• nullMatch All: If one record contains a null, consider this a match.

• Survivorship Function: Select how two similar records will be merged from the drop-down list.

• Concatenate: It adds the content of the first record and the content of the second record together - for
example, Bill and William will be merged into BillWilliam. In the Parameter field, you can specify a
separator to be used to separate values.

• Prefer True (for booleans): It always set booleans to True in the merged record, unless all booleans
in the source records are False.

• Prefer False (for booleans): It always sets booleans to False in the merged record, unless all booleans
in the source records are True.

• Most common: It validates the most frequently-occurring field value in each duplicates group.

• Most recent or Most ancient: The former validates the earliest date value and the latter the latest date
value in each duplicates group. The relevant reference column must be of the Date type.

• Longest or Shortest: The former validates the longest field value and the latter the shortest field value
in each duplicates group.

• Largest or Smallest: The former validates the largest numerical value and the latter the smallest
numerical value in a duplicates group.

Make sure you select Largest or Smallest as the survivorship function when the match key is of numeric type.

• Parameter: For the Most trusted source survivorship function, this item is used to set the name of the data
source you want to use as a base for the master record. For the Concatenate survivorship function, this
item is used to specify a separator you want to use for concatenating data.

3. In the Match threshold field, enter the match probability threshold.

Two data records match when the probability is above this value.

In the Confident match threshold field, set a numerical value between the current Match threshold and 1.

4. In the Default Survivorship Rules section, you define how to survive matches for certain data types:
Boolean, Data, Number and String. If you do not specify the behavior for any or all data types, the default
behavior is applied.

• Click the [+] button to add a new row for each data type.

• In the Data Type column, select the relevant data type from the drop-down list.

• In the Survivorship Function column, select how two similar records will be merged from the drop-down
list. Note that, depending on the data type, only certain choices may be relevant.

Make sure you select Largest or Smallest as the survivorship function when the match key is of numeric type.

• Parameter: For the Most trusted source survivorship function, this item is used to set the name of the data
source you want to use as a base for the master record. For the Concatenate survivorship function, this
item is used to specify a separator you want to use for concatenating data.
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5. Save your changes.
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Chapter 7. Redundancy analyses
This chapter provides all the information you need to perform redundancy analysis that can compare table content
or identify overlapping values between two sets of columns.
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7.1. What are redundancy analyses
Redundancy analyses are column comparison analyses that better explore the relationships between tables through:

• Comparing identical columns in different tables,

• Matching foreign keys in one table to primary keys in the other table and vice versa.

Redundancy analyses support only database tables.

7.2. Comparing identical columns in different
tables
From your studio, you can create an analysis that compares two identical sets of columns in two different tables.
This redundancy analysis supports only database tables.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. In the filter field, start typing redundancy analysis, select Redundancy Analysis from the list and click Next.

4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.
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5. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Next.

Selecting the identical columns you want to compare

1. Expand DB connections and in the desired database, browse to the columns you want to analyze, select them
and then click Finish to close the wizard.

A file for the newly created analysis is listed under the Analysis folder in the DQ Repository tree view. The
analysis editor opens with the defined analysis metadata.

The display of the analysis editor depends on the parameters you set in the [Preferences] window. For more
information, see Setting preferences of analysis editors and analysis results.
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2. Click Analyzed Column Sets to open the view where you can set the columns or modify your selection.

In this example, you want to compare identical columns in the account and account_back tables.

3. From the Connection list, select the database connection relevant to the database to which you want to
connect.

You can find in this list all the database connections you create and centralize in the Studio repository.

4. Click A column Set to open the [Column Selection] dialog box.
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5. Browse the catalogs/schemas in your database connection to reach the table holding the columns you want
to analyze.

You can filter the table or column lists by typing the desired text in the Table filter  or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

6. Click the table name to list all its columns in the right-hand panel of the [Column Selection] dialog box.

7. In the list to the right, select the check boxes of the column(s) you want to analyze and click OK to proceed
to the next step.

You can drag the columns to be analyzed directly from the DQ Repository tree view to the editor.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view, the selected column will be automatically located under the corresponding connection in
the tree view.

8. Click B Column B Set and follow the same steps to select the second set of columns or drag it to the right
column panel.

9. Select the Compute only number of A rows not in B check box if you want to match the data from the A
set against the data from the B set and not vice versa.

Finalizing and executing the analysis

1. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

2. In the Analysis Parameter view and in the Number of connections per analysis field, set the number of
concurrent connections allowed per analysis to the selected database, if required.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

3. If you have defined context variables in the Contexts view in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

4. Save the analysis and press F6 to execute it.

A confirmation message is displayed.

5. Click OK if you want to continue the operation.

The Analysis Results  view opens showing the analysis results.

In this example, 72.73% of the data present in the columns in the account table could be matched with the
same data in the columns in the account_back table.
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Through this view, you can also access the actual analyzed data via the Data Explorer.

To access the analyzed data rows, right-click any of the lines in the table and select:

Option To...

View match rows access a list of all rows that could be matched in the two identical column sets

View not match rows access a list of all rows that could not be matched in the two identical column sets

View rows access a list of all rows in the two identical column sets

The data explorer does not support connections which has empty user name, such as Single sign-on of MS SQL Server. If
you analyze data using such connection and you try to view data rows in the Data Explorer perspective, a warning message
prompt you to set your connection credentials to the SQL Server.

The figure below illustrates the data explorer list of all rows that could be matched in the two sets, eight in this
example.

From the SQL editor, you can save the executed query and list it under the Libraries > Source Files folders in
the DQ Repository tree view if you click the save icon on the editor toolbar. For more information, see Saving
the queries executed on indicators.

The figure below illustrates the data explorer list of all rows that could not be matched in the two sets, three in
this example.
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For more information about the data explorer Graphical User Interface, see Data Explorer management GUI.

7.3. Matching primary and foreign keys
You can create an analysis that matches foreign keys in one table to primary keys in the other table and vice versa.
This redundancy analysis supports only database tables.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

To match primary and foreign keys in tables, do the following:

Defining the analysis

1. In the DQ Repository tree view, expand the Data Profiling folder.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. In the filter field, start typing redundancy analysis and then select Redundancy Analysis, click Next.

4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.
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5. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Finish.

A file for the newly created analysis is displayed under the Analysis folder in the DQ Repository tree view.
The analysis editor opens with the defined analysis metadata.

Selecting the primary and foreign keys

1. Click Analyzed Column Sets to display the corresponding view.

In this example, you want to match the foreign keys in the customer_id column of the sales_fact_1998 table
with the primary keys in the customer_id column of the customer table, and vice versa. This will explore the
relationship between the two tables to show us for example if every customer has an order in the year 1998.
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2. From the Connection list, select the database connection relevant to the database to which you want to
connect.

You have in this list all the connections you create and centralize in the Studio repository.

3. Click A Column Set to open the [Column Selection] dialog box.

If you want to check the validity of the foreign keys, select the column holding the foreign keys for the A set
and the column holding the primary keys for the B set.
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4. Browse the catalogs/schemas in your database connection to reach the table holding the column you want to
match. In this example, the column to be analyzed is customer_id that holds the foreign keys.

You can filter the table or column lists by typing the desired text in the Table filter  or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

5. Click the table name to display all its columns in the right-hand panel of the [Column Selection] dialog box.

6. In the list to the right, select the check box of the column holding the foreign keys and then click OK to
proceed to the next step.

You can drag the columns to be analyzed directly from the DQ Repository tree view to the editor.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view, the selected column will be automatically located under the corresponding connection in
the tree view.

7. Click B Column Set and follow the same steps to select the column holding the primary keys or drag it from
the DQ Repository to the right column panel.

If you select the Compute only number of rows not in B check box, you will look for any missing primary
keys in the column in the B set.

8. Click Data Filter in the analysis editor to display the view where you can set a filter on each of the analyzed
columns.

9. Press F6 to execute this key-matching analysis.

A confirmation message is displayed.

10. Click OK in the message if you want to continue the operation.

The execution of this type of analysis may takes some time. Wait till the Analysis Results view opens
automatically showing the analysis results.

In this example, every foreign key in the sales_fact_1998 table is identified with a primary key in the customer
table. However, 98.22% of the primary keys in the customer table could not be identified with foreign keys
in the sales_fact_1998 table. These primary keys are for the customers who did not order anything in 1998.

Through this view, you can also access the actual analyzed data via the data explorer.

To access the analyzed data rows, right-click any of the lines in the table and select:

Option To...

View match rows access a list of all rows that could be matched in the two identical column sets

View not match rows access a list of all rows that could not be matched in the two identical column sets
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View rows access a list of all rows in the two identical column sets

The data explorer does not support connections which has empty user name, such as Single sign-on of MS SQL Server. If
you analyze data using such connection and you try to view data rows in the Data Explorer perspective, a warning message
prompt you to set your connection credentials to the SQL Server.

The figure below illustrates in the data explorer the list of all analyzed rows in the two columns.

From the SQL editor, you can save the executed query and list it under the Libraries > Source Files folders in
the DQ Repository tree view if you click the save icon on the editor toolbar. For more information, see Saving
the queries executed on indicators.

For more information about the data explorer Graphical User Interface, see Data Explorer management GUI.
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Chapter 8. Correlation analyses
This chapter provides all the information you need to perform column correlation analyses between nominal
and interval columns or nominal and date columns in database tables. A column correlation analysis can also
investigate minimal correlations between nominal columns in the same table.

Column correlation analyses are usually used to explore relationships and correlations in data. They are not used
to provide statistics about the quality of data.
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8.1. What are column correlation analyses
Your studio provides the possibility to explore relationships and correlations between two or more columns so
that these relationships and correlations give a new interpretation of the data through describing how data values
are correlated at different positions.

Column correlation analyses are possible only on database columns for the time being. You can not use these analyses on
file connections.

It is very important to make the distinction between column correlation analyses and all other types of data quality
analyses. Column correlation analyses are usually used to explore relationships and correlations in data and not
to provide statistics about the quality of data.

Several types of column correlation analysis are possible. For more information, see Creating a numerical
correlation analysis, Creating a time correlation analysis and Creating a nominal correlation analysis.

For more information about the use of data mining types in the studio, see Data mining types.

8.2. Numerical correlation analyses
This type of analysis analyzes correlation between nominal and interval columns and gives the result in a kind
of a bubble chart.

A bubble chart is created for each selected numeric column. In a bubble chart, each bubble represents a distinct
record of the nominal column. For example, a nominal column called outlook with 3 distinct nominal instances:
sunny (11 records), rainy (16 records) and overcast (4 records) will generate a bubble chart with 3 bubbles.

The second column in this example is the temperature column where temperature is in degrees Celsius. The
analysis in this example will show the correlation between the outlook and the temperature columns and will give
the result in a bubble chart. The vertical axis represents the average of the numeric column and the horizontal
axis represents the number of records of each nominal instance. The average temperature would be 23.273 for the
"sunny" instances, 7.5 for the "rainy" instances and 18.5 for the "overcast" instances.

The two things to pay attention to in such a chart is the position of the bubble and its size.

Usually, outlier bubbles must be further investigated. The more the bubble is near the left axis, the less confident
we are in the average of the numeric column. For example, the overcast nominal instance here has only 4 records,
hence the bubble is near the left axis. We cannot be confident in the average with only 4 records. When looking
for data quality issues, these bubbles could indicate problematic values.

The bubbles near the top of the chart and those near the bottom of the chart may suggest data quality issues too.
A too high or too low temperature in average could indicate a bad measure of the temperature.



Creating a numerical correlation analysis

Talend Open Studio for Data Quality User Guide 193

The size of the bubble represents the number of null numeric values. The more there are null values in the interval
column, the bigger will be the bubble.

When several nominal columns are selected, the order of the columns plays a crucial role in this analysis. A series
of bubbles (with one color) is displayed for the average temperature and the weather. Another series of bubbles is
displayed for the average temperature and each record of any other nominal column.

8.2.1. Creating a numerical correlation analysis

In the example below, you want to create a numerical correlation analysis to compute the age average of the
personnel of different enterprises located in different states. Three database columns are used for the analysis:
STATE, AGE and COMPANY.

The numerical correlation analysis is possible only on database columns for the time being. You can not use this analysis
on file connections.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand Data Profiling.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. Start typing numerical correlation analysis in the filter field, select Numerical Correlation Analysis and
then click Next.

4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.
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5. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Finish.

A folder for the newly created analysis is listed under Analysis in the DQ Repository tree view, and the
analysis editor opens on the analysis metadata.

Selecting the columns you want to analyze and setting analysis parameters

1. In the analysis editor and from the Connection list, select the database connection on which to run the
analysis.

The numerical correlation analysis is possible only on database columns for the time being. You can change
your database connection by selecting another connection from the Connection list. If the analyzed columns
do not exist in the new database connection you want to set, you receive a warning message that enables you
to continue or cancel the operation.

2. Click Select Columns to open the [Column Selection] dialog box.
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3. Browse the catalogs/schemas in your database connection to the column(s) you want to analyze.

You can filter the table or column lists by typing the desired text in the Table filter  or Column filter fields
respectively. The lists will show only the tables/columns that correspond to the text you type in.

4. Click the table name to list all its columns in the right-hand panel of the [Column Selection] dialog box.

5. In the column list, select the check boxes of the column(s) you want to analyze and click OK.

In this example, you want to compute the age average of the personnel of different enterprises located in
different states. Then the columns to be analyzed are AGE, COMPANY and STATE.

The selected columns are displayed in the Analyzed Column  view of the analysis editor.



Creating a numerical correlation analysis

Talend Open Studio for Data Quality User Guide 197

You can drag the columns to be analyzed directly from the corresponding database connection in the DQ
Repository tree view into the Analyzed Columns area.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view, the selected column will be automatically located under the corresponding connection in
the tree view.

6.
In the Indicators view, click  to open a dialog box where you can set thresholds for each indicator.

The indicators representing the simple statistics are by-default attached to this type of analysis.

7. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

8. In the Analysis Parameter view and in the Number of connections per analysis field, set the number of
concurrent connections allowed per analysis to the selected database connection, if required.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

9. If you have defined context variables in the Contexts view in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.
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• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

10. Press F6 to execute the analysis.

The editor switches to the Analysis Results view showing the results.

For detail explanation of the analysis results, see Exploring the analysis results.

8.2.2. Exploring the analysis results

Prerequisite(s): A numerical correlation analysis is defined and executed in the Profiling perspective of the
studio.

In the Analysis Results view of the analysis editor:

• Click Graphics, Simple Statistics or Data to show the generated graphic, the number of the analyzed records
or the actual analyzed data respectively.

In the Graphics view, the data plotted in the bubble chart have different colors with the legend pointing out which
color refers to which data.

The more the bubble is near the left axis the less confident we are in the average of the numeric column. For the
selected bubble in the above example, the company name is missing and there are only two data records, hence
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the bubble is near the left axis. We cannot be confident about age average with only two records. When looking
for data quality issues, these bubbles could indicate problematic values.

The bubbles near the top of the chart and those near the bottom of the chart may suggest data quality issues too,
too big or too small age average in the above example.

From the generated graphic, you can:

• clear the check box of the value(s) you want to hide in the bubble chart,

• place the pointer on any of the bubbles to see the correlated data values at that position,

• right-click any of the bubbles and select:

Option To...

Show in full screen open the generated graphic in a full screen

View rows access a list of all analyzed rows in the selected column

The below figure illustrates an example of the SQL editor listing the correlated data values at the selected
position.

From the SQL editor, you can save the executed query and list it under the Libraries > Source Files folders in
the DQ Repository tree view if you click the save icon on the editor toolbar. For more information, see Saving
the queries executed on indicators.

The Simple Statistics view shows the number of the analyzed records falling in certain categories, including the
number of rows, the number of distinct and unique values and the number of duplicates.

The Data view displays the actual analyzed data.
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You can sort the data listed in the result table by simply clicking any column header in the table.

8.3. Time correlation analyses
This type of analysis analyzes correlation between nominal and date columns and gives the result in a gantt chart
that illustrates the start and finish dates of each value of the nominal column.

8.3.1. Creating a time correlation analysis
In the example below, you want to create time correlation analysis to compute the minimal and maximal birth
dates for each listed country in the selected nominal column. Two columns are used for the analysis: birthdate
and country.

The time correlation analysis is possible only on database columns for the time being. You can not use this analysis on
file connections.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand the Data Profiling folder.

2. Right-click the Analyses folder and select New Analysis.
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The [Create New Analysis] wizard opens.

3. Start typing time correlation analysis in the filter field, select Time Correlation Analysis and click Next.

4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.
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5. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Finish.

A folder for the newly created analysis is listed under Analysis in the DQ Repository tree view, and the
analysis editor opens on the analysis metadata.

Selecting the columns you want to analyze and setting analysis parameters

1. In the analysis editor and from the Connection list, select the database connection on which to run the
analysis.

The time correlation analysis is possible only on database columns for the time being. You can change your
database connection by selecting another connection from the Connection list. If the analyzed columns do
not exist in the new database connection you want to set, you receive a warning message that enables you
to continue or cancel the operation.

2. Click Select Columns to open the [Column Selection] dialog box and select the columns, or drag them
directly from the DQ Repository tree view into the Analyzed Columns view.

If you right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository view, the selected column will be automatically located under the corresponding connection in
the tree view.
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3.
If required, click  in the Indicators view to open a dialog box where you can set thresholds for each
indicator.

The indicators representing the simple statistics are by-default attached to this type of analysis.

4. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

5. In the Analysis Parameterview and in the Number of connections per analysis field, set the number of
concurrent connections allowed per analysis to the selected database connection, if required.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

6. If you have defined context variables in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

7. Press F6 to execute the column comparison analysis.

The editor switches to the Analysis Results view showing the results.

For detail explanation of the analysis results, see  Exploring the analysis results.

8.3.2.  Exploring the analysis results

Prerequisite(s): A time correlation analysis is defined and executed is the Profiling perspective of the studio.

In the Analysis Results view of the analysis editor:

• Click Graphics, Simple Statistics or Data to show the generated graphic, the number of the analyzed records
or the actual analyzed data respectively.

In the Graphics view, you can clear the check box of the value(s) you want to hide in the chart.
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The Gantt chart displays a range showing the minimal and maximal birth dates for each country listed in the
selected nominal column. It also highlights the range bars that contain null values for birth dates.

For example, in the above chart, the minimal birth date for Mexico is 1910 and the maximal is 2000. And of all
the data records where the country is Mexico, 41 records have null value as birth date.

You can also select a specific birth date range to show if you put the pointer at the start nominal value you want
to show and drag it to the end nominal value you want to show.

From the generated graphic, you can:

• clear the check box of the value(s) you want to hide in the chart,

• place the pointer on any of the range bars to display the correlated data values at that position,

• right-click any of the bars and select:

Option To...

Show in full screen open the generated graphic in a full screen

View rows access a list of all analyzed rows in the selected column

The below figure illustrates an example of the SQL editor listing the correlated data values at the selected range bar.
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From the SQL editor, you can save the executed query and list it under the Libraries > Source Files folders in
the DQ Repository tree view if you click the save icon on the editor toolbar. For more information, see Saving
the queries executed on indicators.

The Simple Statistics view shows the number of the analyzed records falling in certain categories, including the
number of rows, the number of distinct and unique values and the number of duplicates.

The Data view displays the actual analyzed data.

You can sort the data listed in the result table by simply clicking any column header in the table.
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8.4. Nominal correlation analyses
This type of analysis analyzes minimal correlations between nominal columns in the same table and gives the
result in a chart.

In the chart, each column will be represented by a node that has a given color. The correlations between the
nominal values are represented by lines. The thicker the line is, the weaker the association is. Thicker lines can
identify problems or correlations that need special attention. However, you can always inverse edge weight, that
is give larger edge thickness to higher correlation, by selecting the Inverse Edge Weight check box below the
nominal correlation chart.

The correlations in the chart are always pairwise correlations: show associations between pairs of columns.

8.4.1. Creating a nominal correlation analysis

In the example below, you want to create nominal correlation analysis to compute the minimal and maximal birth
dates for each listed country in the selected nominal column. Two columns are used for the analysis: birthdate
and country.

The nominal correlation analysis is possible only on database columns for the time being. You can not use this analysis
on file connections.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio. For further
information, see Connecting to a database.

Defining the analysis

1. In the DQ Repository tree view, expand the Data Profiling folder.

2. Right-click the Analyses folder and select New Analysis.

The [Create New Analysis] wizard opens.
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3. Start typing nominal correlation analysis in the filter field, select Nominal Correlation Analysis and then
click Next.

4. In the Name field, enter a name for the current analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.
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5. Set the analysis metadata (purpose, description and author name) in the corresponding fields and then click
Finish.

A folder for the newly created analysis is listed under Analysis in the DQ Repository tree view, and the
analysis editor opens on the analysis metadata.

Selecting the columns you want to analyze

1. In the analysis editor and from the Connection list, select the database connection on which to run the
analysis.

The nominal correlation analysis is possible only on database columns for the time being. You can change
your database connection by selecting another connection from the Connection list. If the analyzed columns
do not exist in the new database connection you want to set, you receive a warning message that enables you
to continue or cancel the operation.

2. Click Select Columns to open the [Column Selection] dialog box and select the columns you want to analyze,
or drag them directly from the DQ Repository tree view.

If you select too many columns, the analysis result chart will be very difficult to read.

You can right-click any of the listed columns in the Analyzed Columns view and select Show in DQ
Repository viewto locate the selected column under the corresponding connection in the tree view.
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3.
If required, click  in the Indicators view to open a dialog box where you can set thresholds for each
indicator.

The indicators representing the simple statistics are by-default attached to this type of analysis.

4. In the Data Filter view, enter an SQL WHERE clause to filter the data on which to run the analysis, if
required.

5. In the Analysis Parameter view and in the Number of connections per analysis field, set the number of
concurrent connections allowed per analysis to the selected database connection, if required.

You can set this number according to the database available resources, that is the number of concurrent
connections each database can support.

6. If you have defined context variables in the analysis editor:

• use the Data Filter and Analysis Parameter views to set/select context variables to filter data and to
decide the number of concurrent connections per analysis respectively.

• In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis.

For further information about contexts and variables, see Using context variables in analyses.

7. Press F6 to execute the analysis.

The editor switches to the Analysis Results view showing the results.

For detail explanation of the analysis results, see  Exploring the analysis results.

8.4.2.  Exploring the analysis results

Prerequisite(s): A nominal correlation analysis is defined and executed in the Profiling perspective of the studio.

In the Analysis Results view of the analysis editor:
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• Click Graphics, Simple Statistics or Data to show the generated graphic, the number of the analyzed records
or the actual data respectively.

The Graphics view shows the generated graphic for the analyzed columns.

To have a better view of the graphical result of the nominal correlation analysis, right-click the graphic in the
Graphics panel and select Show in full screen.

In the above chart, each value in the country and marital-status columns is represented by a node that has a given
color. Nominal correlation analysis is carried out to see the relationship between the number of married or single
people and the country they live in. Correlations are represented by lines, the thicker the line is, the higher the
association is - if the Inverse Edge Weight check box is selected.

The buttons below the chart help you manage the chart display. The following table describes these buttons and
their usage:

Button Description

Filter Edge Weight Move the slider to the right to (filter out edges with small weight) visualize the more important
edges.

plus and minus Click the [+] or [-] buttons to respectively zoom in and zoom out the chart size.

Reset Click to put the chart back to its initial state.

Inverse Edge Weight By default, the thicker the line is, the weaker the correlation is.

Select this check box to inverse the current edge weight, that is give larger edge thickness to higher
correlation.

Picking Select this check box to be able to pick any node and drag it to anywhere in the chart.

Save Layout Click this button to save the chart layout.

Restore Layout Click this button to restore the chart to its previously saved layout.

The Simple Statistics view shows the number of the analyzed records falling in certain categories, including the
number of rows, the number of distinct and unique values and the number of duplicates.

The Data view displays the actual analyzed data.
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You can sort the data listed in the result table by simply clicking any column header in the table.
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Chapter 9. Extended functionality: patterns
and indicators
This chapter provides detailed information about how to use regular expressions and SQL patterns to analyze and
monitor data in columns. It also explains how to use system and user-defined indicators when analyzing columns.
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9.1. Patterns
Patterns are sets of strings against which you can match the content of the columns to be analyzed.

9.1.1. Pattern types

Two types of patterns are listed under the Patterns folder in the DQ Repository tree view: regular expressions
and SQL patterns.

Regular expressions (regex) are predefined patterns that you can use to search and manipulate text in the databases
to which you connect. You can also create your own regular expressions and use them to analyze columns.

SQL patterns are a kind of personalized patterns that are used in SQL queries. These patterns usually
contain the percent sign (%). For more information on SQL wildcards, see http://www.w3schools.com/SQL/
sql_wildcards.asp.

You can use any of the above two pattern types either with column analyses or with the analyses of a set of columns
(simple table analyses). These pattern-based analyses illustrate the frequencies of various data patterns found in
the values of the analyzed columns. For more information, see Creating a basic analysis on a database columnand
How to create an analysis of a set of columns using patterns.

From the studio, you can generate graphs to represent the results of analyses using patterns. You can also view
tables in the Analysis Results view that write in words the generated graphs. From those graphs and analysis
results you can easily determine the percentage of invalid values based on the listed patterns. For more information,
see Tab panel of the analysis editors.

Management processes for SQL patterns and regular expressions, including those for Java, are the same. For more
information, see Managing regular expressions and SQL patterns.

Some databases do not support regular expressions. To work with such databases, some configuration is necessary before
being able to use regular expressions. For more information, see Managing User-Defined Functions in databases.

9.1.2. Managing User-Defined Functions in databases

The regular expression function is built in several databases, but many other databases do not support it. The
databases that natively support regular expressions include: MySQL, PostgreSQL, Oracle 10g, and Ingres while
Microsoft SQL server and Netezza do not, for example.

A different case is when the regular expression function is built in the database but the query template of the
regular expression indicator is not defined.

From Profiling perspective of the studio, you can:

• extend the functionality of certain database servers to support the regular expression function. For more
information, see How to declare a User-Defined Function in a specific database.

• define the query template for a database that supports the regular expression function. For more information,
see How to define a query template for a specific database.

To learn more about using regular expressions with Teradata, see the documentation on Talend Help Center
(https://help.talend.com).

For information about using regular expressions with Netezza, see What you need to know about some databases.

http://www.w3schools.com/SQL/sql_wildcards.asp
http://www.w3schools.com/SQL/sql_wildcards.asp
https://help.talend.com
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9.1.2.1. How to declare a User-Defined Function in a specific
database

The regular expression function is not built into all different database environments. If you want to use the studio to
analyze columns against regular expressions in databases that do not natively support regular expressions, you can:

Either:

1. Install the relevant regular expressions libraries on the database. For an example of creating a regular
expression function on a database, see Regular expressions on SQL Server.

2. Create a query template for the database in the studio. For more information, see How to define a query
template for a specific database.

Or:

• Execute the column analysis using the Java engine. In this case, the system will use the Java regular
expressions to analyze the specified column(s) and not SQL regular expressions. For more information on
the Java engine, see Using the Java or the SQL engine.

9.1.2.2. How to define a query template for a specific database

A query template defines the query logic required to analyze columns against regular expressions. The steps to
define a query template in the studio include the following:

• Create a query template for a specific database,

• Set the database-specific regular expression if this expression is not simple enough to be used with all databases.

The below example shows how to define a query template specific for the Microsoft SQL Server database. Regular
expressions on SQL Server gives a detailed example on how to create a user-defined regular expression function
on an SQL server.

To define a query template for a specific database, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Expand System Indicators > Pattern Matching.
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3. Double-click Regular Expression Matching, or right-click it and select Open from the contextual menu.

The corresponding view is displayed to show the indicator metadata and its definition.

You need now to add to the list of databases the database for which you want to define a query template. This
query template will compute the regular expression matching.

4. Click the [+] button at the bottom of the Indicator Definition view to add a field for the new template.

5. In the new field, click the arrow and select the database for which you want to define the template. In this
example, select Ingres.

6. Copy the indicator definition of any of the other databases.

7. Click the Edit... button next to the new field.

The [Edit expression] dialog box is displayed.
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8. Paste the indicator definition (template) in the Expression box and then modify the text after WHEN in order
to adapt the template to the selected database. In this example, replace the text after WHEN with WHEN REGEX.

9. Click OK. The new template is displayed in the field.

10. Click the save icon on top of the editor to save your changes.

You have finalized creating the query template specific for the Ingres database. You can now start analyzing the
columns in this database against regular expressions.

If the regular expression you want to use to analyze data on this server is simple enough to be used with all
databases, you can start your column analyses immediately. If not, you must edit the definition of the regular
expression to work with this specific database, Ingres in this example.

If an analysis with a user-defined indicator runs successfully at least one time and later the indicator definition
template for the database is deleted, the analysis does not fail. It keeps running successfully because it uses the
previously generated SQL query.

For more information on how to set the database-specific regular expression definition, see How to edit a regular
expression or an SQL pattern and How to duplicate a regular expression or an SQL pattern.

9.1.2.3. How to edit a query template

You can edit the query template you create for a specific database.

To edit a query template for a specific database, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Expand System Indicator > Pattern Matching.
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3. Double-click Regular Expression Matching, or right-click it and select Open from the contextual menu.

The corresponding view is displayed to show the indicator metadata and its definition.

4.
Click the  button next to the database for which you want to edit the query template.

The [Edit expression] dialog box is displayed.
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5. In the Expression  area, edit the regular expression template as required and then click OK to close the dialog
box and proceed to the next step.

The regular expression template is modified accordingly.

9.1.2.4. How to delete a query template

You can delete the query template you create for a specific database.

To delete a query template for a specific database, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Expand System Indicators > Pattern Matching.
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3. Double-click Regular Expression Matching, or right-click it and select Open from the contextual menu.

The corresponding view is displayed to show the indicator metadata and its definition.

4.
Click the  button next to the database for which you want to delete the query template.

The selected query template is deleted from the list in the Indicator definition view.

9.1.3. Adding regular expressions and SQL patterns to
column analyses

You can use regular expressions and SQL patterns in column analyses in order to check all existing data in
the analyzed columns against these expressions and patterns. For more information, see How to add a regular
expression or an SQL pattern to a column analysis.

You can also edit the regular expression or SQL pattern parameters after attaching it to a column analysis. For
more information, see How to edit a pattern in the column analysis.

After the execution of the column analysis that uses a specific expression or pattern, you can:

• access a list of all valid/invalid data in the analyzed column. For more information, see How to view the data
analyzed against patterns.

9.1.4. Managing regular expressions and SQL patterns

The management procedures of regular expressions and SQL patterns include operations like creating, testing,
duplicating, importing and exporting.



Managing regular expressions and SQL patterns

Talend Open Studio for Data Quality User Guide 221

The sections below explain in detail each of the management option for regular expressions and SQL patterns.
Management processes for both types of patterns are exactly the same.

9.1.4.1. How to create a new regular expression or SQL pattern

You can create new regular expressions or SQL patterns, including those for Java to be used in column analyses.

Management processes for regular expressions and SQL patterns are the same. The procedure below with all the included
screen captures reflect the steps to create a regular expression. You can follow the same steps to create an SQL pattern.

To create a new pattern, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns, and then right-click Regex.

2. From the contextual menu, select New Regex Pattern to open the corresponding wizard.
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When you open the wizard, a help panel automatically opens with the wizard. This help panel guides you
through the steps of creating new regular patterns.

3. In the Name field, enter a name for this new regular expression.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

4. If required, set other metadata (purpose, description and author name) in the corresponding fields and click
Next.

5. In the Regular expression field, enter the definition of the regular expression to be created. The regular
expression must be surrounded by single quotes.
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For the PostgreSQL database, regular expressions are not compatible among the database different versions.

If you want to use the regular expression with PostgreSQL version 9.1 or greater, you must either:

• in the PostgreSQL database configuration, set the standard_conforming_strings parameter to off and write
double backslashes in the definition, or

• in the Regular expression field in the wizard, use a single backslash in the expression definition.

For further information about PostgreSQL regular expressions, select Window > Show View, expand Help and then
select Bookmarks.

6. From the Language Selection list, select the language (a specific database or Java).

7. Click Finish to close the dialog box.

A subfolder for this new regular expression is listed under the Regex folder in the DQ Repository tree view,
and the pattern editor opens with the defined metadata and the defined regular expression.
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8. In the Pattern Definition view, click the [+] button and add as many regular expressions as necessary in
the new pattern.

You can define the regular expressions specific to any of the available databases or specific to Java.

If the regular expression is simple enough to be used in all databases, select Default from the list.

Subfolders labeled with the specified database types or Java are listed below the name of the new pattern
under the Patterns folder in the DQ Repository tree view.

9. Save the new pattern.

Once the pattern is created, you can drop it directly onto a database column in the open analysis editor.

10. If required, click the pattern name to display its detail in the Detail View in the Studio.

In the pattern editor, you can click Test next to the regular expression to test the regular pattern definition. For more
information, see How to test a regular expression in the Pattern Test View. Also, from the [Pattern Test View], you
can create a new pattern based on the regular expression you are testing. For further information, see How to create
a new pattern from the Pattern Test View .

9.1.4.2. How to test a regular expression in the Pattern Test View

It is possible to test character sequences against a predefined or newly created regular expression.

Prerequisite(s): At least one database connection is set in the Profiling perspective of the studio.

To test a character sequence against a regular expression, do the following:

1. Follow the steps outlined in How to create a new regular expression or SQL pattern to create a new regular
expression.

2. In the open pattern editor, click Pattern Definition to open the relevant view.
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3. Click the Test button next to the definition against which you want to test a character sequence to proceed
to the next step.

The test view is displayed in the Studio showing the selected regular expression.

4. In the Test Area, enter the character sequence you want to check against the regular expression

5. From the DB Connection list, select the database in which you want to use the regular expression.

If you select to test a regular expression in Java, the Java option will be selected by default and the DB Connections
option and list will be unavailable in the test view.

6. Click Test.

An icon is displayed in the upper left corner of the view to indicate if the character sequence matches or does
not match the selected pattern definition.

7. If required, modify the regular expression according to your needs and then click Save to save your
modifications.

The pattern definition is modified accordingly in the pattern editor.

You can create/modify patterns directly from the Pattern Test View via the Create Pattern button. For further information,
see How to create a new pattern from the Pattern Test View
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9.1.4.3. How to create a new pattern from the Pattern Test View

You can create your own customized patterns from the [Pattern Test View]. The advantage of creating a pattern
from this view is that you can create your customized pattern based on an already tested regular expression. All
you need to do is to customize the expression definition according to your needs before saving the new pattern.

To create a new pattern based on a predefined or a newly created regular expression, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns > Regex and double-click the pattern you
want to use to create your customized pattern.

The pattern editor opens in the studio.

2. Click Test next to the definition you want to use as a base to create the new pattern.

The [Pattern Test View] is opened on the definition of the selected regular expression.
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3. If required, test the regular expression through entering text in the Test Area. For further information, see
How to test a regular expression in the Pattern Test View.

4. Click Create Pattern to open the [New Regex pattern] wizard.

5. In the Name field, enter a name for this new regular expression.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

6. If required, set other metadata (purpose, description and author name) in the corresponding fields and click
Next to proceed to the next step.

The definition of the initial regular expression is already listed in the Regular expression field.
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7. Customize the syntax of the initial regular expression according to your needs. The regular expression
definition must be surrounded by single quotes.

For the PostgreSQL database, regular expressions are not compatible among the database different versions.

If you want to use the regular expression with PostgreSQL version 9.1 or greater, you must either:

• in the PostgreSQL database configuration, set the standard_conforming_strings parameter to off and write
double backslashes in the definition, or

• in the Regular expression field in the wizard, use a single backslash in the expression definition.

For further information about PostgreSQL regular expressions, select Window > Show View, expand Help and then
select Bookmarks.

8. From the Language Selection list, select the database in which you want to use the new regular expression.

9. Click Finish to close the wizard.

A subfolder for the new pattern is listed under the Regex folder in the same file of the initial regular pattern.
The pattern editor opens on the pattern metadata and pattern definition.

9.1.4.4. How to generate a regular expression from the Date
Pattern Frequency

You can generate a regular pattern from the results of an analysis that uses the Date Pattern Frequency indicator
on a date column.

Prerequisite(s): In the Profiling perspective of the studio, a column analysis is created on a date column using
the Date Pattern Frequency indicator.

To be able to use the Date Pattern Frequency indicator on date columns, you must set the execution engine to Java in the
Analysis Parameter view of the column analysis editor. For more information on execution engines, see Using the Java
or the SQL engine.

For more information on how to create a column analysis, see Creating a basic analysis on a database column.

To generate a regular expression from the results of a column analysis, do the following:

1. In the DQ Repository tree view, right-click the column analysis that uses the date indicator on a date column.
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2. Select Open from the contextual menu to open the corresponding analysis editor.

3. Press F6 to execute the analysis and display the analysis results in the Analysis Results view of the editor.

4.

In this example, 100.00% of the date values follow the pattern yyyy MM dd and 39.41% follow the pattern
yyyy dd MM.

5. Right-click the date value for which you want to generate a regular expression and select Generate Regex
Pattern from the contextual menu.

The [New Regex Pattern] dialog box is displayed.
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6. Click Next.

The date regular expression is already defined in the corresponding field.

7. Click Finish to proceed to the next step.

The pattern editor opens with the defined metadata and the generated pattern definition.
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The new regular expression is listed under Pattern > Regex in the DQ Repository tree view. You can drag
it onto any date column in the analysis editor.

8. If required, click the Test button to test a character sequence against this date regular expression as outlined
in How to test a regular expression in the Pattern Test View.

9.1.4.5. How to edit a regular expression or an SQL pattern

You can open the editor of any regular expression or SQL pattern to check its settings and/or edit its definition
in order to:

• adapt it to a specific database type, or

• adapt it to a specific use.

To open/edit a regular expression or an SQL pattern, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns.

2. Browse through the regular expression or SQL pattern lists to reach the expression or pattern you want to
open/edit.

3. Right-click its name and select Open from the contextual menu.

The pattern editor opens displaying the regular expression or SQL pattern settings.
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4. Modify the pattern metadata, if required, and then click Pattern Definition to display the relevant view. In
this view, you can: edit pattern definition, change the selected database and add other patterns specific to
available databases through the [+] button.

For the PostgreSQL database, regular expressions are not compatible among the database different versions.

If you want to use the regular expression with PostgreSQL version 9.1 or greater, you must either:

• in the PostgreSQL database configuration, set the standard_conforming_strings parameter to off and write
double backslashes in the definition, or

• in the Regular expression field in the wizard, use a single backslash in the expression definition.

For further information about PostgreSQL regular expressions, select Window > Show View, expand Help and then
select Bookmarks.

5. If the regular expression or SQL pattern is simple enough to be used in all databases, select Default in the list.

6. Click the save icon on top of the editor to save your changes.

You can test regular expressions before start using them against data in the specified database. For more information, see
How to test a regular expression in the Pattern Test View.

When you edit a regular expression or an SQL pattern, make sure that your modifications are suitable for all the analyses
that may be using this regular expression or SQL pattern.

9.1.4.6. How to export regular expressions or SQL patterns

You can export regular expressions or SQL patterns from your current version of the studio to Talend Exchange
where they are saved as .xmi files. Other users can then import these patterns from the exchange server into their
studios and use them in their analyses.

You can also export regular expressions and SQL patterns and store them locally in a csv file. For more information
about the content lay out of the csv file, see How to import regular expressions or SQL patterns .



Managing regular expressions and SQL patterns

Talend Open Studio for Data Quality User Guide 233

Management processes for regular expressions and SQL patterns are the same. The procedure below with all the included
screen captures reflect the steps to export regular expressions. You can follow the same steps to export SQL patterns.

How to export regular expressions or SQL patterns to Talend Exchange

You can export regular expressions or SQL patterns from your current version of studio to Talend Exchange
where you can share them with other users. The exported patterns are saved as .xmi files on the exchange server.

Patterns will be exported with the exact path they have in the initial repository. When users import them from
Talend Exchange into the repository of their studios, these patterns will be imported under the same folder or
subfolders they had in the initial repository.

The below procedure uses regular expressions as an example. You can follow the same steps to export SQL
patterns.

To export regular expressions to Talend Exchange, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns.

2. Right-click Regex and select Export for Talend Exchange.

The [Export for Talend Exchange] wizard is displayed.

3. Browse to the folder where to save the regular expressions.

4. Click Select All to select all the regular expressions in the list or select the check boxes of the regular
expressions you want to export to the specified folder.

Select the Browse check box to list only the patterns you want to export.
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5. Click Finish.

The .xmi file of each selected pattern is saved as a zip file in the defined folder.

6. Upload the zip files to Talend Exchange at https://exchange.talend.com/. Please create an account on the
Talend Exchange server if you do not have one already.

To export a single regular expression family to Talend Exchange, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns, and then browse to the regular expression
you want to export.

2. Right-click it and then select Export for Talend Exchange from the contextual menu.

The [Export for Talend Exchange] wizard opens.

https://exchange.talend.com/
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3. Click Select All to select all the regular expressions in the list, or select the check boxes of the regular
expressions or SQL patterns you want to export to the folder.

4. Click Finish to close the wizard.

The .xmi file of each selected pattern is saved as a zip file in the defined folder.

5. Upload the zip files to Talend Exchange at https://exchange.talend.com/. Please create an account on the
Talend Exchange server if you do not have one already.

Patterns are uploaded to Talend Exchange as .xmi files.

When users import these .xmi files from Talend Exchange into the repository of their studios, the patterns are
imported under the same family subfolder, and thus have the path they had in the initial repository.

How to export regular expressions or SQL patterns to a csv file

To export regular expressions to a csv file, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns, and then right-click Regex.

2. From the contextual menu, select Export Patterns.

The [Export Patterns] wizard opens.

https://exchange.talend.com/
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3. Browse to the csv file where to save the regular expressions.

4. Click Select All to select all listed regular expressions or select the check boxes of the regular expressions
you want to export to the csv file.

5. Click Finish to close the wizard.

All exported regular expressions are saved in the defined csv file.

When users try to import these regular expressions from the csv file into the repository of their studios,
the regular expressions will be imported under the Regex folder, and thus have the same path in the new
repository.

To export a single regular expression family to a csv file, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns, and then browse to the regular expression
family you want to export.
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2. From the contextual menu, select Export Patterns.

The [Export Patterns] wizard opens.
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3. Click Select All to select all the check boxes of the regular expressions or select the check boxes of the regular
expressions you want to export to the csv file.

4. Click Finish to close the wizard.

All exported regular expressions are saved in the defined csv file.

When users try to import these regular expressions from the csv file into the repository of their studios, the regular
expressions will be imported under the same subfolder, and thus have in the new repository the same path they
had in the initial repository.

9.1.4.7. How to import regular expressions or SQL patterns

You can import regular expressions or SQL patterns from Talend Exchange into your studio and use them on
analyses. This way you can share all the patterns created by other users and stored on the exchange server.

You can also import the regular expressions or SQL patterns stored locally in a csv file. The csv file must have
specific columns including the ones listed in the table below. The csv file may contain only a few of them.

Column name Description

Label the label of the pattern (must not be empty)

Purpose the purpose of the pattern (can be empty)

Description the description of the pattern (can be empty)

Author the author of the regular expression (can be empty)

Relative Path the relative path to the root folder (can be empty)
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Column name Description

All_ DB_Regexp the regular expression applicable to all databases (can be empty)

<database name>_Regexp the regular expression applicable to this specific databases (can be empty)

How to import regular expressions or SQL patterns from Talend Exchange

You can import the .xmi files of regular expressions or SQL patterns from Talend Exchange into the repository
of your current studio and use them to analyze columns.

You can import only versions that are compatible with the version of your current studio.

Prerequisite(s): Your network is up and running.

The below procedure uses SQL patterns as an example. You can follow the same steps to import regular
expressions.

To import SQL patterns from Talend Exchange, do the following:

1. In the DQ Repository tree view, expand Libraries > Exchange.

If you have connection problems, you will not have access to any of the items under the Exchange node. A
pop-up will prompt you to check your internet connection.

2. Under Exchange, expand SQL and right-click the name of the pattern you want to import.

3. Select Import in DQ Repository.

The [Import From Talend Exchange] wizard opens.
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You will have access only to versions that are compatible with the version of your current studio.

4. Select the Overwrite existing items check box if some error and warning messages are listed in the Error
and Warning area.

This means that a pattern with the same name already exists in the current studio. The imported pattern will
replace the one in the studio.

5. Click Finish.

A progress information bar is displayed. The pattern is listed under the Patterns > SQL folder in the DQ
Repository tree view.

The patterns you import in your studio will be imported with the structure they had in the initial repository.
They will be imported under the same folder or subfolder they had initially.

How to import regular expressions or SQL patterns from a csv file

Prerequisite(s): The csv file is stored locally.

To import regular expressions from a csv file, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns.

2. Right-click Regex and select Import patterns.

The [Import Patterns] wizard opens.
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3. Browse to the csv file holding the regular expressions.

4. In the Duplicate patterns handling area, select:

Option To...

skip existing patterns import only the regular expressions that do not exist in the corresponding lists in the DQ
Repository tree view. A warning message is displayed if the imported patterns already
exist under the Patterns folder.

rename new patterns with suffix identify each of the imported regular expressions with a suffix. All regular expression
will be imported even if they already exist under the Patterns folder.

5. Click Finish.

A confirmation message is displayed.

6. Click OK.

All imported regular expressions are listed under the Regex folder in the DQ Repository tree view.

The regular expressions are imported under the same folders or subfolders they had in the initial repository.

A warning icon  next to the name of the imported regular expression or SQL pattern in the tree view identifies that it is
not correct. You must open the expression or the pattern and try to figure out what is wrong. Usually, problems come from
missing quotes. Check your regular expressions and SQL patterns and ensure that they are encapsulated in single quotes.

9.1.4.8. How to duplicate a regular expression or an SQL pattern

To avoid creating a regular expression or an SQL pattern from scratch, you can duplicate an existing one and work
around its metadata and definition to have a new regular expression or SQL pattern to be used in data profiling
analyses.

To duplicate a regular expression or an SQL pattern, do the following:
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1. In the DQ Repository tree view, expand Libraries > patterns.

2. Browse through the regular expression/SQL pattern lists to reach the expression/pattern you want to duplicate.

3. Right-click its name and select Duplicate... from the contextual menu.

The duplicated regular expression/SQL pattern is displayed under the Regex/SQL folder in the DQ
Repository tree view.

You can now double-click the duplicated pattern to modify its metadata and/or definition as needed.

For the PostgreSQL database, regular expressions are not compatible among the database different versions.

If you want to use the regular expression with PostgreSQL version 9.1 or greater, you must either:

• in the PostgreSQL database configuration, set the standard_conforming_strings parameter to off and write double
backslashes in the definition, or

• in the Regular expression field in the wizard, use a single backslash in the expression definition.

For further information about PostgreSQL regular expressions, select Window > Show View, expand Help and then select
Bookmarks.

You can test new regular expressions before start using them against data in the specified database. For more
information, see How to test a regular expression in the Pattern Test View.

9.1.4.9. How to delete a regular expression or an SQL pattern

You can delete regular expressions or SQL patterns directly from the Analyzed Columns view or from the DQ
Repository tree view.

How to delete a regular expression or an SQL pattern from the analyzed
column

A column analysis is open in the analysis editor.

To delete a regular expression or an SQL pattern from the analyzed column, do the following:

1. Click Analyze Columns to display the analyzed columns view.

2. Right-click the regular expression/SQL pattern you want to delete and select Remove Elements from the
contextual menu.
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The selected regular expression/SQL pattern disappears from the Analyzed Column list.

How to delete and restore a regular expression or an SQL pattern

To delete a regular expression or an SQL pattern from the DQ Repository tree view, do the following:

1. In the DQ Repository tree view, expand Libraries > Patterns.

2. Browse to the regular expression or SQL pattern you want to remove from the list.

3. Right-click the expression or pattern and select Delete from the contextual menu.

The regular expression or SQL pattern is moved to the Recycle Bin.

To delete it from the Recycle Bin, do the following:

1. Right-click it in the Recycle Bin and choose Delete from the contextual menu.

If it is not used by any analysis in the current Studio, a [Delete forever] dialog box is displayed.

2. Click Yes to confirm the operation and close the dialog box.

If it is used by one or more analyses in the current Studio, a dialog box is displayed to list all the analyses
that use the pattern.
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3. Either:

• Click OK to close the dialog box without deleting the pattern from the recycle bin.

• Select the Force to delete all the dependencies check box and then click OK to delete the pattern from
the recycle bin and to delete all the dependent analyses from the Data Profiling node.

You can also delete the pattern permanently by emptying the recycle bin. To empty the Recycle Bin, do the
following:

1. Right-click the Recycle Bin and select Empty recycle bin.

If the pattern is not used by any analysis in the current Studio, a confirmation dialog box is displayed.

2. Click Yes to empty the recycle bin.

If the pattern is used by one or more analyses in the current Studio, a dialog box is displayed to list all the
analyses that use the pattern.

3. Click OK to close the dialog box without removing the pattern from the recycle bin.

To restore a pattern from the Recycle Bin, do the following:

• In the Recycle Bin, right-click the pattern and select Restore.

The pattern is moved back to the Libraries node.
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9.2. Indicators
Indicators can be the results achieved through the implementation of different patterns that are used to define the
content, structure and quality of your data.

Indicators represent as well the results of highly complex analyses related not only to data-matching, but also to
different other data-related operations.

9.2.1. Indicator types

Two types of indicators are listed under the Indicators folder in the DQ Repository tree view: system indicators
and user-defined indicators.

User-defined indicators, as their name indicates, are indicators created by the user. You can use them through a
simple drag-and-drop operation from the User Defined Indicators folder in the tree view. User-defined indicators
are used only with column analyses. For more information on how to set user-defined indicators for columns, see
How to set user-defined indicators from the analysis editor.

System indicators are predefined indicators grouped under different categories in the System Indicators folder in
the DQ Repository tree view. Each category of the system indicators is used with a corresponding analysis type.

You can not create a system indicator or drag it directly from the DQ Repository tree view to an analysis. However,
you can open and modify the parameters of a system indicator to adapt it to a specific database for example. For
further information, see How to edit a system indicator.

Only system indicators you can modify are listed under the System Indicators folder in the DQ Repository tree
view. However, the [Indicator Selection] dialog box lists all indicators including the system indicators you can
not modify, such as Date pattern frequency.

Several management options including editing, duplicating, importing and exporting are possible for system
and user-defined indicators. For more information, see Managing user-defined indicators and Managing system
indicators.

The following sections to follow describe the system indicators used only on column analyses. These system
indicators can range from simple or advanced statistics to text strings analysis, including summary data and
statistical distributions of records.

9.2.1.1. Advanced statistics

They determine the most probable and the most frequent values and builds frequency tables. The main advanced
statistics include the following values:

• Mode: computes the most probable value. For numerical data or continuous data, you can set bins in the
parameters of this indicator. It is different from the "average" and the "median". It is good for addressing
categorical attributes.

• Value Frequency: computes the number of most frequent values for each distinct record.

• All other Value Frequency indicators are available to aggregate date and numerical data (with respect to "date",
"week", "month", "quarter", "year" and "bin").

• Value Low Frequency: computes the number of less frequent records for each distinct record.
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• All other Value Low Frequency indicators are available to aggregate date and numerical data (with respect
to "date", "week", "month", "quarter", "year" and "bin"), where "bin" is the aggregation of numerical data by
intervals.

9.2.1.2. Fraud Detection

The Benford Law indicator (first-digit law) is based on examining the actual frequency of the digits 1 through 9
in numerical data. It is usually used as an indicator of accounting and expenses fraud in lists or tables.

Benford's law states that in lists and tables the digit 1 tends to occur as a leading digit about 30% of the time.
Larger digits occur as the leading digits with lower frequency, for example the digit 2 about 17%, the digit 3
about 12% and so on. Valid, unaltered data will follow this expected frequency. A simple comparison of first-
digit frequency distribution from the data you analyze with the expected distribution according to Benford's law
ought to show up any anomalous results.

For example, let's assume an employee has committed fraud by creating and sending payments to a fictitious
vendor. Since the amounts of these fictitious payments are made up rather than occurring naturally, the leading
digit distribution of all fictitious and valid transactions (mixed together) will no longer follow Benford's law.
Furthermore, assume many of these fraudulent payments have 2 as the leading digit, such as 29, 232 or 2,187. By
using the Benford Law indicator to analyze such data, you should see the amounts that have the leading digit 2
occur more frequently than the usual occurrence pattern of 17%.

When using the Benford Law indicator, it is advised to:

• make sure that the numerical data you analyze do not start with 0 as Benford's law expects the leading digit
to range only from 1 to 9. This can be verified by using the number > Integer values pattern on the column
you analyze.

• check the order of magnitude of the data either by selecting the min and max value indicators or by using the
Order of Magnitude indicator you can import from Talend Exchange. This is because Benford's law tends to
be most accurate when values are distributed across multiple orders of magnitude. For further information about
importing indicators from Talend Exchange, see How to import user-defined indicators from Talend Exchange.

In the result chart of the Benford Law indicator, digits 1 through 9 are represented by bars and the height of the
bar is the percentage of the first-digit frequency distribution of the analyzed data. The dots represent the expected
first-digit frequency distribution according to Benford's law.

Below is an example of the results of an analysis after using the Benford Law indicator and the Order of
Magnitude user-defined indicator on a total_sales column.
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The first chart shows that the analyzed data varies over 5 orders of magnitude, that is there are 5 digits between
the minimal value and maximal value of the numerical column.

The second chart shows that the actual distribution of the data (height of bars) does not follow the Benford's law
(dot values). The differences are very big between the frequency distribution of the sales figures and the expected
distribution according to Benford's law. For example, the usual occurrence pattern for sales figures that start with
1 is 30% and those figures in the analyzed data represent only 20%. Some fraud could be suspected here, sales
figures may have been modified by someone or some data may be missing.

Below is another example of the result chart of a column analysis after using the Benford Law indicator.

The red bar labeled as invalid means that this percentage of the analyzed data does not start with a digit. And the 0
bar represents the percentage of data that starts with 0. Both cases are not expected when analyzing columns using
the Benford Law indicator and this is why they are represented in red.

For further information about analyzing columns, see Creating a basic analysis on a database column.
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9.2.1.3. Pattern frequency statistics

Indicators in this group determine the most and less frequent patterns.

• Pattern Frequency: computes the number of most frequent records for each distinct pattern.

• Pattern Low Frequency: computes the number of less frequent records for each distinct pattern.

The above two indicators give patterns by converting alpha characters to a and numerics to 9.

• East Asia Pattern Frequency: computes the number of most frequent records for each distinct pattern.

• East Asia Pattern Low Frequency: computes the number of less frequent records for each distinct pattern.

The above two indicators work only with Latin characters and are available only with the Java engine. They are
useful when you want to identify patterns in Asian data.

The above two indicators give patterns by converting Asian characters to letters such as H,K,C and G following
the rules described in the following table:

Character Type Unicode Range Usage

Hiragana \u3040-\u309F H and h replace uppercase and lowercase
characters respectively

Katakana \u30A1-\u30FA K and k replace uppercase and lowercase
characters respectively

Katakana Phonetic Extensions \u31F0-\u31FF k replaces all characters (lowercase characters)

Halfwidth Katakana \uFF66-\uFF9F K and k replace uppercase and lowercase
characters respectively

Fullwidth Latin Numbers \uFF10-\uFF19 9 replaces all ascii digits

Fullwidth Latin Uppercased Letters \uFF21-\uFF3A A replaces all characters

Fullwidth Latin Lowercased Letters \uFF41-\uFF5A a replaces all ascii Latin characters

Kanji CJK Unified Ideographs:

• [4E00-9FCC]

CJK Extension-A:

• [3400-4DB5]

CJK Extension B:

• [20000-2A6D6]

CJK Extension C:

• [2A700-2B734]

CJK Extension D:

• [2B740-2B81D]

CJK Compatibility Ideographs:

• [F900-FA6D]

• [FA70-FAD9]

CJK Compatibility Ideographs
Supplement:

• [2F800-2FA1D]

CJK Radicals / KangXi
Radicals:

C replaces Chinese characters
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• [2F00-2FD5]

CJK Radicals Supplement:

• [2E80-2E99]

• [2E9B-2EF3]

CJK Symbols and Punctuation:

• [3005-3005]

• [3007-3007]

• [3021-3029]

• [3038-303B]

Hangul \uAC00-\uD7AF G replaces Hangul characters

Below is an example of a column analysis using the East Asia Pattern Frequency and East Asia Pattern Low
Frequency indicators on an address column.

The analysis results of the East Asia Pattern Low Frequency indicator will look like the following:
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These results give the number of the least frequent records for each distinct pattern. Some patterns have characters
and numbers, while others have only characters. Patterns also have different lengths, so this shows that the address
is not consistent and you may need to correct and clean it.

9.2.1.4. Phone number statistics

Indicators in this group count phone numbers. They return the count for each phone number format. They validate
the phone formats using the org.talend.libraries.google.libphonumber library.

• Valid phone number count: computes the valid phone numbers.

• Possible phone number count: computes the supposed valid phone numbers.

• Valid region code number count: computes phone numbers with valid region code.

• Invalid region code count. computes phone numbers with invalid region code.

• Well formed national phone number count: computes well formatted national phone numbers.

• Well formed international phone number count: computes the international phone numbers that respect the
international phone format (phone numbers that start with the country code) .

• Well formed E164 phone number count: computes the international phone numbers that respect the international
phone format ( maximum of fifteen digits written with a + prefix.

• Format Phone Number Frequency: shows the results of the phone number count in a pie chart divided into
sectors.

9.2.1.5. Simple statistics

They provide simple statistics on the number of records falling in certain categories including the number of rows,
the number of null values, the number of distinct and unique values, the number of duplicates, or the number of
blank fields.

• Blank Count: counts the number of blank rows. A "blank" is a non null textual data that contains only white
space. Note that Oracle does not distinguish between the empty string and the null value.

• Default Value Count: counts the number of default values.

• Distinct Count: counts the number of distinct values of your column.
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• Duplicate Count: counts the number of values appearing more than once. You have the relation: Duplicate count
+ Unique count = Distinct count. For example, a,a,a,a,b,b,c,d,e => 9 values, 5 distinct values, 3 unique values,
2 duplicate values.

• Null Count: counts the number of null rows.

• Row Count: counts the number of rows.

• Unique Count: counts the number of distinct values with only one occurrence. It is necessarily less or equal
to Distinct counts.

9.2.1.6. Soundex frequency statistics

Indicators in this group use the Soundex algorithm built in the DBMS.

They index records by sounds. This way, records with the same pronunciation (only English pronunciation) are
encoded to the same representation so that they can be matched despite minor differences in spelling.

• Soundex Frequency: computes the number of most frequent distinct records relative to the total number of
records having the same pronunciation.

• Soundex Low Frequency: computes the number of less frequent distinct records relative to the total number of
records having the same pronunciation.

Due to some limitation in Teradata soundex implementation, you may not be able to drill down the results of profiling
Teradata with this indicator. For further information, see the documentation on Talend Help Center (https://help.talend.com).

9.2.1.7. Summary statistics

They perform statistical analyses on numeric data, including the computation of location measures such as the
median and the average, the computation of statistical dispersions such as the inter quartile range and the range.

• Mean: computes the average of the records.

• Median: computes the value separating the higher half of a sample, a population, or a probability distribution
from the lower half.

• Inter quartile range: computes the difference between the third and first quartiles.

• Lower quartile (First quartile): computes the first quartile of data, that is the lowest 25% of data.

• Upper quartile (Third quartile): computes the third quartile of data, that is the highest 25% of data.

• Range: computes the difference between the maximum and minimum values.

When using the summary statistics indicators to profile a DB2 database, analysis results could be slightly different
between Java and SQL engines. This is because indicators are computed differently depending on the database
type, and also Talend uses special functions when working with Java.

9.2.1.8. Text statistics

You can use the text statistics indicators to analyze columns only if their data mining type is set to nominal in the
analysis editor. Otherwise, these statistics will be grayed out in the [Indicator Selection] dialog box. For further
information on the available data mining types, see Data mining types.

https://help.talend.com
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Text statistics analyze the characteristics of textual fields in the columns, including minimum, maximum and
average length.

• Minimal Length: computes the minimal length of a text field.

• Maximal Length: computes the maximal length of a text field.

• Average Length: computes the average length of a field.

Other text indicators are available to count each of the above indicators with null values, with blank values or
with null and blank values.

Null values will be counted as data of 0 length, that is to say the minimal length of null values is 0. This means
that the Minimal Length With Null and the Maximal Length With Null will compute the minimal/maximal
length of a text field including null values.

Blank values will be counted as data of 0 length, that is to say the minimal length of blank values is 0. This means
that the Minimal Length With Blank and the Maximal Length With Blank will compute the minimal/maximal
length of a text field including blank values.

The same will be applied for all average indicators.

The below table gives an example of computing the length of few textual fields in a column using all different
types of text statistic indicators.

Data Current length With blank values With null values With blank
and null values

Brayan 6 6 6 6

Ava 3 3 3 3

" " 1 0 1 0

"" 0 0 0 0

Null - - 0 0

Minimal, Maximal and Average lengths

Minimal length 0 0 0 0

Maximal length 6 6 6 6

Average length 9/4 = 2.25 8/4 = 2 9/5 = 1.8 8/5 = 1.6

9.2.2. Managing system indicators

System indicators are predefined but editable indicators that you can use on analyses. For more information on
the system indicators available in the studio, see Indicator types.

9.2.2.1. How to edit a system indicator

Although system indicators are predefined indicators, you can open their editors to check or to edit their settings
and their definitions in order to adapt them to a specific database version or to a specific need, for example.
However, you can not edit the name of the system indicator.

To edit a system indicator, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators, and then browse through the indicator lists
to reach the indicator you want to modify.

2. Right-click the indicator name and select Open from the contextual menu.
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The indicator editor opens displaying the selected indicator parameters.
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3. Modify the indicator metadata.

You can edit any metadata field of the system indicator except the indicator name which is not editable..

4. Click Indicator Definition.

In this view, you can edit the indicator definition, change the selected database and add other indicators
specific to available databases using the [+] button at the bottom of the editor.

5. Click the save icon on top of the editor to save your changes.

If the indicator is simple enough to be used in all databases, select Default in the database list.

When you edit an indicator, you modify the indicator listed in the DQ Repository tree view. Make sure that your modifications
are suitable for all analyses that may be using the modified indicator.
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9.2.2.2. How to set system indicators and indicator options to
column analyses

You can define system indicators and indicator parameters for columns of database tables that need to be analyzed
or monitored. For more information, see How to set indicators on columns and How to set options for system or
user-defined indicators.

9.2.2.3. How to export or import system indicators

You can export system indicators to folders or archive files and import them again in the studio on the condition
that the export and import operations are done in compatible versions of the Studio. For further information, see
Exporting data profiling items and Importing data profiling items.

9.2.2.4. How to duplicate a system indicator

To avoid creating a system indicator from scratch, you can duplicate an existing one in the indicator list. once the
copy is created, you can work around its metadata to have a new indicator and use it in data profiling analyses.

To duplicate a system indicator, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Browse through the indicator lists to reach the indicator you want to duplicate, right-click its name and select
Duplicate from the contextual menu.

The indicator is duplicated as a user-defined indicator and is displayed under the User Defined Indicators
folder in the DQ Repository tree view.

The indicator category of the duplicated Fraud Detection and Soundex indicators is User Defined Frequency.
Thus, two columns are expected in the result set of the analysis that uses these duplicated indicators, whereas four
columns are expected when using the original system indicators.

To be able use the duplicated Fraud Detection and Soundex indicators in data profiling analyses, you need to
edit the indicator definition or create new indicators. For more information on editing user-defined indicators, see
How to edit a user-defined indicator.
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9.2.3. Managing user-defined indicators

User-defined indicators, as their name indicates, are indicators created by the user himself/herself. You can use
these indicators to analyzed columns through a simple drag-and-drop operation from the DQ Repository tree view
to the columns listed in the editor.

The management options available for user-defined indicators include: create, export and import, edit and
duplicate.

9.2.3.1. How to create SQL user-defined indicators

You can create your own personalized indicators from the studio.

Management processes for user-defined indicators are the same as those for system indicators.

Defining the indicator

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Right-click User Defined Indicators.

3. Select New Indicator from the contextual menu.

The [New Indicator] wizard is displayed.
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4. In the Name field, enter a name for the indicator you want to create.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

If required, set other metadata (purpose, description and author name) in the corresponding fields and click
Finish.

The indicator editor opens displaying the metadata of the user-defined indicator.
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Setting the indicator definition and category

1. Click Indicator Category and select from the list a category for the indicator.

The selected category determines the columns expected in the result set of the analysis that uses the user-
defined indicator.

The table below explains available categories.

Indicator category Description Expected query results

User Defined Match Evaluates the number of data matching a
condition.

The result set should have one row and
two columns. The first column contains the
number of values that match and the second
column the total count.

User Defined Frequency Evaluates the frequency of records using
user-defined indicators for each distinct
record.

The result set should have 0 or more rows
and two columns. The first column contains
a value and the second the frequency (count)
of this value.

User Defined Real Value Evaluates real function of data. The result set should have one row and one
column that contain a real value.

User Defined Count (by-default
category)

Analyzes the quantity of records and returns
a row count.

The result set should have one row and one
column that contain the row count.

2. Click Indicator Definition and then click the [+] button.

3. From the Database list, select a database on which to use the indicator.

If the indicator is simple enough to be used in all databases, select Default in the database list.
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4. Enter the database version in the Version field.

5. Define the SQL statement for the indicator you want to create:

• Click the Edit... button next to the SQL Template field.

The [Edit Expression] dialog box opens.

• In the Indicator Definition view, enter the SQL expression(s) you want to use in matching and analyzing
data. You can drop templates from the templates list to complete the expression.

For example, set the expression to measure the maximal length of the values in a column as shown in the
above capture.

This view may have several input fields, one for each column expected by indicator category. For example,
if you select the User Defined Count category, you will have only a Where Expression field; while if
you select the User Defined Match category, you will have two fields: Matching Expression and Where
Expression.

The SQL expressions are automatically transformed into a complete SQL template in the Full SQL
Template view.
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Also, the SQL expressions are automatically transformed into templates to view rows/values. Different
tabs are available in the dialog box depending on what indicator category is selected.

If you edit the SQL expression(s) in the Indicator Definition view, the templates will be updated
accordingly in the other tabs.

• Use the Reset button to revert all templates according to the content of the Indicator Definition tab.

• Click OK.

The dialog box is closed and the SQL template is displayed in the indicator editor.

• Use the [+] button and follow the same steps to add as many indicator definitions as needed.

You do not need to define any parameters in the Indicator Parameters view when the user-defined indicator
contains only SQL templates. These parameters are used only when indicators have Java implementation. For further
information, see How to define Java user-defined indicators.

6. Click the save icon on top of the editor.

The indicator is listed under the User Defined Indicators folder in the DQ Repository tree view. You can
use this indicator to analyzed columns through a simple drag-and-drop operation from the DQ Repository
tree view to the columns listed in the editor.

If an analysis with a user-defined indicator runs successfully at least one time and later the indicator definition
template for the database is deleted, the analysis does not fail. It keeps running successfully because it uses
the previously generated SQL query.

9.2.3.2. How to define Java user-defined indicators

You can create your own personalized Java indicators from the studio. Management processes for Java user-
defined indicators are the same as those for system indicators.

You can also import a ready-to-use Java user-defined indicator from the Exchange folder in the DQ Repository tree view.
This Java user-defined indicator connects to the mail server and checks if the email exists. For further information on
importing indicators from Talend Exchange, see How to import user-defined indicators from Talend Exchange.

The two sections below detail the procedures to create Java user-defined indicators.
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How to create Java user-defined indicators

Defining the indicator

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Right-click User Defined Indicators.

3. Select New Indicator from the contextual menu.

The [New Indicator] wizard is displayed.
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4. In the Name field, enter a name for the Java indicator you want to create.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.

5. If required, set other metadata (purpose, description and author name) in the corresponding fields and click
Finish.

The indicator editor opens displaying the metadata of the user-defined indicator.

Setting the indicator definition and category

1. Click Indicator Category and select from the list a category for the Java indicator.

The selected category determines the columns expected in the result set of the analysis that uses this indicator.

The table below explains available categories.

Indicator category Description Expected query results

User Defined Match Evaluates the number of data matching a
condition.

The result set should have one row and
two columns. The first column contains the
number of values that match and the second
column the total count.

User Defined Frequency Evaluates the frequency of records using
user-defined indicators for each distinct
record.

The result set should have 0 or more rows
and two columns. The first column contains
a value and the second the frequency (count)
of this value.

User Defined Real Value Evaluates real functions of data. The result set should have one row and one
column that contain a real value.

User Defined Count Analyzes the quantity of records and returns
a row count.

The result set should have one row and one
column that contain the row count.

2. Click Indicator Definition and then click the [+] button.
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3. From the Database list, select Java.

4. Enter the Java class in the Java Class field.

Make sure that the class name includes the package path, if this string parameter is not correctly specified, an error
message will display when you try to save the Java user-defined indicator.

5. Select the Java archive holding the Java class:

• Click the Edit... button.

The [UDI Selector] dialog box opens.

• In the Select libraries view, select the check box of the archive holding the Java class and then select the
class in the bottom panel of the wizard.

• Click OK.

The dialog box is closed and the Java archive is displayed in the indicator editor.

You can add or delete Java archives from the Manage Libraries view of this dialog box.

For more information on creating a Java archive, see How to create a Java archive for the user-defined
indicator.

6. Click Indicator Parameters to open the view where you can define parameters to retrieve parameter values
while coding the Java indicator.
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You can retrieve parameter values with a code similar to this one that retrieves the parameter of EMAIL_PARAM:

// Check prerequisite
        IndicatorParameters param = this.getParameters();
        if (param == null) {
            log.error("No parameter set in the user defined indicator " +
 this.getName()); //$NON-NLS-1$
            return false;
        }
        Domain indicatorValidDomain = param.getIndicatorValidDomain();
        if (indicatorValidDomain == null) {
            log.error("No parameter set in the user defined indicator " +
 this.getName()); //$NON-NLS-1$
            return false;
        }

        // else retrieve email from parameter
        EList<JavaUDIIndicatorParameter> javaUDIIndicatorParameter =
 indicatorValidDomain.getJavaUDIIndicatorParameter();
        for (JavaUDIIndicatorParameter p : javaUDIIndicatorParameter) {
            if (EMAIL_PARAM.equalsIgnoreCase(p.getKey())) {

For a more detailed sample of the use of parameters in a Java user-defined
indicator, check https://github.com/Talend/tdq-studio-se/tree/master/sample/test.myudi/src/main/java/org/
talend/dataquality/indicator/userdefine/email.

7. Click the [+] button at the bottom of the table and define in the new line the parameter key and value.

You can edit these default parameters or even add new parameters any time you use the indicator in a column
analysis. To do this, click the indicator option icon in the analysis editor to open a dialog box where you can
edit the default parameters according to your needs or add new parameters.

8. Click the save icon on top of the editor.

The indicator is listed under the User Defined Indicators folder in the DQ Repository tree view. You can
use this indicator to analyzed columns through a simple drag-and-drop operation from the DQ Repository
tree view to the columns listed in the editor.

How to create a Java archive for the user-defined indicator

Before creating a Java archive for the user defined indicator, you must define, in Eclipse, the target platform
against which the workspace plug-ins will be compiled and tested.

https://github.com/Talend/tdq-studio-se/tree/master/sample/test.myudi/src/main/java/org/talend/dataquality/indicator/userdefine/email
https://github.com/Talend/tdq-studio-se/tree/master/sample/test.myudi/src/main/java/org/talend/dataquality/indicator/userdefine/email
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To define the target platform, do the following:

1. In Eclipse, select Preferences to display the [Preferences] window.

2. Expand Plug-in Development and select Target Platform then click Add... to open a view where you can
create the target definition.
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3. Select the Nothing: Start with an empty target definition option and then click Next to proceed to the
next step.

4. In the Name field, enter a name for the new target definition and then click the Add... button to proceed
to the next step.
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5. Select Installation from the Add Content list and then click Next to proceed to the next step.

6. Use the Browse... button to set the path of the installation directory and then click Next  to proceed to the
next step.

The new target definition is displayed in the location list.
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7. Click Finish to close the dialog box.

To create a Java archive for the user defined indicator, do the following:

1. In Eclipse, check out the project from GIT at https://github.com/Talend/tdq-studio-se/tree/master/sample/
test.myudi.

In this Java project, you can find four Java classes that correspond to the four indicator categories listed in
the Indicator Category view in the indicator editor.

Each one of these Java classes extends the UserDefIndicatorImpl indicator. The figure below illustrates
an example using the MyAvgLength Java class.

package test.udi;

import org.talend.dataquality.indicators.sql.impl.UserDefIndicatorImpl;

/**
 * @author mzhao
 * 
 * A very simple example of a java implementation of a user defined indicator. This
 indicator returns a user defined
 * real value. It implements the minimum number of required methods.

https://github.com/Talend/tdq-studio-se/tree/master/sample/test.myudi
https://github.com/Talend/tdq-studio-se/tree/master/sample/test.myudi
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 */
public class MyAvgLength extends UserDefIndicatorImpl {

    private double length = 0;

    @Override
    public boolean reset() {
        super.reset();
        length = 0;
        return true;
    }

    @Override
    public boolean handle(Object data) {
        super.handle(data);
        // an indicator which computes the average text length on data which are
 more than 2 characters (this means that
        // text values with less than 2 characters are not taken into account).
        int dataLength = (data != null) ? data.toString().length() : 0;
        if (dataLength > 2) {
            length += dataLength;
        }
        return true;
    }

    /*
     * (non-Javadoc)
     * 
     * @see
 org.talend.dataquality.indicators.impl.IndicatorImpl#finalizeComputation()
     */
    @Override
    public boolean finalizeComputation() {
        value = String.valueOf(this.length / (this.getCount() -
 this.getNullCount()));
        return super.finalizeComputation();
    }

}

2. Modify the code of the methods that follow each @Override according to your needs.

3. If required, use the following methods in your code to retrieve the indicator parameters:

4. use Indicator.getParameter() which returns an IndicatorParameters object.

5. call IndicatorParameters.getIndicatorValidDomain() which returns a Domain object.

6. call Domain.getJavaUDIIndicatorParameter() which returns a list of JavaUDIIndicatorParameter
that stores each key/value pair that defines the parameter.

7. Save your modifications.

8. Using Eclipse, export this new Java archive.

The Java archive is now ready to be attached to any Java indicator you want to create in from Profiling perspective
of the studio.

9.2.3.3. How to export user-defined indicators

You can export user-defined indicators to archive files or to Talend Exchange to be shared with other users.
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How to export user-defined indicators to an archive file

You can export user-defined indicators and store them locally in an archive file using the Export Item option on
the studio toolbar. For further information on how to export indicators, see Exporting data profiling items.

How to export user-defined indicators to Talend Exchange

You can export user-defined indicators from your current studio to Talend Exchange where you can share them
with other users.

The exported indicators are saved as .xmi files on the exchange server.

Prerequisite(s):At least one user-defined indicator is created in the Profiling perspective of the studio.

To export user-defined indicators to Talend Exchange, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Right-click the User Defined Indicator folder and select Export for Talend Exchange.

The [Export for Talend Exchange] wizard is displayed.

3. Browse to the folder where to save indicators.

4. Select the check boxes of the indicators you want to export to the specified folder.

Select the Browse check box to list only the indicators you want to export.

5. Click Finish.

The .xmi file of each selected indicator is saved as a zip file in the defined folder.
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6. Upload the zip files to Talend Exchange at https://exchange.talend.com/. Please create an account on the
Talend Exchange server if you do not have one already.

9.2.3.4. How to import user-defined indicators

You can import user-defined indicators from a local archive file or from Talend Exchange into your studio and
use them on your column analyses.

How to import user-defined indicators from an archive file

Using the Import Item option on the studio toolbar, you can import user-defined indicators stored locally in
an archive file and use them on your column analyses. For further information on how to import indicators, see
Importing data profiling items.

A warning icon  next to the name of the imported indicator in the tree view identifies that it is not correct. You
must open the indicator and try to figure out what is wrong.

How to import user-defined indicators from a csv file (deprecated feature)

This section describes a deprecated feature that is still available for use to provide backward compatibility.

You can import indicators stored locally in a csv file to use them on your column analyses.

Prerequisite(s): You have selected the Profiling perspective of the studio. The csv file is stored locally.

To import user-defined indicators from a csv file, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Right-click User Defined Indicators and select Import Indicators.

The [Import Indicators] wizard opens.

https://exchange.talend.com/
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3. Browse to the csv file holding the user-defined indicators.

4. In the Duplicate Indicators handling area, select:

Option To...

skip existing indicators import only the indicators that do not exist in the corresponding lists in the DQ Repository
tree view. A warning message is displayed if the imported indicators already exist under
the Indicators folder.

rename new indicators with suffix identify each of the imported indicators with a suffix. All indicators will be imported even
if they already exist under the Indicators folder.

5. Click Finish.

All imported indicators are listed under the User Defined Indicators folder in the DQ Repository tree view.

A warning icon  next to the name of the imported user-defined indicator in the tree view identifies that it is not correct.
You must open the indicator and try to figure out what is wrong.

How to import user-defined indicators from Talend Exchange

You can import the .xmi files of user-defined indicators created by other users and stored on the Talend Exchange
server into your current studio and use them on your column analyses.

You can import only versions that are compatible with the version of your current studio.
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The indicators you can import from Talend Exchange include for example:

• Order of Magnitude: It computes the number of digits between the minimal value and maximal value of a
numerical column.

• Email validation via mail server: This Java user-defined indicator connects to a mail server and checks if the
email exists.

Prerequisite(s): You have selected the Profiling perspective of the studio. Your network is up and running.

The below procedure shows how to import the Email validation via mail server indicator from the exchange server
into the studio:

1. In the DQ Repository tree view, expand Libraries > Exchange.

If you have connection problems, you will not have access to any of the items under the Exchange node. A
pop-up will prompt you to check your internet connection.

2. Under Exchange, expand indicator and right-click the name of the indicator you want to import, a Java user-
defined indicator in this example.

3. Select Import in DQ Repository.

The [Import From Talend Exchange] wizard opens.
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You will have access only to versions that are compatible with the version of your current studio.

4. Select the Overwrite existing items check box if some error and warning messages are listed in the Error
and Warning area.

This means that an indicator with the same name already exists in the current studio. The imported indicator
will replace the one in the studio.

5. Click Finish.

The user-defined indicator is imported from Talend Exchange and listed under the User Defined Indicators
folder in the DQ Repository tree view.

Before being able to use this indicator on column analyses to check emails by sending an SMTP request to the
mail server, you must define the indicator parameters as the following:

1. Double-click the indicator to open the indicator editor.
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This Java user-defined indicator has three parameters set by default:

• a buffer size that gives the number of invalid email addresses stored in memory before they are saved in
a file.

• a file path to the list of invalid email addresses.

• the email of the sender.

2. Modify the values of the BUFFER SIZE and INVALID DATA FILE according to your needs.

3. In the Parameters Value column, set the value for the EMAIL parameter, that is the address of the sender
on the SMTP server.
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4. Save the indicator.

If you have an error message when running a column analysis with this indicator, please check your email server
configuration.

You can also use the studio to create an SQL user-defined indicator or a Java user-defined indicator from scratch.
For further information, see How to create SQL user-defined indicators and How to define Java user-defined
indicators respectively.

9.2.3.5. How to edit a user-defined indicator

You can open the editor of any system or user-defined indicator to check its settings and/or edit its definition and
metadata in order to adapt it to a specific database type or need, if required.

Prerequisite(s): At least one user-defined indicator is created in the Profiling perspective of the studio.

To edit the definition of a user-defined indicator, do the following:

1. In the DQ Repository tree view, expand Libraries > Indicators > User Defined Indicators, and then browse
through the indicator lists to reach the indicator you want to modify the definition of.

2. Right-click the indicator name and select Open from the contextual menu.

The indicator editor opens displaying the selected indicator settings.

3. Modify the indicator metadata, if required.
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4. Click Indicator Category to open the view and select an indicator category from the list.

The table below describes the different categories.

Indicator category Description

User Defined Match (by-default
category)

Uses user-defined indicators to evaluate the number of the data records that match a
regular expression or an SQL pattern. The analysis results show the record matching count
and the record total count.

User Defined Frequency Uses user-defined indicators for each distinct data record to evaluate the record frequency
that match a regular expression or an SQL pattern. The analysis results show the distinct
count giving a label and a label-related count.

User Defined Real Value Uses user-defined indicators which return real value to evaluate any real function of the
data.

User Defined Count Uses user-defined indicators that return a row count.

If you change the indicator category, you can keep the existing indicator definition or remove the indicator
definitions for all databases but the one for Java.

5. Click Indicator Definition to open the view. Set the indicator definition for one or more databases using
the [+] button.

If the indicator is simple enough to be used in all databases, select Default in the list.

6. Click Indicator Parameter and modify the indicator parameters as needed.

7. To add new default parameters, click the [+] button at the bottom of the table, click in the lines and define
the parameter keys and values.

8. Click the save icon on top of the editor to save your changes.

When you edit an indicator, make sure that your modifications are suitable for all analyses that may be using the modified
indicator.

9.2.3.6. How to duplicate a user-defined indicator

To avoid creating an indicator from scratch, you can duplicate an existing one in the indicator list. Once the copy
is created, you can work around its metadata to have a new indicator and use it in data profiling analyses.

Prerequisite(s): At least one user-defined indicator has been defined in the Profiling perspective of the studio.

To duplicate a user defined indicator, do the following:
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1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Browse through the user-defined indicator lists to reach the indicator you want to duplicate, right-click its
name and select Duplicate... from the contextual menu.

The duplicated indicator is displayed under the User Defined Indicators folder in the DQ Repository tree view.

You can now open the duplicated indicator to modify its metadata and definition as needed. for more information
on editing user-defined indicators, see How to edit a user-defined indicator.

9.2.3.7. How to delete or restore a user-defined indicator

In the studio, you can delete a user-defined indicator definitely or restore it from the Recycle Bin. For details,
refer to How to delete a regular expression or an SQL pattern.

9.2.4. Indicator parameters

This section describes indicator parameters displayed in the different [Indicators Settings] dialog boxes.

Bins Designer

Possible value Description

Minimal value Beginning of the first bin.

Maximal value End of the last bin.

Number of bins Number of bins.

Blank Options

Possible value Description

Aggregate nulls with blanks When selected, null data is counted as zero length text field. This means that null
data is treated as an empty string. When not selected, null data is treated as any other
text data.

Aggregate blanks When selected, blank texts (e.g. " ") are all grouped together and considered as an
empty string. When not selected, blank texts are treated as any other text data.
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Possible value Description

In Oracle, empty strings and null strings are the same objects. Therefore,
you must select or clear both check boxes in order to get consistent results.

Data Thresholds

Possible value Description

Lower threshold Data smaller than this value should not exist.

Upper threshold Data greater than this value should not exist.

Value Frequency Parameters

Possible value Description

Number of results shown Number of displayed results.

Indicator Thresholds

Possible value Description

Lower threshold Lower threshold of matching indicator values.

Upper threshold Higher threshold of matching indicator values.

Lower threshold(%) Lower threshold of matching indicator values in percentage relative to the total row
count.

Upper threshold(%) Higher threshold of matching indicator values in percentage relative to the total row
count.

Expected value Only for the Mode indicator in the Advanced Statistics. Most probable value that
should exist in the selected column.

Java Options

Possible value Description

Characters to replace List of the characters to be replaced.

Replacement characters List of the characters that will take the place of the replaced characters.

Each character of the first field will be replaced by the character at
the same position from the second field. For example, with the values
"abc0123ABC,;.:" in the first field and "aaa9999AAApppp" in the second
field any "a", "b" or "c" will be replaced by "a" and any "0", "1", "2" or "3"
will be replaced by "9".

Phone number

Possible value Description

Country Country ISO2 code of the phone number.

Text Parameters

Possible value Description

Ignore case When selected, comparison of text data is not case sensitive.

Text Length

Possible value Description

Count nulls When selected, null data is counted as zero length text field.

Count blanks When selected, blank texts (e.g. " ") are counted as zero length text fields.
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Chapter 10. Other important management
procedures
This chapter provides the information you need to carry out some basic procedures including setting preferences
of analysis editors and analysis results, creating SQL queries, setting data parser rules, importing/exporting data
quality items and upgrading projects from older versions.
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10.1. Creating and storing SQL queries
From the studio, you can query and browse a selected database using the SQL Editor and then to store these SQL
queries under the Source Files folder in the DQ Repository tree view. You can then open the SQL Editor on any
of these stored queries to rename, edit or execute the query.

To create an SQL query, do the following:

1. In the DQ Repository tree view, expand Libraries.

2. Right-click Source Files and select New SQL File from the contextual menu. The [New SQL File] dialog
box is displayed.

3. In the Name field, enter a name for the SQL query you want to create and then click Finish to proceed to
the next step.

The SQL Editor opens on the new SQL query.

If the Connections view is not open, use the combination Window > Show View > Data Explorer > Connections
to open it.

4. Enter your SQL statement in the SQL Editor.

5. From the Choose Connection list, select the database you want to run the query on.
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6.
On the SQL Editor toolbar, click  to execute the query on the defined base table(s).

Data rows are retrieved from the defined base table(s) and displayed in the editor.

A file for the new SQL query is listed under Source Files in the DQ Repository tree view.
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7. Right-click an SQL file and from the contextual menu select:

Option To...

Open open the selected Query file

Duplicate create a copy of the selected Query file

Rename SQL File open a dialog box where you can edit the name of the query file

Open in Data Explorer open in the data explorer the SQL editor on the selected query file

Delete delete the query file

The deleted item will go to the Recycle Bin in the DQ Repository tree view.
You can restore or delete such item via a right-click on the item. You can also
empty the recycle bin via a right-click on it.

When you open a query file in the SQL Editor, make sure to select the database connection from the Choose Connection
list before executing the query. Otherwise the run icon on the editor toolbar will be unavailable.

When you create or modify a query in a query file in the SQL Editor and try to close the editor, you will be prompted to
save the modifications. The modifications will not be taken into account unless you click the save icon on the editor toolbar.

10.2. Using context variables in analyses
You can use context variables in the analysis editor to filter the data on which to run the analysis, or to decide the
number of concurrent connections to the database allowed by the analysis.

The Profiling perspective of the studio allows you to define multiple contexts for profiling analyses and select
specific context values with which to execute an analysis. You can define context parameters in the analysis editor
to:

• filter data using contexts variables with WHERE clauses and decide the data or tables/columns on which to
run the analysis,

• decide the number of concurrent connections allowed by the analysis.
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You usually set this number according to the database available resources, that is the number of concurrent
connections each database can support.

You can use context variables only when you profile databases. Context variables can not be used when profiling files.

10.2.1. Creating one or multiple contexts for the same
analysis

You can create one or several contexts for a database analysis and select specific context values with which to
execute the analysis. Defining context variables in analysis will enable you to run the analysis on different data
using the same connection.

Prerequisite(s): You have already created a database analysis in the Profiling perspective of the studio.

To define one context for an analysis, do the following:

1. Double-click the database analysis to open the analysis editor.

2. Select Window > Show View > Profiling > Contexts to open the context view in the Profiling perspective.

3. In the Contexts view, click the [+] button at the top right corner to open the [Configure Contexts] dialog box.

A Default context is listed by default.

4. Select the default context and click Edit to rename it, prod in this example. Click OK in both dialog boxes.

The context environment is named accordingly in the table in the Contexts view.

5. Click the [+] button at the bottom of the view to add lines in the table and define the name and values of
the context variables.
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Suppose that you want to profile a postal_code column and you want to analyze only the postal codes that
start with 75. Name the variable where_clause and set the value to postal_code like '75%'.

To define a second context for an analysis, do the following:

1. To add a new context, click the [+] button at the top right corner in the view and then click New... in the
[Configure Contexts] dialog box.

2. Enter a name for the new context, dev in this example, and then click OK.

The legacy of the context selected as default in the context list is copied to the new context which is created
and listed in the dialog box and in the Contexts view.

3. Click in the context table and modify the values of the new context as needed.
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In this example, set the value of the where_clause for the dev context to postal_code like '15%'.

4. Repeat the above three steps to add as many context environments as needed.

10.2.2. Selecting the context with which to run the
analysis

Prerequisite(s): At least one context has been created in the analysis editor. For further information, see Creating
one or multiple contexts for the same analysis.

1. Double-click the analysis to open the analysis editor.

2. In the Data Filter view and in the Where box, either:

• enter the name of the context variable you want to use to run the analysis using context. followed by
the variable name, or

• press Ctrl + space to open the list of context variables created in the Profiling perspective and from which
you can select a variable of your choice.

This list will be empty until you define context variables in the Contexts view in the analysis editor.

In this example, type context.where_clause in the Where box.

You can use only one context variable to run the analysis. Multiple variables are not supported.

3. In the Analysis Parameters view and in the Number of connection per analysis field, either:

• enter the name of the context variable you want to use to run the analysis using context. followed by
the variable name, or

• press Ctrl + space to open the list of context variables.

This list will be empty until you define context variables in the Contexts view in the analysis editor.

For further information about defining context variables, see Creating one or multiple contexts for the same
analysis.

4. In the Context Group Settings view, select from the list the context environment you want to use to run
the analysis, prod for this example.
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The variables of the selected context will show in the table.

All context environments you create in the Contexts view in the analysis editor will be accessible from this
list.

5. Run the analysis.

6. Right-click Row Count in the table and select View rows.
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The SQL Editor opens listing only the data rows where postal code starts with 75.

10.3. Importing data profiling items
You can import data profiling items including analyses, database connections, patterns and indicators, etc. into
you current studio from various projects or different versions of the studio.

You can not import an item without all its dependencies. When you try to import an analysis for example, all its
dependencies such as a metadata connection and the patterns and indicators used in this analysis will be selected
by default and imported with the analysis.

You can not import into your current studio data profiling items created in versions older than 4.0.0. To use such items in
your current studio, you must carry out an upgrade operation. For further information, see Upgrading project items from
older versions.

Prerequisite(s): You have access to the root directory of another studio version in which data profiling items
have been created.

To import one or more data profiling items, do the following:

1. In the Profiling perspective, either:

• Right-click anywhere in the DQ Repository tree view and select Import Items.

•
Click the  icon on the toolbar and select Import Items.
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All editors which are open in the studio are automatically closed. The [Import Item] wizard is displayed.

2. Select the root directory or the archive file option according to whether the data profiling items you want to
import are in the workspace file within the studio directory or are already exported into a zip file.

• If you select the root directory option, click Browse and set the path to the project folder containing the
items to be imported within the workspace file of the studio directory.

All items and their dependencies that do not exist in your current Studio are selected by default in the
dialog box.

• If you select the archive file option, click Browse and set the path to the archive file that holds the data
profiling items you want to import.
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All items and their dependencies that do not exist in your current studio are selected by default in the
dialog box.

3. Select the Overwrite existing items check box if some error and warning messages are listed in the Error
and Warning area.

This means that items with the same names already exist in the current studio.

The imported items will replace the existing ones.

When you import system indicators that are modified in a studio version, they will not overwrite the indicators
in the current studio. All modifications from older versions will be integrated with the system indicators in
the current studio.

4. Select or clear the check boxes of the data profiling items you want or do not want to import according to
your needs.

All dependencies for the selected item are selected by default. When you clear the check box of an item, the
check boxes of the dependencies of this item are automatically cleared as well. Also, an error message will
display on top of the dialog box if you clear the check box of any of the dependencies of the selected item.

5. Click Finish to validate the operation.

The imported items display under the corresponding folders in the DQ Repository tree view.

You can also import local project folders from the login window of your studio. For further information, see
the Getting Started Guide..

6. Do the following to have every item working correctly:

• Run the analyses that have Java as their execution engine. This will compute and store locally the results
of the indicators used in the analyses.

You can not open a list of the indicator results in the Analysis Results view in the current studio without
running the analyses first as data is not imported with them from the old studio.

• Install missing third-party Java libraries or database drivers.

When you import database connections for the first time, warning red icons may be docked on the
connection names. This is because Talend Studio requires specific third-party Java libraries or database
drivers (.jar files) to be installed to connect to sources and targets. Those libraries or drivers, known as
external modules, can be required by some connection wizards. Due to license restrictions, Talend may
not be able to ship certain external modules within the studio.

For more information about identifying and installing external modules, see the Talend Installation and
Upgrade Guide.

• Set the path for the drivers of the SQL Servers (2005 or 2008).

If you import SQL Servers (2005 or 2008) connections into your current studio, a warning red icon is
docked on the connection names in the DB connections folder. This indicates that the driver path for these
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connections is empty. You must open the connection wizard and redefine the connection manually to set
the path to a JDBC driver you can download from the Microsoft download center.

For further information on editing a database connection, see How to open or edit a database connection.

You can also set the path to a JDBC driver for a group of database connections simultaneously in order
not to define them one by one. For further information, see Migrating a group of connections.

10.4. Exporting data profiling items
You can export data profiling items including analyses, database connections, patterns and indicators, etc. from
the current instance of the studio to the root directory of another studio or to archive files.

Prerequisite(s): At least, one data profiling item has been created in the studio.

To export data profiling items, do the following:

1. • Right-click anywhere in the DQ Repository tree view and select Export Items.

•
Click the  icon on the toolbar and select Export Items.

The [Export Item] wizard is displayed.
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2. Select the root directory or archive file option and then click Browse... and browse to the directory/archive
where you want to export the data profiling items.

3. Select the check boxes of the data profiling items you want to export or use the Select All or Deselect All tabs.

When you select an analysis check box, all analysis dependencies including the metadata connection and any
patterns or indicators used in this analysis are selected by default. Otherwise, if you have an error message
on top of the dialog box that indicates any missing dependencies, click the Include dependencies tab to
automatically select the check boxes of all items necessary to the selected data profiling analysis.

4. If required, select the Browse check box to have in the export list only the selected data profiling items.

5. Click Finish to validate the operation.

A progress bar is displayed to indicate the progress of the export operation and the data profiling items are
exported in the defined place.
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10.5. Migrating a group of connections
You can import database connections from various projects or various versions of the Studio.

Some of the migrated JDBC connections may have a warning icon docked on their names in the DB connections
folder in the DQ Repository tree view. This indicates that the driver path for these connections is empty after
migration.

Setting the driver path manually for each of the connections could be tedious especially if you have imported big
number. The studio enables you to set the driver path once for all. You may download such a driver from the
Microsoft download center, for example.

Prerequisite(s): You have already migrated your database connections from an older version of the studio as
outlined in Importing data profiling items.

To migrate a group of connections simultaneously, do the following:

1. In the menu bar, select Window > Preferences to display the [Preferences] window.

2. In the search field, type jdbc and then select JDBC Driver Setting to open the corresponding view.

3. Set the JDBC parameters in the corresponding fields, and then click Apply to connections....

A dialog box is displayed to list all the JDBC connections that do not have the required JDBC driver after
migration.

4. Select the check boxes of the connections for which you want to apply the driver settings and then click OK.

A confirmation message is displayed.

5. Click OK to close the confirmation message.
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6. In the [Preferences] window, click OK.

A confirmation message is displayed.

7. Click OK to close the message and the [Preferences] window.

10.6. Upgrading project items from older
versions

The below procedure concerns only the migration of data profiling items from versions older than 4.0.0. To migrate your
data profiling items from version 4.0.0 onward, you simply need to import them into your current Studio . For further
information, see Importing data profiling items.

To migrate data profiling items (analyses, database connections, patterns and indicators, etc.) created in versions
older than 4.0.0, do the following:

1. From the folder of the old version studio, copy the workspace file and paste it in the folder of your current
Studio. Accept to replace the current workspace file with the old file.

2. Launch the Studio connecting to this workspace.

The upgrade operation is completed once the Studio is completely launched, and you should have access to all
your data profiling items.

Regarding system indicators during migration, please pay attention to the following:

• When you upgrade the repository items to version 4.2 from a prior version, the migration process overwrites any changes
you made to the system indicators.

• When you upgrade the repository items from version 4.2 to version 5.0 onward, you do not lose any changes you made
to the system indicators, the changes are merged.
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Chapter 11. Managing analyses
This chapter provides the information you need to perform basic management procedures for all analysis created
in the Profiling perspective of Talend Studio.
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11.1. Procedures for all types of analyses
The procedures below provide detailed information on basic management options for all types of the analyses
listed under the Analyses folder in the DQ Repository tree view.

From the contextual menu of the selected analysis, you can open, execute, duplicate or delete this analysis. You
can also add a task to the selected analysis.

11.1.1. Opening an analysis

Prerequisite(s): At least one analysis has been created in the Profiling perspective of the studio.

To open an analysis, do the following:

1. In the DQ Repository tree view, expand Data Profiling > Analyses.

2. Either:

• double-click the analysis you want to open, or,

• right-click the analysis you want to open and select Open from the contextual menu.

The corresponding analysis editor is displayed.

3. If required, click Refresh the graphics to the right of the editor to display the results of the analysis.

4. If required, click the Analysis results button at the bottom of the editor to open a more detailed view of the
analysis results.

11.1.2. Executing an analysis without opening the
analysis editor

Prerequisite(s): At least one analysis has been created in the Profiling perspective of the studio.

To execute an analysis without opening the analysis editor, do the following:

1. In the DQ Repository tree view, expand Data Profiling > Analyses.

2. Right-click the analysis you want to execute and select Run from the contextual menu.

A message is displayed on the status bar showing execution progress and the analysis is executed without
opening the analysis editor in the studio.

You can execute many analyses simultaneously if you select them, right-click the selection and click Run.

11.1.3. Duplicating an analysis

To avoid creating an analysis from scratch, you can duplicate an existing one in the Analyses folder and work
around its metadata to have a new analysis.
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Prerequisite(s): At least one analysis has been created in the Profiling perspective of the studio.

To duplicate an analysis, do the following:

1. In the DQ Repository tree view, expand Data profiling > Analyses.

2. Right-click the analysis you want to duplicate and select Duplicate... from the contextual menu.

The duplicated analysis shows in the analysis list in the DQ Repository tree view. You can now open the
duplicated analysis and modify its metadata as needed.

11.1.4. Adding a task to an analysis

You can add a task to an analysis to indicate a problem that needs to be solved later, for example.

For more information, see Managing tasks.

11.1.5. Deleting or restoring an analysis

Prerequisite(s):At least one analysis has been created in the Profiling perspective of the studio.

To delete an analysis, do the following:

1. In the DQ Repository tree view, expand Data Profiling > Analyses.

2. Right-click the analysis you want to delete and select Delete from the contextual menu.

The analysis is moved to the Recycle Bin.

You can also delete the analysis permanently by emptying the recycle bin. To empty the Recycle Bin, do the
following:

1. Right-click the Recycle Bin and select Empty recycle bin.

A confirmation dialog box is displayed.

2. Click Yes to empty the recycle bin.

To restore an analysis from the Recycle Bin, do the following:

• In the Recycle Bin, right-click the analysis and select Restore.

The analysis is moved back to the Data profiling node.

11.2. Managing tasks
In the studio, it is possible to add tasks to different items, display the task list and delete any completed task from
the task list.

You can add tasks to different items either:

• in the DQ Repository tree view on connections, catalogs, schemas, tables, columns and created analyses,



Adding a task to a column in a database connection

300 Talend Open Studio for Data Quality User Guide

• or, on columns, or patterns and indicators set on columns directly in the current analysis editor.

For example, you can add a general task to any item in a database connection via the Metadata node in the DQ
Repository tree view. You can add a more specific task to the same item defined in the context of an analysis
through the Analyses node. And finally, you can add a task to a column in an analysis context (also to a pattern
or an indicator set on this column) directly in the current analysis editor.

The procedure to add a task to any of these items is exactly the same. Adding tasks to such items will list these
tasks in the Tasks list accessible through the Window > Show view... combination. Later, you can open the editor
corresponding to the relevant item by double-clicking the appropriate task in the Tasks list.

11.2.1. Adding a task to a column in a database
connection

Prerequisite(s): At least, one database connection has been created in the Profiling perspective of the studio. For
further information, see Connecting to a database.

To add a task to a column in a database connection, do the following:

1. In the DQ Repository tree view, expand Metadata > DB Connections.

2. Navigate to the column you want to add a task to, account_id in this example.

3. Right-click the account_id and select Add task... from the contextual menu.
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The [Properties] dialog box opens showing the metadata of the selected column.

4. In the Description field, enter a short description for the task you want to carry on the selected item.

5. In the Priority list, select the priority level and then click OK to close the dialog box.

The created task is added to the Tasks list. For more information on how to access the task list, see Displaying
the task list.

From the task list, you can:

• double-click a task to open the editor where this task has been set.

• select the task check box once the task is completed in order to be able to delete it.

• filter the task view according to your needs using the options in a menu accessible through the drop-down arrow
on the top-right corner of the Tasks view. For further information about filtering the task list, see Filtering
the task list.

11.2.2. Adding a task to an item in a specific analysis

The below procedure gives an example of adding a task to a column in an analysis. You can follow the same steps
to add tasks to other elements in the created analyses.
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Prerequisite(s): The analysis has been created in the Profiling perspective of the studio.

To add a task to an item in an analysis, do the following:

1. In the DQ Repository tree view, expand Analyses.

2. Expand an analysis and navigate to the item you want to add a task to, the account_id column in this example.

3. Right-click account_id and select Add task... from the contextual menu.

4. Follow the steps outlined in Adding a task to a column in a database connection to add a task to account_id
in the selected analysis.

For more information on how to access the task list, see Displaying the task list.

11.2.3. Adding a task to an indicator in a column
analysis

In the open analysis editor, you can add a task to the indicators set on columns. This task can be used, for example,
as a reminder to modify the indicator or to flag a problem that needs to be solved later.

Prerequisite(s):

• A column analysis is open in the analysis editor in the Profiling perspective of the studio.

• At least one indicator is set for the columns to be analyzed.

To add a task to an indicator, do the following:

1. In the Analyzed Columns list, right-click the indicator name and select Add task... from the contextual menu.
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The [Properties] dialog box opens showing the metadata of the selected indicator.

2. In the Description field, enter a short description for the task you want to attach to the selected indicator.

3. On the Priority list, select the priority level and then click OK to close the dialog box. The created task is
added to the Tasks list.

For more information on how to access the task list, see Displaying the task list.

11.2.4. Displaying the task list

Adding tasks to items will list these tasks in the Tasks list.

Prerequisite(s): At least, one task is added to an item in Profiling perspective of the studio.

To access the Tasks list, do the following:
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1. On the menu bar of Talend Studio, select Window > Show view... .

The [Show View] dialog box is displayed.

2. Start typing task in the filter field and then select Tasks from the list.

3. Click OK.

The Tasks view opens in the Profiling perspective of the studio listing the added task(s).

4. If required, double-click any task in the Tasks list to open the editor corresponding to the item to which the
task is attached.

You can create different filters for the content of the task list. For further information, see Filtering the task list.

11.2.5. Filtering the task list

In the Profiling perspective of the studio, the Tasks view lists all the tasks you create in the studio.

You can create filters to decide what to list in the task view.

Prerequisite(s): At least, one task is added to an item in Profiling perspective of the studio.

To filter tasks in the Tasks view, do the following:
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1. Follow the steps outlined in Displaying the task list to open the task list.

The Tasks view is displayed.

2. Click the drop-down arrow in the top right corner of the view, and then select Configure contents....

The [Configure contents...] dialog box is displayed showing the by-default configuration.

3. Click New to open a dialog box and then enter a name for the new filter.
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4. Click OK to close the dialog box

The new filter is listed in the Configurations list.

5. Set the different options for the new filter as the following:

• From the Scope list, select a filter scope option, and then click Select... to open a dialog box where you
can select a working set for your filter.

• Select whether you want to display completed or not completed tasks or both of them.

• Select to display tasks according to their priority or according to the text they have.

• Finally, select the check boxes of the task types you want to list.

6. Click OK to confirm your changes and close the dialog box.

The task list shows only the tasks that confirm to the new filter options.
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11.2.6. Deleting a completed task

When a task goal is met, you can delete this task from the Tasks list after labeling it as completed.

Prerequisite(s): At least one task is added to an item in the Profiling perspective of the studio.

To delete a completed task, do the following:

1. Follow the steps outlined in Displaying the task list to access the Tasks list.

2. Select the check boxes next to each of the tasks and right-click anywhere in the list.
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3. From the contextual menu, select Delete Completed Tasks. A confirmation message is displayed to validate
the operation.

4. Click OK to close the confirmation message.

All tasks marked as completed are deleted from the Tasks list.
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Appendix A. The studio management GUI
This appendix describes the Graphical User Interfaces (GUI) of the studio.
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A.1. Main window
The studio main window is the interface from which you manage data profiling.

The main window is divided into:

• the menu bar,

• the toolbar,

• the tree view area,

• a detailed view

• the workspace,

• a tab panel (specific to the Column Analysis editors),

• a cheat sheet view.

The figure below illustrates the main window and its possible views.

The following sections give detailed information about each of the above views.

A.2.  Menu bar
The menu bar headers and submenus help you perform operations on your enterprise data.
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Table 1 describes menus and menu items available to you.

Table A.1. Table 1-Management menus

Menu Menu item Description

File Close Closes the current open editor in the workspace

Close All Closes all open editors in the workspace

Save Unavailable option.

Save All Unavailable option.

Exit Closes the studio main window

Open File... Opens a file

Window Perspective Profiling:  Opens the Profiling perspective

Data Explorer: Opens the Data Explorer perspective

Other...: Opens a dialog box where you can select any of the
available perspectives

Show View... Opens the [Show View] dialog box which enables you to display
different views in the studio

Preferences Opens the [Preferences] window which enables you to set your
preferences

Reset Perspective... Resets the current perspective to its default view after confirmation

Help Welcome Opens a welcoming page which has links to the user documentation
and Talend practical sites

Help Contents Opens the Eclipse help system documentation

About   Talend Studio Displays:

-the software version you are using

-detailed information on your software configuration that may be
useful if there is a problem

-detailed information about plug-in(s)

-detailed information about the studio features

Cheat Sheets... Displays a dialog box where you can select a cheat sheet to open

Export logs Opens a wizard that helps you to export all logs generated in the
Studio and system configuration information to an archived file.

View bookmarks Opens a bookmarks panel that holds few useful links. These links
enable you to easily access specific information related to the usage
of the studio and/or its database management system

A.3.  Toolbar
The toolbar contains icons that provide you with quick access to the commonly used operations you can perform
from the studio main window.

Table 2 describes the toolbar icons and their functions.

Table A.2. Table 2-Management toolbar

Icon Function

Saves modifications
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Icon Function

Import data quality items

Export data quality items

Switches to data explorer

A.4.  DQ Repository tree view
The DQ Repository tree view of the studio shows folders for data profiling analyses, patterns and metadata.

When expanding the Data profiling folder in the tree view, you display the created analyses (either executed or
not executed yet).

When expanding the Libraries folder in the tree view list, you display the list of the pre-defined patterns and SQL
patterns. Imported patterns and patterns created by you will also show under the Patterns folder.

Under Libraries as well, you have all created SQL business rules and all imported patterns from Talend
Exchange.

When expanding the Metadata folder in the tree view list, you display the list of all created DB connections.

The figure below shows an example of an expanded DQ Repository tree view.

You can use the local toolbar icons to manage the display of the DQ Repository tree view.

A.5.  Detailed View
This view is located below the DQ Repository tree view of the studio. It displays detailed information about the
selected element in the tree view area.
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The figure below shows an example of the detailed view of the selected DB connection.

You can use the local toolbar icons to manage the display of Detail View.

A.6. Profiling workspace
This area contains:

• nothing if no data quality item is open,

• the parameter values of the open item (an analysis, a database connection and so on).

When you open a data quality item in the DQ Repository tree view, a corresponding editor opens in the profiling
workspace.

You can use the local toolbar icons to manage the display of the workspace.

A.7. Tab panel of the analysis editors
This management tab panel is located at the bottom of the analysis editors. It contains a pair of tabs:
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• Analysis Settings,

• Analysis Results.

The Analysis Settings tab lists the settings for the current analysis in the currenty editor.

The figure below is an example of the parameters of a column analysis.

The Analysis Results tab lists:

• a summary of the executed analysis in the Analysis Summary view in which it specifies the connection, the
database and the table names for the current analysis,

• the results of the executed analysis, graphics and tables, in the Analysis Results view.

The figure below is an example of a column analysis results.
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In the Analysis Results view, you can:

• click the arrow located next to a column name to display the types of analyses done on that column,

• select a type of analysis to display the corresponding generated graphics and tables.

A.8.  Selecting a task from the studio
You have several ways to select a task from Talend Studio main window. You can, for example, use:

• a menu - submenu combination, or

• a toolbar icon, or

• a right-click list, or

• shortcut keys.

Example 1: To show a view in Talend Studio main window, either:

• use the Window > Show View... menu - submenu combination, or,

• use the Alt+Shift+Q, Q shortcut key.

Example 2: To execute a job, a route or an analysis, do one of the followings :

• use the run icon on the toolbar, or

• right-click the job, route or analysis you want to execute and select the run option from the contextual menu, or

• use the F6 shortcut key.
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Appendix B. Data Explorer management GUI
The data explorer embedded in the studio allows you to query and browse databases.

This appendix introduces the Graphical User Interfaces (GUI) of the data explorer which is based on the SQL
Explorer for which you can find documentation at http://www.sqlexplorer.org/.
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B.1. Main window of the data explorer
The main window of the data explorer is the interface from which you manage your database.

The data explorer main window is divided into:

• menu bar,

• toolbar,

• Connections view,

• SQL History view

• SQL editor view,

• Database Detail view,

• Database Structure view.

The figure below illustrates an example of the data explorer main window and its components.

The following sections give detailed information about each of the above components.

B.2.  Menu bar of the data explorer
The menu bar headers and submenus help you perform operations on your enterprise data.

Menu bar of Appendix A describes menus and menu items available to you.
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B.3.  Toolbar of the data explorer
The toolbar contains icons that provide you with quick access to the commonly used operations you can perform
from the data explorer main window.

Toolbar of Appendix A describes the toolbar icons and their functions.

B.4.  Connections view
The Connections view shows all the connection profiles that you have set up.

The figure below shows an example of the Connections view.

You can use the local toolbar icons to manage the display of the Connections view.

B.5.  SQL History view
This view shows below the Connections view area. Every statement that was successfully executed is logged in
the SQL History view.

The view shows the statement, the date and time when the statement was last executed, which connection was
used and how many times the statement has been executed. The SQL statements can be filtered, sorted, removed
and opened in or appended to the [SQL Editor].

The figure below shows an example of the SQL History view.
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You can use the local toolbar icons to manage the display of SQL History View.

B.6.  SQL editor view
This area contains nothing if no [SQL Editor] is open. The [SQL Editor] provides the following features:

• Executing queries using the CTRL-ENTER combination,

• Basic syntax coloring

• Basic Content Assist

• Overriding result limit

• Word wrapping (if enabled in preferences)

• Session/Catalog/Schema switching

• Loading/Saving SQL scripts

• Commit/Rollback buttons (if session is not in auto-commit mode)

• Display of query execution time of last run query

The figure below shows an example of the [SQL Editor] view.

The lower part of the [SQL Editor] view, the Messages area, detailed information about your data exploring
actions. When you execute a query in the SQL query editor, the Messages area displays the query results.

You can save all the queries you execute in the data explorer under Libraries > Source Files in the DQ Repository tree
view in the studio.

The figure below shows an example of the Messages area.
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B.7. Database Structure view
Using the Database Structure view, you can explore multiple databases simultaneously.

When you select a node in the Database Structure view, the corresponding detail is shown in the Database Detail
view. For more information, see Database Detail view. If the detailed view is not active, double-clicking the node
will bring the detail view to the front.

B.8. Database Detail view
Database Detail view shows detailed information for whatever node you double-click in the Database Structure
view. What is displayed will depend on the database type that you are using.
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When you select a database node in the Database Structure view, the Database Detail view will show you the
connection information as shown in the figure below.

When you select a specific table in the database connection in the Database Structure view, the Database Detail
view shows you detail information about the selected table including Exported Keys and Imported Keys.

The Imported Keys column shows how the table references other tables based on primary and foreign key
declarations.

The Exported Keys column shows how other tables reference the selected table based on primary and foreign
key declarations.
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Appendix C. Theory into practice: Profiling
data
This chapter aims at users of Talend Data Quality who seek a real-life use case to help them take full control
over data quality products.

It describes how to use the Profiling perspective in Talend Studio to profile data.
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C.1. Profiling customer data
Incorporating appropriate data quality tools in your business processes is vital at the beginning of any project and
through the project plan in order to see what type of data quality you have and decide how and what data to resolve.

Suppose, for example, that you want to start a campaign for your sales and marketing groups, or you need to
contact customers for billing and payment and your main source to contact appropriate people is email and postal
addresses. Having consistent and correct address data is vital in such campaign to be able to reach all people.

This section provides an example of profiling US customer email and postal addresses.

C.1.1. Identifying data anomalies

The first step in this example is to profile the customer contact information in a MySQL database. The profiling
results provides you with statistics about the values within each column.

C.1.1.1. How to profile address columns

You will use the studio to analyze few customer columns including email and postal. Using out-of-box indicators
and patterns on these columns, you can show in the analysis results the matching and non-matching address data,
the number of most frequent records for each distinct pattern and the row, duplicate and blank counts in each
column.

Defining the column analysis

1. In the DQ Repository tree view, right-click the Analysis folder and select New Analysis.

The [Create New Analysis] wizard opens.
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2. Start typing Basic column analysis in the search field, select Basic Column Analysis from the list and click
Next.

3. In the Name field, enter a name for the current column analysis.

Avoid using special characters in the item names including:

"~", "!", "`", "#", "^", "&", "*", "\\", "/", "?", ":", ";", "\"", ".", "(", ")", "'", "¥", "'", """, "«", "»", "<", ">".

These characters are all replaced with "_" in the file system and you may end up creating duplicate items.
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4. Set column analysis metadata (purpose, description and author name) in the corresponding fields and click
Next.

Selecting the address columns and setting sample data

1. Expand DB connections and browse to the address columns you want to analyze.
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2. Select the columns and click Finish to close the wizard.

A file for the newly created column analysis is listed under the Analysis node in the DQ Repository tree
view, and the analysis editor opens with the analysis metadata.
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3. In the Data preview view, click Refresh Data.

The data in the selected columns is displayed in the table.

You can change your data source and your selected columns by using the New Connection and Select Data
buttons respectively.

4. In the Limit field, set to 50 the number for the data records you want to display in the table and use as sample
data.

5. Select n random rows to list 50 random records from the selected columns.

For further information on column analysis, see the chapter about column analysis in Talend Studio User
Guide.

Setting system indicators

1. From the Data preview view in the analysis editor, click Select indicators to open the [Indicator Selection]
dialog box.
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2. Click in the cells next to indicators names to set indicator parameters for the analyzed columns and click OK.

You want to see the row, blank and duplicate counts in all columns to see how consistent the data is. Also
you want to use the Pattern Frequency Table indicator on the email and postal columns in order to compute
the number of most frequent records for each distinct pattern or value.

Indicators are added accordingly to the columns in the Analyzed Columns view.
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3.
Click the option icon  next to the Blank Count indicator and set 0 in the Upper threshold field.

Defining thresholds on indicators is very helpful as it will write in red the count of the null values in the
analysis results.

For further information on indicator types and their usage when analyzing data, see Talend Studio User Guide.

Setting patterns

You would want now to match the content of the email column against a standard email format and the postal
column against a standard US zip code format. This will define the content, structure and quality of emails and
zip codes and give a percentage of the data that match the standard formats and the data that does not match.

1.
In the Analyzed Columns view, click the  icon next to email.
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2. In the [Pattern Selector] dialog box, expand Regex and browse to Email Address in the internet folder,
and then click OK.

3.
Click the option icon  next to the Email Address indicator and set 98.0 in the Lower threshold (%) field.

If the number of the records that match the pattern is fewer than 98%, it will be written in red in the analysis
results.

4. Do the same to add to the postal column the US Zipcode Validation pattern from the address folder.

For further information on pattern types and their usage when analyzing data, see Talend Studio User Guide.

Executing the analysis and displaying the profiling results

1. Save the column analysis in the analysis editor and then press F6 to execute it.

A group of graphics is displayed in the Graphics panel to the right of the analysis editor showing the results
of the column analysis including those for pattern matching.

2. Click the Analysis Results tab at the bottom of the analysis editor to access a more detail result view.
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These results show the generated graphics for the analyzed columns accompanied with tables that detail the
statistic and pattern matching results.

The results for the email column look as the following:

The pattern matching results show that about 10% of the email records do not match the standard email
pattern. The simple statistic results show that about 8% of the email records are blank and that about 5%
are duplicates. And the pattern frequency results give the number of most frequent records for each distinct
pattern. This shows that the data is not consistent and you need to correct and cleans the email data before
starting your campaign.

The results for the postal column look as the following:
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The result sets for the postal column give the count of the records that match and those that do not match
a standard US zip code format. The results sets also give the blank and duplicate counts and the number of
most frequent records for each distinct pattern. These results show that the data is not very consistent.

Then some percentage of the customers can not be contacted by either email or US mail service. These results
show clearly that your data is not very consistent and that it needs to be corrected.

C.1.1.2. How to view analyzed data

After running the column analysis using the SQL engine and from the Analysis Results view of the analysis
editor, you can right-click any of the rows/bars in the result tables/charts and access a view of the actual analyzed
data. This could be very helpful to see invalid rows for example and start analyzing what needs to be done to
clean such data.

To view and export the analyzed data, do the following:

1. At the bottom of the analysis editor, click the Analysis Results tab to open a detailed view of the analysis
results.
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2. Right-click the data row in the statistic results of the Email column and select View rows for example.

The Data Explorer perspective opens listing the invalid rows in the email column.
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Appendix D. Regular expressions on SQL
Server
This appendix describes in detail how to create a regular expression function on SQL Server databases.
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D.1.  Main concept
The regular expression function is not built into all different databases environments. This is why you need, when
using some databases, to create a User-Defined Function (UDF) to extend the functionality of the database server.

For example, the following databases natively support regular expressions: MySQL, PostgreSQL, Oracle 10g,
Ingres, etc., while Microsoft SQL server does not.

After you create the regular expression function, you should use the studio to declare that function in a specific
database before being able to use regular expressions on analyzed columns.

For more information on how to declare a regular expression function in the studio, see How to define a query
template for a specific database and How to declare a User-Defined Function in a specific database.

D.2.  How to create a regular expression
function on SQL Server
Prerequisite(s):You should have Visual Studio 2008, which is the version used to do the example in this
documentation. The Visual Studio main window is open.

To create a regular expression function in SQL Server, follow the steps outlined in the sections below.

D.2.1.  How to create a project in Visual Studio

You must start by creating an SQL server database project. To do that:

1. On the menu bar, select File > New > Project to open the [New Project] window.

2. In the Project types tree view, expand Visual C# and select Database.
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3. In the Templates area to the right, select SQL Server Project and then enter a name in the Name field for
the project you want to create, UDF function in this example.

4. Click OK to validate your changes and close the window.

The [Add Database Reference] dialog box is displayed.

5. From the Available References list, select the database in which you want to create the project and then
click OK to close the dialog box.

If the database you want to create the project in is not listed, you can add it to the Available Reference list through
the Add New Reference tab.

The project is created and listed in the Data Explorer panel to the right of the Visual Studio main window.

D.2.2. How to deploy the regular expression function
to the SQL server

You need now to add the new regular expression function to the created project, and then deploy the function to
the SQl server. To do that:

1. In the project list in the Solution Explorer panel, expand the node of the project you created and right-click
the Test Scripts node.

2. From the contextual menu, select Add > New Item....
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The [Add New Item] dialog box is displayed.

3. From the Templates list, select Class and then in the Name field, enter a name to the user-defined function
you want to add to the project, RegExMatch in this example.

The added function is listed under the created project node in the Solution Explorer panel to the right.

4. Click Add to validate your changes and close the dialog box.
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5. In the code space to the left, enter the instructions corresponding to the regular expression function you
already added to the created project.

Below is the code for the regular expression function we use in this example.

Using System;
Using Microsoft.SqlServer.Server;
Using System.Text.RegularExpressions;
Public partial class RegExBase
{
     [SqlFunction(IsDeterministic = true, IsPrecise = true)]
     Public static int RegExMatch( string matchString , string pattern)
     {
            Regex r1 = new Regex(pattern.TrimEnd(null));
            if (r1.Match(matchString.TrimEnd(null)).Success == true) 
            {
                 return 1 ;
            }
            else
            {
                 return 0 ;
            }
Using
     }
};

6. Press Ctrl+S to save your changes and then on the menu bar, click Build and in the contextual menu select
the corresponding item to build the project you created, Build UDF function in this example.

The lower pane of the window displays a message to confirm that the "build" operation was successful or not.
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7. On the menu bar, click Build and in the contextual menu select the corresponding item to deploy the project
you created, Deploy UDF function in this example.

The lower pane of the window displays a message to confirm that the "deploy" operation was successful,
or not.

If required:

1. launch SQL Server and check if the created function exists in the function list,

2. check if the function works well, for more information, see How to test the created function via the
SQL Server editor.

D.2.3. How to set up the studio

Before being able to use regular expressions on analyzed columns in a database, you must first declare the created
regular expression function, RegExMatch in this example, in the specified database via the studio. To do that:

1. In the DQ Repository tree view, expand Libraries > Indicators.

2. Expand System Indicators > Pattern Matching.

3. Double-click Regular Expression Matching, or right-click it and select Open from the contextual menu.

The corresponding view displays the indicator metadata and its definition.
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You need now to add to the list of databases the database for which you want to define a query template. This
query template will compute the regular expression matching.

4. Click the [+] button at the bottom of the Indicator Definition view to add a field for the new template.

5. In the new field, click the arrow and select the database for which you want to define the template, Microsoft
SQL Server.

6. Copy the indicator definition of any of the other databases.

7. Click the Edit... button next to the new field.

The [Edit expression] dialog box is displayed.
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8. Paste the indicator definition (template) in the Expression box and then modify the text after WHEN in order
to adapt the template to the selected database.

9. Click OK to proceed to the next step. The new template is displayed in the field.

10. Click the save icon on top of the editor to save your changes.

For more detailed information on how to declare a regular expression function in the studio, see How to define a
query template for a specific database and How to declare a User-Defined Function in a specific database.

D.3. How to test the created function via the
SQL Server editor
• To test the created function via the SQL server editor, copy the below code and execute it:

create table Contacts (
FirstName nvarchar(30),
 LastName nvarchar(30),
EmailAddress nvarchar(30) CHECK
 (dbo.RegExMatch('[a-zA-Z0-9_\-]+@([a-zA-Z0-9_\-]+\.)
 +(com|org|edu|nz)',
EmailAddress)=1),
USPhoneNo nvarchar(30) CHECK
 (dbo.RegExMatch('\([1-9][0-9][0-9]\) [0-9][0-9][0-9]
\-[0-9][0-9][0-9][0-9]',
UsPhoneNo)=1))

INSERT INTO [talend].[dbo].[Contacts]
                        ([FirstName]
                       , [LastName]
                       , [EmailAddress]
                       , [USPhoneNo])
       VALUES
                     ('Hallam'
                    , 'Amine'
                    , 'mhallam@talend.com'
                    , '0129-2090-1092')
                    , ( 'encoremoi'
                     , 'nimportequoi'
                     , 'amine@zichji.org'
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                     , '(122) 190-9090')
GO

• To search for the expression that match, use the following code:

SELECT [FirstName]
     , [LastName]
     , [EmailAddress]
     , [USPhoneNo]
  FROM [talend].[dbo].[Contacts]
  where [talend].[dbo].RegExMatch([EmailAddress],
'[a-zA-Z0-9_\-]+@([a-zA-Z0-9_\-]+\.)+(com|org|edu|nz|au)')
= 1 

• To search for the expression that do not match, use the following code:

SELECT [FirstName]
     , [LastName]
     , [EmailAddress]
     , [USPhoneNo]
  FROM [talend].[dbo].[Contacts]
  where [talend].[dbo].RegExMatch([EmailAddress],
'[a-zA-Z0-9_\-]+@([a-zA-Z0-9_\-]+\.)+(com|org|edu|nz|au)')
= 0 
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